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1. General Information

1.1. Software license

Copyright (c) 2002-2010, Thomas Kellerer

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, publish, distribute, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

The source code or parts of the source-code may only be reused with the permission of the author

In order to ensure that this software stays free, selling, licensing or charging for the use of this software is prohibited.
The right to include this software in a commercial product (bundling) is still granted as long as this software is not the
major functionality delivered.

Disclaimer

The software is provided "as is", without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the author (Thomas Kellerer), be liable for any direct, indirect, incidental, special,
exemplary, or consequential damages (including, but not limited to, procurement of substitute goods
or services; loss of use, data, or profits; or business interruption) however caused and on any theory of
liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any
way out of the use of this software, even if advised of the possibility of such damage.

In other words: use it at your own risk, and don't blame me if you accidently delete your database!

1.2. Program version

This document describes build 110 of SQL Workbench/J

1.3. Feedback and support

Feedback regarding this program is more then welcome. Please report any problems you find, or send your ideas to
improve the usability to: <support@sql-workbench.net>

SQL Workbench/J can be downloaded from http://www.sql-workbench.net

If you want to contact other users of SQL Workbench/J you can do this using an online forum at Google Groups: http://
groups.google.com/group/sql-workbench

1.4. Credits and thanks

Thanks to Christian (and his team) for his thorough testing, his patience and his continous ideas to improve this tool.
His input has influenced and driven a lot of features and has helped reduce the number of bugs drastically!

http://www.sql-workbench.net
http://groups.google.com/group/sql-workbench
http://groups.google.com/group/sql-workbench
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1.5. Third party components

1.5.1. JLine

SQL Workbench/J includes the JLine library to support command line editing for the console mode on Unix style
operating systems. The JDK on Windows supports full editing of the commandline including the usual Windows
hotkeys to show the list of commands, so JLine is not used when SQL Workbench/J is running under Windows.

The copyright notice for JLine follows:

Copyright (c) 2002-2006, Marc Prud'hommeaux <mwp1@cornell.edu> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

• Neither the name of JLine nor the names of its contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

1.5.2. Icons

Some icons are taken from Tango project: http://tango.freedesktop.org/Tango_Icon_Library

Some icons are taken from KDE Crystal project: http://www.everaldo.com/crystal/

The DbExplorer icon is from the icon set "Mantra" by Umar Irshad: http://umar123.deviantart.com/

http://jline.sourceforge.net/
http://tango.freedesktop.org/Tango_Icon_Library
http://www.everaldo.com/crystal/
http://umar123.deviantart.com/
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2. Change log

Changes from build 109 to build 110

Enhancements

• The (self-written) Windows launcher has been dropped and replaced with executables from Winrun4J, including
suppport for 64bit executables (thanks to Markus for testing this).

• EXPLAIN is now supported for auto-completion (PostgreSQL, Oracle, MySQL)

• The DbExplorer will now show the status of Oracle stored procedures.

• The DbExplorer now includes information about partitioned tables and indexes for Oracle in the generated source.

• The possibility to influence the generated INSERT statement for WbImport is now available as a commandline
parameter (previously this was only possible through a property in workbench.settings).

• Two new options for the SQL Formatter are available that control the placement of the comma when line breaks are
inserted. Thanks to Andreas for this patch.

• The option "Allow empty line as statement delimiter" has been moved into the settings dialog and is now also being
used when detecting the current statement in the editor.

• The font size of the editor can now be changed dynamically using Ctrl-Numpad Plus/Ctrl-Numpad Minus or via the
scroll wheel of the mouse (holding down the Ctrl Key). The font size of a result table can be changed using the scroll
wheel or through the context menu in the table header.

• It is now (optionally) possible to modify the text in the editor while a statement is running. Statement and error
highlighting will not be available if the editor contents was modified during execution.

• When the option "Show Max. Rows warning" is enabled, the warning is now shown using an icon in the tab header
(instead of changing the color).

• The join condition inside a JOIN part of a SELECT statement can now be generated automatically (if the tables
involved are using foreign keys) using SQL -> JOIN completion

• Primary key columns are now shown in bold face in the auto-completion popup window. If comments are defined for
columns, tables or view, these will be shown as a tooltip for the entry in the popup

• A new parameter -skipTargetCheck is available for WbCopy to disable checking of the target table. This is useful if
the target table is not visible by the JDBC driver (e.g. temporary tables for Informix)

• A new parameter (-tableType) is available for WbCopy to control what kind of table is created when using -
createTarget. The parameter value selects a SQL "template" that is defined in workbench.settings

• When using WbExport and -quoteAlways=true, null values are no longer escaped. The parameter can now be use
with WbImport to distinguis between null values and empty strings.

• The escaping of embedded quotes can now also be selected when using "Save Data as" or "Import file".

• When connected to an Excel Spreadsheet, [] are now also recognized as quote characters (to allow a semicolon in a
"table" name).

• The JDBC driver templates can now be loaded from an external a file named "DriverTemplates.xml" that has to be
stored in the directory where the jar file is located.

• When starting the console mode without specifying a password or when using a profile without a password, the
application now prompts to enter a password
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• A new option "Connection Timeout" has been added to the connectioin profiles.

• A new option to log all executed SQL statements to the logfile has been added (Tools -> Options -> General -> Log
all SQL statements).

• The DataPumper now remembers the settings for importing text or XML files

• A new SQL formatter option has been added, to insert a space after a comma when processing IN (...) lists.

• The "Delete data" dialog in the DbExplorer now correctly commits for DBMS where TRUNCATE is transaction
safe. The CASCADE option for PostgreSQL is also supported.

Bug fixes

• Changing the font size in the editor would corrupt the display of the caret

• When exporting data, two tabs could not be defined as a separator (only a single tab)

• Oracle Procedures with the status "INVALID" where not shown in the DbExplorer

• The JOIN completion did not always detect the FKs correctly.

• Cancelling an import did not rollback the changes.

• When reloading the table list in the DbExplorer while "editing" mode was active, the table list was not retrieved
correctly.

• Using WbCopy with schema qualified table names did not work properly when the target connection was using a
different default schema.

• The rowcount in the statusbar was not always showing the correct values when more than one result was present

• JOIN completion did not work

• WbCall did not work for functions that were using OUT parameters

• When using a query as the source for WbCopy that used column aliases between databases that store object names in
different case a wrong isnert or update statement was created

• When changing the current database, the object cache was not updated correctly

• "Filter by selected value" did not work for boolean columns

• For PostgreSQL, columns defined as bit(x) with x > 1 where not displayed correctly.

• When running a statement there was a built-in limit on 15 warnings that would be displayed by SQL Workbench.
That limited the output of messages with RAISe NOTICE to 15 as well in PostgreSQL.

• The datatype for parameters in Oracle stored procedures was not always displayed correctly.

• When selecting JdbcOdbc bridge as the Driver class, SQL Workbench incorrectly showed an error message that the
driver could not be found.

• Copying a table's column definitions into the clipboard did not work.

• When using WbCopy and -createTarget with a fully qualified table name (otherschema.sometable) the table was not
created in the specified schema

• Postgres DOMAINs where not displayed if the DOMAIN was created in a schema that is not in the schema
search_path
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• A selection of '*' in the DbExplorer's schema selector was not restored if "Remember DbExplorer schema" was
enabled for the workspace

• -quoteCharEscaping=duplicate was not working for WbImport if a quote character other than " was used.

• Procedures were no longer displayed in DbExplorer for DB2.

• A workaround for an Oracle driver bug was implemented, where the datatype for TIMESTAMP(3) was reported
incorrectly.

• The generated XML content was not valid for ODS or OpenXML export if the generating SQL contained characters
that needed escaping in XML.

• Statements where not closed properly when retrieving Oracle Object type information.

• Oracle RAW columns were not displayed correctly if the automatic data conversion was turned on.

• Using WbDataDiff (and WbSchemaDiff) with the -referenceSchema parameter or selecting specific tables for
comparison did not work.

• Optimize column width calculated a width that was too wide (and increased with the total number of columns)

• When using the DataPumper to import xml files, non-standard column names were not quoted properly in the
UPDATE statement

• When saving and loading the same file an empty line was appended each time the file was loaded.

• The console interface was no longer working.

• Importing multiple zipped text files into tables with BLOB columns did not work when using a batch size > 1

• When copying data to the clipboard, the data was always copied in the column order as retrieved from the database.
If the column order was changed, this was not reflected in the copied data

• If a stored procedure in Oracle with the same name existed as a standalone procedure and a packaged procedure, the
procedure columns for the standalone procedure where not displayed correctly in the DbExplorer

• When using the new lobsPerDirectory parameter for WbExport, the directory numbering did not restart with a new
table.

• WbSchemaReport created invalid SQL if column names contained characters that needed a replacement with an
XML entity.

The full release history is available at the SQL Workbench/J homepage

http://www.sql-workbench.net/history.html
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3. Installing and starting SQL Workbench/J

3.1. Pre-requisites

To run SQL Workbench/J a Java 6 runtime environment is required. You can either use a JRE ("Runtime") or a JDK
("Development Kit") to run SQL Workbench/J.

3.2. First time installation

Once you have downloaded the application's distribution package, unzip the archive into a directory of your choice.
Apart from that, no special installation procedure is needed.

You will need to configure the necessary JDBC driver(s) for your database before you can connect to a database. Please
refer to the chapter JDBC Drivers for details on how to make the JDBC driver available to SQL Workbench/J

When starting SQL Workbench/J for the first time, it will create a directory called .sqlworkbench in the current
user's home folder to store all its configuration information.

The "user's home directory" is $HOME on a Linux or Unix based system, and %HOMEPATH% on a Windows system.
(Technically speaking it is using the contents of Java system property user.home to find the user's home directory)

3.3. Upgrade installation

When upgrading to a newer version of SQL Workbench/J simply overwrite the old sqlworkbench.jar and the exe
launcher and shell scripts that start the application.

Starting with build 99 the file names have changed. The jar file is now named sqlworkbench.jar and the filename
of the Windows launcher is now sqlworkbench.exe.

If you are upgrading from build 98 or earlier, please delete the old files Workbench.jar and JWorkbench.exe.

3.4. Starting the program from the commandline

sqlworkbench.jar is a self executing JAR file. This means, that if your JDK is installed properly, a double click (on
the Windows® platform) on sqlworkbench.jar will execute the application. To run the application manually use the
command:

java -jar sqlworkbench.jar

Native executables for Windows and Mac OSX are supplied that start SQL Workbench/J by using the default Java
runtime installed on your system. Details on using the Windows launcher can be found here.

3.5. Starting the program using the shell script

To run SQL Workbench/J under an Unix-type operating system, the supplied shell script sqlworkbench.sh can be
used. For Linux desktops a sample ".desktop" file is available.

3.5.1. Specifying the Java runtime for the shell script

The shell scripts (and the batch files) first check if the environment variable WORKBENCH_JDK is defined. If that
variable is defined, the shell script will use $WORKBENCH_JDK/bin/java to run the application.

http://java.sun.com/javase/downloads/index.jsp
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If WORKBENCH_JDK is not defined, the shell script will check for the environment variable JAVA_HOME. If that is
defined, the script will use $JAVA_HOME/bin/java to run the application.

If neither WORKBENCH_JDK nor JAVA_HOME is defined, the shell script will simply use java to start the application,
assuming that a valid Java runtime is available on the path.

All parameters that are passed to the shell scripts are passed to the application, not to the Java runtime. If you want to
change the memory or other system settings for the JVM, you need to edit the shell script.

3.6. Starting the program using the Windows launcher

On a 32bit Windows® platform the supplied SQLWorkbench.exe can be used to start the program when using a Sun
JDK. The native launcher searches for an installed JDK (querying the registry) and then starts SQL Workbench/J. The
file sqlworkbench.jar has to be located in the same directory as the SQLWorkbench.exe, otherwise it doesn't work.

For a Windows 64bit system, you have to use SQLWorkbench64.exe. It will automatically search for a
64bit Java installation.

The launcher only works with a Sun JDK, as it directly calls the JDK' dll to start the virtual machine. If you are using
a different JDK you cannot use the launcher to start SQL Workbench/J on Windows (unless it uses the same directory
layout and filenames as the Sun JDK).

By default the launcher increases the maximum JVM heap size to 256MB. If you need more heap memory, you need
to pass the appropriate JVM parameter to the launcher. Please refer to Increasing the memory for details on how to
increase the memory that is available to SQL Workbench/J

3.6.1. Parameters for the Windows launcher

The launcher executables are based on WinRun4J, further documentation on the format of the configuration file and
parameters can also be found there.

3.7. Configuration directory

The configuration directory is the directory where all config (workbench.settings, WbProfiles.xml,
WbDrivers.xml) files are stored.

If no configuration directory has been specified on the commandline, SQL Workbench/J will identify the configuration
directory by looking at the following places

1. The current directory

2. The directory where sqlworkbench.jar is located

3. In the user's home direcotry (e.g. $HOME/.sqlworkbench on Unix based systems or %HOMEPATH%
\.sqlworkbench on Windows systems)

If the file workbench.settings is found in one of those directories, that directory is considered the configuration
directory.

If no configuration directory can be identified, it will be created in the user's home directory (as .sqlworkbench).

The above mentioned search can be overridden by supplying the configuration directory on the commandline when
starting the application.

http://winrun4j.sourceforge.net/
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Note that, before Build 98 the default configuration directory was the program's directory and not a directory in the
user's home directory.

The following files are stored in the configuration directory:

• General configuration settings (workbench.settings)

• Connection profiles (WbProfiles.xml)

• JDBC Driver definitions (WbDrivers.xml)

• Customized shortcut definitions (WbShortcuts.xml). If you did not customize any of the shortcuts, this file does
not exist

• Macro definitions (WbMacros.xml)

• Log file (workbench.log)

• Workspace files (*.wksp)

If you want to use a different file for the connection profile than WbProfiles.xml then you can specify the location of
the profiles with the -profilestorage parameter on the commandline. Thus you can create different shortcuts on
your desktop pointing to different sets of profiles. The different shortcuts can still use the same main configuration file.

3.7.1. Specifying the location of the configuration directory

If you want to control the location where SQL Workbench/J stores the configuration files, you have to start the
application with the parameter -configDir to specify an alternate directory:

java -jar sqlworkbench.jar -configDir=/export/configs/SQLWorkbench

or if you are using the Windows® launcher:

SQLWorkbench -configDir=c:\ConfigData\SQLWorkbench

The placeholder ${user.home} will be replaced with the current user's home directory (as returned by the Operating
System), e.g.:

java -jar sqlworkbench.jar -configDir=${user.home}/.sqlworkbench

If the specified directory does not exist, it will be created.

To copy an installation to a different computer, simply copy all the above files to the other computer (the log file does
not need to be copied). When a profile is connected to a workspace, the filename of the workspace file is usually stored
with a placeholder for the configuration directory (%configDir%) so that the profiles don't need to be adjusted.

You will need to edit the driver definitions (stored in WbDrivers.xml) as the full path to the driver's jar file(s) is
stored in the file (unless you define the location of the drivers using the libdir variable.

3.8. Increasing the memory available to the application

SQL Workbench/J is a Java application and thus runs inside a virtual machine (JVM). The virtual machine limits the
memory of the application independently from the installed memory that is available to the operating system.
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SQL Workbench/J reads the data that is returned by a SELECT statement into the main memory. When retrieving large
result sets, you might get an error message, indicating that not enough memory is available. In this case you need to
increase the memory that the JVM requests from the operating system (or change your statement to return fewer rows).

When you use the Windows® Launcher to start SQL Workbench/J you need to create a configuration file named
SQLWorkbench.ini (or SQLWorkbench64.ini when using the 64bit launcher) with the following content:

vm.heapsize.preferred=512

This will increase the memory for the application to 512MB. For more options to configure the JVM, please refer to the
documentation of WinRun4J

If you are running SQL Workbench/J on a non-Windows® operating system or do not want to use the launcher, then
you need to pass this parameter directly to the JVM

java -Xmx512m -jar sqlworkbench.jar

If you are using the supplied shell scripts to start SQL Workbench/J, you can edit the scripts and change the value for
the -Xmx parameter in there.

3.9. Command line parameters

Command line parameters are not case sensitive. The parameters -PROFILE or -profile are identical. The usage of
the command line parameters is identical between the launcher or starting SQL Workbench/J using the java command
itself.

When quoting parameters on the commandline (especially in a Windows environment) you have to use single
quotes, as the double quotes won't be passed to the application.

3.9.1. Specify the directory for configuration settings

The parameter -configDir specifies the directory where SQL Workbench/J will store all its settings. If this
parameter is not supplied, the directory where the default location is used. The placeholder ${user.home} will be
replaced with the current user's home directory (as returned by the Operating System). If the specified directory does
not exist, it will be created.

java -jar sqlworkbench.jar -configDir=${user.home}/wbconfig
SQLWorkbench -configDir='c:\Configurations\SQLWorkbench'

On the Windows platform you can use a forward slash to separate directory names in the parameter.

3.9.2. Specify a base directory for JDBC driver libraries

The -libdir parameter defines the base directory for your JDBC drivers. The value of this parameter can be
referenced when defining a driver library using the placholder %LibDir% The value for this parameter can also be set
in the file workbench.settings.

3.9.3. Specify the file containing connection profiles

SQL Workbench/J stores the connection profiles in a file called WbProfiles.xml. If you want to use a different
filename, or use different set of profiles for different purposes you can define the file where the profiles are stored with
the -profilestorage parameter.

http://winrun4j.sourceforge.net/
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If the value of the parameter does not contain a path, the file will be expected (and stored) in the configuration
directory.

3.9.4. Defining variables

With the -vardef parameter a definition file for internal variables can be specified. Each variable has to be listed
on a single line in the format variable=value. Lines starting with a # character are ignored (comments). the file
can contain unicode sequences (e.g. \u00fc. Values spanning multiple lines are not supported. When reading a file
during startup the default encoding is used. If you need to read the file in a specific encoding please use the WbVarDef
command with the -file and -encoding parameter.

#Define some values
var_id=42
person_name=Dent
another_variable=24

If the above file was saved under the name vars.txt, you can use those variables by starting SQL Workbench/J
using the following commandline:

java -jar sqlworkbench.jar -vardef=vars.txt

You can also define a list of variables with this parameter. In this case, the first character after the = sign, has to be #
(hash sign) to flag the value as a variable list:

java -jar sqlworkbench.jar -vardef=#var_id=42,person_name=Dent

Defining variable values in this way can also be used when running in batch mode.

3.9.5. Prevent updating the .settings file

If the -nosettings parameter is specified, SQL Workbench/J will not write its settings to the file
workbench.settings when it's beeing closed. Note that in batch mode, this file is never written.

If this parameter is supplied, the workspace will not be saved automatically as well!

3.9.6. Connect using a pre-defined connection profile

You can specify the name of an already created connection profile on the commandline with the -
profile=<profile name> parameter. The name has to be passed exactly like it appears in the profile dialog (case
sensitiv!). If the name contains spaces or dashes, it has to be enclosed in quotations marks. If you have more than one
profile with the same name but in different profile groups, you have to specify the desired profile group using the -
profilegroup parameter, otherwise the first profile matching the passed name will be selected.

Example (on one line):

java -jar sqlworkbench.jar
     -profile='PostgreSQL - Test'
     -script='test.sql'

In this case the file WbProfiles.xml must be in the current (working) directory of the application. If this is not the
case, please specify the location of the profile using either the -profilestorage or -configDir parameter.

If you have two profiles with the names "Oracle - Test" you will need to specify the profile group as well (in one
line):

java -jar sqlworkbench.jar
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     -profile='PostgreSQL - Test'
     -profilegroup='Local'
     -script='test.sql'

3.9.7. Connect without a profile

You can also specify the full connection parameters on the commandline, if you don't want to create a profile
only for executing a batch file. The advantage of this method is, that SQL Workbench/J does not need the files
WbProfiles.xml, WbDrivers.xml to be able to connect to the database.

The connection can be specified with the following parameters:

Parameter Description

-url The JDBC connection URL

-username Specify the username for the DBMS

-password Specify the password for the user

-driver Specify the full class name of the JDBC driver

-driverJar Specify the full pathname to the .jar file containing the JDBC driver

-autocommit Set the autocommit property for this connection. You can also control the autocommit mode
from within your script by using the SET AUTOCOMMIT command.

-rollbackOnDisconnect If this parameter is set to true, a ROLLBACK will be sent to the DBMS before the connection
is closed. This setting is also available in the connection profile.

-trimCharData Turns on right-trimming of values retrieved from CHAR columns. See the description of the
profile properties for details.

-removeComments This parameter corresponds to the Remove comments setting of the connection profile.

-fetchSize This parameter corresponds to the Fetch size setting of the connection profile.

-ignoreDropError This parameter corresponds to the Ignore DROP errors setting of the connection profile.

-emptyStringIsNull This parameter corresponds to the Empty String is NULL setting of the connection profile.
This will only be needed when editing a result set in GUI mode.

-connectionProperties This parameter can be used to pass extended connection properties if the driver does not
support them e.g. in the JDBC URL. The values are passed as key=value pairs, e.g. -
connectionProperties=someProp=42

If either a comma or an equal sign occurs in a parameter's value, it must be quoted. This
means, when passing multiple properties the whole expression needs to be quoted: -
connectionProperties='someProp=42,otherProp=24'.

As an alternative, a colon can be used instead of the equals sign, e.g -
connectionProperties=someProp:42,otherProp:24. In this case no quoting is
needed (because no delimiter is part of the parameters value).

If any of the property values contain a comma or an equal sign, then the
whole parameter value needs to be quoted again, even when using a colon. -
connectionProperties='someProp:"answer=42",otherProp:"2,4"' will
define the value answer=42 for the property someProp and the value 2,4 for the property
otherProp.

-altDelim The alternate delimiter to be used for this connection. To define a single line delimiter append
the characters :nl to the parameter value: e.g. -altDelimiter=GO:nl to define a SQL
Server like GO as the alternate delimiter. Note that when running in batchmode you can also
override the default delimiter by specifying the -delimiter parameter.
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Parameter Description

-separateConnection If this parameter is set to true, and SQL Workbench/J is run in GUI mode, each SQL tab will
use it's own connection to the database server. This setting is also available in the connection
profile. The default is true.

-workspace The workspace file to be loaded. If the file specification does not include a directory, the
workspace will be loaded from the configuration directory. If this parameter is not specified,
the default workspace (Default.wksp) will be loaded.

-readOnly Puts the connection into read-only mode.

If a value for one of the parameters contains a dash or a space, you will need to quote the parameter value.

A disadvantage of this method is, that the password is displayed in plain text on the command line. If this is used in a
batch file, the password will be stored in plain text in the batch file. If you don't want to expose the password, you can
use a connection profile and enable password encryption for connection profiles.
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4. JDBC Drivers

4.1. Configuring JDBC drivers

 Before you can connect to a DBMS you have to configure the JDBC driver to be used. The driver configuration is
available in the connection dialog or through File » Manage Drivers

The configuration of a specific driver requires at least two properties:

• the driver's class name

• the library ("JAR file") where to find the driver class

After you have selected the .jar file for a driver, SQL Workbench/J will scan the jar file looking for a JDBC driver. If
only a single driver is found, the classname is automatically put into the entry field. If more than one class is found that
is a driver implementation, you will be prompted to select one. In that case, please refer to the manual of your driver, to
choose the correct one.

If you enter the class name of the driver manually, remember that it's case-sensitive.
org.postgresql.driver is different to org.postgresql.Driver (note the capital D for Driver)

The name of the library has to contain the full path to the driver's jar file, so that SQL Workbench/J can find it. Some
drivers are distributed in several jar files. In that case, select all necessary files in the file open dialog, or enter all the
filenames separated by a semicolon (or a colon on Unix style operating systems). This is also true for drivers that
require a license file that is contained in a jar file. In this case you have to include the license jar in the list of files.
Basically this list defines the classpath for the classloader that is used to load and instantiate the driver.

If the driver accesses files through its classpath definition that are not contained in a jar library, you have to include
that directory as part of the library definition (e.g: "c:\etc\TheDriver\jdbcDriver.jar;c:\etc
\TheDriver"). The file selection dialog will not let you select a directory, so you have to add it manually to the
library definition.

SQL Workbench/J is not using the system CLASSPATH definition (i.e. environment variable) to load the
driver classes. Changing the CLASSPATH environment variable to include your driver's library will not work.
Using the -cp switch to add a driver to the classpath when starting the application through a batch file will
also not work.

You do not need to specify a library for the JDBC-ODBC bridge, as the necessary drivers are already part of the Java
runtime.

 You can assign a sample URL to each driver, which will be put into the URL property of the profile, when the driver
class is selected.

SQL Workbench/J comes with some sample URLs pre-configured. Some of these sample URLs use brackets to indicate
a parameters that need to be replaced with the actual value for your connection: (servername) In this case the entire
sequence including the brackets need to be replaced with the actual value.

4.2. Connecting through ODBC

To connect to a database using an ODBC driver, you must first setup an ODBC datasource with the tools of your
operating system (e.g. the control panel in Windows®)

Once you have set up the ODBC datasource, select the ODBC Bridge as the driver in the connection dialog. The JDBC
URL for the datasource connection then is jdbc:odbc:name_of_your_datasource.

If you named your ODBC datasource ProductDB, then the JDBC url for SQL Workbench/J would be
jdbc:odbc:ProductDB
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4.3. Specifying a library directory

When defining the location of the driver's .jar file, you can use the placeholder %LibDir% instead of the using the
directory's name directly. This way your WbDrivers.xml is portable across installations. To specify the library
directory, either set it in the workbench.settings file, or specify the directory using the -libdir switch when
starting the application.

4.4. Popular JDBC drivers

Here is an overview of common JDBC drivers, and the classname that need to be used. SQL Workbench/J contains
predefined JDBC drivers with sample URLs for connecting to the database.

Most drivers accept additional configuration parameters either in the URL or through the extended properties. Please
consult the manual of your driver for more detailed information on these additional parameters.

DBMS Driver class Library name

PostgreSQL org.postgresql.Driver postgresql-8.4-701.jdbc4.jar (exact name depends on
PostgreSQL version)
http://jdbc.postgresql.org

Firebird SQL org.firebirdsql.jdbc.FBDriver firebirdsql-full.jar
http://www.firebirdsql.org/

Oracle oracle.jdbc.OracleDriver ojdbc6.jar
http://www.oracle.com/technetwork/database/
features/jdbc/index-091264.html

H2 Database
Engine

org.h2.Driver h2.jar
http://www.h2database.com

HSQLDB org.hsqldb.jdbcDriver hsqldb.jar
http://hsqldb.sourceforge.net

IBM DB2 com.ibm.db2.jcc.DB2Driver db2jcc4.jar
http://www-01.ibm.com/support/docview.wss?
rs=4020&uid=swg21385217

IBM DB2 for
iSeries

com.ibm.as400.access.AS400JDBCDriver jt400.jar
http://www-01.ibm.com/software/data/db2/java/

Apache Derby org.apache.derby.jdbc.EmbeddedDriver derby.jar
http://db.apache.org/derby/

Teradata com.teradata.jdbc.TeraDriver terajdbc4.jar
http://www.teradata.com/DownloadCenter/
Forum158-1.aspx

Sybase SQL
Anywhere

com.sybase.jdbc3.jdbc.SybDriver jconnect.jar
http://www.sybase.com/products/allproductsa-z/
softwaredeveloperkit/jconnect

MySQL com.mysql.jdbc.Driver mysql-connector-java-5.1.5-bin.jar (exact name
depends on version)
http://www.mysql.com

SQL Server
2000/2005
(Microsoft
driver)

com.microsoft.sqlserver.jdbc.SQLServerDriver sqljdbc4.jar
http://www.microsoft.com/sqlserver/2005/en/us/
java-database-connectivity.aspx

SQL Server
(jTDS driver)

net.sourceforge.jtds.jdbc.Driver jtds.jar
http://jtds.sourceforge.net

http://jdbc.postgresql.org
http://www.firebirdsql.org/
http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html
http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html
http://www.h2database.com
http://hsqldb.sourceforge.net
http://www-01.ibm.com/support/docview.wss?rs=4020&uid=swg21385217
http://www-01.ibm.com/support/docview.wss?rs=4020&uid=swg21385217
http://www-01.ibm.com/software/data/db2/java/
http://db.apache.org/derby/
http://www.teradata.com/DownloadCenter/Forum158-1.aspx
http://www.teradata.com/DownloadCenter/Forum158-1.aspx
http://www.sybase.com/products/allproductsa-z/softwaredeveloperkit/jconnect
http://www.sybase.com/products/allproductsa-z/softwaredeveloperkit/jconnect
http://www.mysql.com
http://www.microsoft.com/sqlserver/2005/en/us/java-database-connectivity.aspx
http://www.microsoft.com/sqlserver/2005/en/us/java-database-connectivity.aspx
http://jtds.sourceforge.net
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DBMS Driver class Library name

ODBC Bridge sun.jdbc.odbc.JdbcOdbcDriver Included in the JDK
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5. Connecting to the database

5.1. Connection profiles

SQL Workbench/J uses the concept of profiles to store connection information. A connection profile stores two
different types of settings:

• JDBC related properties such as the JDBC driver class, the connection URL, the username etc.

• SQL Workbench/J related properties such as the profile name the associated workspace, etc.

After the program is started, you are prompted to choose a connection profile to connect to a database. The dialog will
display a list of available profiles on the left side. When selecting a profile, its details (JDBC and SQL Workbench/J
settings) are displayed on the right side of the window.

 To create a new profile click on the New Profile button ( ). This will create a new profile with the name "New
Profile". The new profile will be created in the currently active group. The other properties will be empty. To create

a copy of the currently selected profile click on the Copy Profile button ( ). The copy will be created in the
current group. If you want to place the copy into a different group, you can either choose to Copy & Paste a copy of the
profile into that group, or move the copied profile, once it is created.

 To delete an existing profile, select the profile in the list and click on the Delete Profile button ( )

5.2. Managing profile groups

Profiles can be organized in groups, so you can group them by type (test, integration, production) or customer or
database system. When you start SQL Workbench/J for the first time, no groups are created and the tree will only

display the default group node. To add a new group click on the Add profile group ( ) button. The new group
will be appended at the end of the tree. If you create a new profile, it will be created in the currently selected group. If a
profile is selected in the tree and not a group node, the new profile will be created in the group of the currently selected
profile.

Empty groups are discarded (i.e. not saved) when you restart SQL Workbench/J

You can move profiles from one group to another but right clicking on the profile, then choose Cut. Then right-click
on the target group and select Paste from the popup menu. If you want to put the profile into a new group that is not yet
created, you can choose Paste to new folder. You will be prompted to enter the new group name.

If you choose Copy instead of Cut, a copy of the selected profile will be pasted into the target group. This is similar to
copying the currently selected profile.

To rename a group, select the node in the tree, then press the F2 key. You can now edit the group name.

To delete a group, simply remove all profiles from that group. The group will then automatically be removed.
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5.3. JDBC related profile settings

Property Description

Driver This is the classname for the JDBC driver. The exact name depends on the DBMS and
driver combination. The documentation for your driver should contain this information. SQL
Workbench/J has some drivers pre-configured. See JDBC drivers for details on how to configure
your JDBC driver for SQL Workbench/J.

URL  The connection URL for your DBMS. This value is DBMS specific. The pre-configured drivers
from SQL Workbench/J contain a sample URL. If the sample URL (which gets filled into the
text field when you select a driver class) contains words in brackets, then these words (including
the brackets) are placeholders for the actual values. You have to replace them (including the
brackets) with the appropriate values for your DBMS connection.

Username This is the name of the DBMS user account

Password This is the password for your DBMS user account. You can choose not to store the password in
the connection profile.

Autocommit  This checkbox enables/disables the property for the connection. If autocommit is enabled,
then each SQL statement is automatically committed on the DBMS. If this is disabled, any
DML statement (UPDATE, INSERT, DELETE, ...) has to be committed in order to
make the change permanent. Some DBMS require a commit for DDL statements (CREATE
TABLE, ...) as well. Please refer to the documentation of your DBMS.

Fetch size  This setting controls the default fetch size for data retrieval. This parameter will directly be
passed to the setFetchSize() method of the Statement object. For some combinations of
JDBC driver and DBMS, setting this parameter to a rather large number can improve retrieval
performance because it saves network traffic.

The JDBC driver for PostgreSQL controls the caching of ResultSets through this parameter.
As the results are cached by SQL Workbench/J anyway, it is suggested to set this parameter to
a value greater then zero to disable the caching in the driver. Especially when exporting large
results using WbExport or WbCopy it is recommended to turn off the caching in the driver (e.g.
by setting the value for this property to 1).

You can change the fetch size for the current connection manually by running the SQL
Workbench/J specific command WbFetchSize

Timeout  This property defines a timeout in seconds that is applied when establishing the connection to
the database server. If no connection is possible in that time, the attempt will be aborted. If this is
empty, the default timeout defined by the JDBC driver is used.

5.4. Extended properties for the JDBC driver

JDBC drivers support additional connection properties where you can fine tune the behaviour of the driver or enable
special features that are not switched on by default. Most drivers support passing properties as part of the URL, but
sometimes they need to be passed to the driver using a different method called extended properties.

If you need to pass an additional paramter to your driver you can do that with the Extended Properties button. After
clicking that button, a dialog will appear with a table that has two columns. The first column is the name of the
property, the second column the value that you want to pass to the driver.

To create a new property click on the new button. A new row will be inserted into the table, where you can define the
property. To edit an existing property, simply doubleclick in the table cell that you want to edit. To delete an existing

property click on the Delete button ( ).

http://java.sun.com/javase/6/docs/api/java/sql/Statement.html#setFetchSize(int)
http://jdbc.postgresql.org
http://www.postgresql.org/
http://jdbc.postgresql.org/documentation/80/query.html#query-with-cursor


SQL Workbench/J User's Manual

22

Some driver require those properties to be so called "System properties" (see the manual of your driver for details). If
this is the case for your driver, check the option Copy to system properties before connecting.

5.5. SQL Workbench/J specific settings

5.5.1. Save password

If this option is enabled (i.e. checked) the password for the profile will also be stored in the profile file. If the global
option Encrypt Passwords is selected, then the password will be stored encrypted, otherwise it will be stored in plain
text!

If you choose not to store the password, you will be prompted for it each time you connect using the profile.

5.5.2. Separate connection per tab

If this option is enabled, then each tab in the main window will open a separate (phyiscal) connection to the database
server. This is useful, if the JDBC driver is not multi-threaded and does not allow to execute two statements
concurrently on the same connection.

The connection for each tab will not be opened until the tab is actually selected.

Enabling this option has impact on transaction handling as well. If only one connection for all tabs (including the
Database Explorer) is used, then a transaction that is started in one tab is "visible" to all other tabs (as they share the
same connection). Changes done in one tab via UPDATE are seen in all other tabs (including the Database Explorer). If
a separate connection is used for each tab, then each tab will have its own transaction context. Changes done in one tab
will not be visible in other tabs until they are committed (depending on the isolation level of the database of course)

If you intend to execute several statements in parallel then it's strongly recommended to use one connection for each
tab. Most JDBC drivers are not multi-threaded and thus cannot run more then on statement on the same connection.
SQL Workbench/J does try to detect conflicting usages of a single connection as far as possible, but it is still possible to
lock the GUI when running multiple statements on the same connection

When you disable the use of separate connections per tab, you can still create new a (physical) connection for the
current tab later, by selecting File » New Connection. That menu item will be disabled if Separate connection
per tab is disabled or you have already created a new connection for that tab.

5.5.3. Ignore DROP errors

If this option is enabled, any error reported by the database server when issuing a statement that begins with DROP, will
be ignored. Only a warning will be printed into the message area. This is useful when executing SQL scripts to build up
a schema, where a DROP TABLE is executed before each CREATE TABLE. If the table does not exist the error which
the DROP statement will report, is not considered as an error and the script execution continues.

When running SQL Workbench/J in batchmode this option can be defined using a separate command line parameter.
See Section 9, “Using SQL Workbench/J in batch files” for details.

5.5.4. Rollback before disconnect

Some DBMS require that all open transactions are closed before actually closing the connection to the server. If this
option is enabled, SQL Workbench/J will send a ROLLBACK to the backend server before closing the connection. This
is e.g. required for Cloudscape/Derby because executing a SELECT query already starts a transaction. If you see errors
in your log file while disconnecting, you might need to enable this for your database as well.
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5.5.5. Confirm updates

If this option is enabled, then SQL Workbench/J will ask you to confirm the execution of any SQL statement that is
updating or changing the database in any way (e.g. UPDATE, DELETE, INSERT, DROP, CREATE, COMMIT, ...).

If you save changes from within the result list, you will be prompted even if Confirm result set updates is disabled.

This option cannot be selected together with the "Read only" option.

The read only state of the connection can temporarily be changed (without modifying the profile) using the WbMode
command.

5.5.6. Read only

If this option is enabled, then SQL Workbench/J will never run any statements that might change the database.
Changing of retrieved data is also disabled in this case. This option can be used to prevent accidental changes to
important data (e.g. a production database)

SQL Workbench/J cannot detect all possible statements that may change the database. Especially when calling stored
procedures SQL Workbench/J cannot know if they will change the database. But they might be needed to retrieve data,
this cannot be disabled alltogether.

You can extend the list of keywords known to update the data in the workbench.settings file.

SQL Workbench/J will not guarantee that there is no way (accidentally or intended) to change data when this
option is enabled. Please do not rely on this option when dealing with important data that must not be changed.

If you really need to guarantee that no data is changed, you have to do this with the security mechanism of your
DBMS, e.g. by creating a read-only user.

This option cannot be selected together with the "Confirm updates" option.

The read only state of the connection can temporarily be changed (without modifying the profile) using the WbMode
command.

5.5.7. Empty string is NULL

If this option is enabled, then a NULL value will be sent to the database for an empty (zero length) string. Everything
else will be sent to the database as entered.

Empty values for non-character values (dates, numbers etc) are always treated as NULL.

If this option is disabled you can still set a column's value to NULL while editing a result set. Please see Editing
data [43] for details

5.5.8. Include NULL columns in INSERT

This setting controls whether columns where the value from the result grid is null are included in INSERT statements.
If this setting is enabled, then columns for new rows that have a null value are listed in the column list for the INSERT
statement (with the corresponding NULL value passed in the VALUES list). If this property is un-checked, then those
columns will not be listed in INSERT statements. This is useful if you have e.g. auto-increment columns that only work
if the columns are not listed in the DML statement.

5.5.9. Remove comments

If this option is checked, then comments will be removed from the SQL statement before it is sent to the database. This
covers single line comments using -- or multi-line comments using /* .. */
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As an ANSI compliant SQL Lexer is used for detecting comments, this does not work for non-standard MySQL
comments using the # character.

5.5.10. Hide warnings

When a SQL statement returns warnings from the DBMS, these are usually displayed after the SQL statement has
finished. By enabling this option, warnings that are returned from the DBMS are never displayed.

Note that for some DBMS (e.g. MS SQL Server) server messages (PRINT 'Hello, world') are also returned as a
warning by the driver. If you disable this property, those messages will also not be displayed.

If you hide warnings when connected to a PostgreSQL server, you will also not see messages that are returned e.g. by
the VACUUM command.

5.5.11. Remember DbExplorer Schema

If this option is enabled, the currently selected schema in the DbExplorer will be stored in the workspace associated
with the current connection profile. If this option is not enabled, the DbExplorer tries to pre-select the current schema
when it's opened.

5.5.12. Trim CHAR data

For columns defined with the CHAR datatype, some DBMS pad the values to the length defined in the column
definition (e.g. a CHAR(80) column will always contain 80 characters). If this option is enabled, SQL Workbench/J will
remove trailing spaces from the values retrieved from the database. When running SQL Workbench/J in batch mode,
this flag can be enabled using the -trimCharData switch.

5.5.13. Info Background

Once a connection has been established, information about the connection are display in the toolbar of the main
window. You can select a color for the background of this display to e.g. indicate "sensitive" connections. To use the

default background, click on the Reset ( ) button. If no color is selected this is indicated with the text (None)
next to the selection button. If you have selected a color, a preview of the color is displayed.

5.5.14. Alternate delimiter

If an alternate delimiter is defined, and the statement that is executed ends with the defined delimiter, this one will be
used instead of the standard semicolon. The profile setting will overwrite the global setting for this connection. This
way you can define the GO keyword for SQL Server connections, and use the forward slash in Oracle connections. The
delimiter can be defined as a "single line delimiter", which means that it will only be recognized if put on a single line.
Please refer to using the alternate delimiter for details on this property.

5.5.15. Workspace

For each connection profile, a workspace file can (and should) be assigned. When you create a new connection, you can
either leave this field empty or supply a name for a new profile.

If the profile that you specify does not exist, you will be prompted if you want to create a new file, load a different
workspace or want to ignore the missing file. If you choose to ignore, the association with the workspace file will be
cleared and the default workspace will be loaded.

If you choose to leave the workspace file empty, or ignore the missing file, you can later save your workspace to a new
file. When you do that, you will be prompted if you want to assign the new workspace to the current connection profile.
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To save you current workspace choose Workspace » Save Workspace as to create a new workspace file.

When specifying the location of the workspace file, you can use the placeholder %ConfigDir% as part of
the filename. The file will then be stored in the same directory as SQL Workbench/J's configuration files e.g.:
%ConfigDir%/oracle.wksp

When you use the %ConfigDir% placeholder, you can move the profiles and workspaces to a different computer,
without changing the location of the workspace files.

The placeholder will be put automatically into the filename when you select the location of the profile using the file
dialog. The file dialog will be opened when you click the button with ... to the right of the input field.

As the workspace stores several settings that are related to the connection (e.g. the selected schema in the
DbExplorer) it is recommended to create one workspace for each connection profile.

5.5.16. Connect scripts

You can define a SQL script that is executed immediately after a connection for this profile has been established,
and a script that is executed before a connection is about to be closed. To define the scripts, click on the button
Connect scripts. A new window will be opened that contains two editors. Enter the script that should be executed upon
connecting into the upper editor, the script to be executed before disconnecting into the lower editor. You can put more
than one statement into the scripts. The statements have to be separated by a semicolon.

The statements that are executed will be logged in the message panel of the SQL panel where the connection is created.
You will not see the log when a connection for the DbExplorer is created.

Execution of the script will stop at the first statement that throws an error. The error message will also be logged to the
message panel. If the connection is made for a DbExplorer panel, the errors will only be visible in the log file.

Keep alive script

Some DBMS are configured to disconnect an application that has been idle for some time. You can define an idle time
and a SQL statement that is executed when the connection has been idle for the defined interval. This is also available
when clicking on the Connect scripts.

The keep alive statement can not be a script, it can only be a single SQL statement (e.g. SELECT version() or
SELECT 42 FROM dual). You may not enter the trailing semicolon.

The idle time is defined im milliseconds, but you can also enter the interval in seconds or minutes by appending the
letter 's' (for seconds) or 'm' (for minutes) to the value. e.g.: 30000 (30 seconds), or 45s (45 seconds), or 10m (10
minutes).

You can disable the keep alive feature by deleting the entry for the interval but keeping the SQL statement. Thus you
can quickly turn off the keep alive feature but keep the SQL statement for the next time.

5.5.17. Schema and Catalog filters

If your database contains a lot of schema or catalogs that you don't want to be listed in the dropdown of the DbExplorer,
you can define filter expressions to hide certain entries.

The filters are defined by clicking on the Schema/Catalog Filter button. The filter dialog contains two input fields, one
to filter schema name and one to filter catalog names.

Each line of the filter definition defines a single regular expression of schema/catalog names to be excluded from the
dropdown, i.e. if a schema/catalog matches the defined name, it will not be listed in the dropdown.

The filter items are treated as regular expressions, so the standard SQL wildcards will not work here. The basic
expression is just a name (e.g. MDSYS). Comparison is always done case-insensitive. So mdsys and MDSYS will
achieve the same thing.
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If you want to filter all schemas that start with a certain value, the regular expression would be: ^pg_toast.*. Note
the dot followed by a * at the end. In a regular expression the dot matches any character, and the * will allow any
number of characters to follow. The ^ specifies that the whole string must occur at the beginning of the value.

The regular expression must match completely in order to exlude the value from the dropdown.

If you want to learn more about regular expressions, please have a look at http://www.regular-expressions.info/

5.6. Connect to Oracle with SYSDBA privilege

Connecting to Oracle with SYSDBA privilege can be done by supplying an additional property to the driver when
connecting.

In the profile dialog, click on the Extended Properties button. Add a new property in the following window with the
name internal_logon and the value sysdba. Now close the dialog by clicking on the OK button. This property
will be passed on to the JDBC driver, which will enable the SYSDBA role when connecting to the server.

The profile itself has to use an Oracle user account that is allowed to connect as SYSDBA (e.g. SYS).

5.7. ODBC connections without a data source

On Microsoft Windows® you can use the ODBC bridge to connect to ODBC datasources. For some drivers you don't
need to create an ODBC datasource in order to be able to use the ODBC driver. The following URLs can be used to
connect to data files directly.

The class name of the driver is sun.jdbc.odbc.JdbcOdbcDriver

ODBC
Connection

URL to be used

Excel jdbc:odbc:DRIVER={Microsoft Excel Driver (*.xls)};DBQ=<filename>

Access jdbc:odbc:DRIVER={Microsoft Access Driver (*.mdb)};DBQ=<filename>

dBase jdbc:odbc:DRIVER={Microsoft dBase Driver (*.dbf)};DefaultDir=<directory where the .dbf files are
located>

http://www.regular-expressions.info/
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6. Editing SQL Statements

6.1. Editing files

You can load and save the editor's content into external files (e.g. for re-using) them in other SQL tools.

To load a file use File » Open... or right click on the tab's label and choose Open... from the popup menu.

The association between an editor tab and the external file will be saved in the workspace that is used for the current
connection. When opening the workspace (e.g. by connecting using a profile that is linked to that workspace) the
external file will be loaded as well.

If you want to run very large SQL scripts (e.g. over 15MB) it is recommended to execute them using
WbInclude rather than loading them completely into the editor. WbInclude will not load the script into
memory, thus you can even run scripts that would not fit into memory.

6.2. Command completion

The editor can show a popup window with a list of available tables (and views) or a list of available columns for a table.
Which list is displayed depends on the position of the cursor inside the statement.

If the cursor is located in the column list of a SELECT statement and the FROM part already contains the necessary
tables, the window will show the columns available in the table. Assuming you are editing the following statement ( the
| indicating the position of the caret):

SELECT p.|, p.firstname, a.zip, a.city
FROM person p
  JOIN address a ON p.id = a.person_id;

then pressing the Ctrl-Space key will show a list of columns available in the PERSON table (because the cursor is
located after the p. alias). If you put the cursor after the a.city column and press the Ctrl-Space the popup window
will list the two tables that are referenced in the FROM part of the statement. The behaviour when editing the WHERE
part of an statement is similar.

When editing the list of tables in the FROM part of the statement, pressing the Ctrl-Space will pop up a list of available
tables.

The editor assumes that the standard semicolon is used to separate statements when doing auto-completion or using the
"Execute current" function. This can be changed to a non-standard behaviour through the options dialog  so that the
editor also recognizes empty lines as a statement delimiter.

Parameters for SQL Workbench/J specific commands are also supported by the command completion. The parameters
will only be shown, if you have already typed the leading dash, e.g. WbImport -. If you press the shortcut for the
command completion while the cursor is located after the dash, a list of available options for the current comand is
shown. Once the parameter has been added, you can display a list of possible values for the parameter if the cursor is
located after the equals sign. for WbImport -mode= will display a list of allowed values for the -mode parameter.
For parameters where table names can be supplied the usual table list will be shown.

6.3. JOIN completion

When using ANSI JOIN syntax to create table joins with tables linked by foreign keys in the database, the command
JOIN completion can be used to automatically generate the necessary join condition. Consider the following
statement
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SELECT ord.amount, ord.order_date, prod.name
FROM orders ord
  JOIN product prod ON

When the cursor is located behind the ONkeyword, and you select SQL » JOIN completion, SQL Workbench/J will
retrieve the foreign key and corresponding primary key definitions between the tables orders and product. If
such constraints exist, the corresponding condition will be generated and written into the editor. After executing JOIN
completion, the SQL statement will look like this:

SELECT ord.amount, ord.order_date, prod.name
FROM orders ord
  JOIN product prod ON prod.id = ord.product_id

This feature depends on the usage of the JOIN keyword. Joining tables in the WHERE clause is not supported!

6.4. Customizing keyword highlighting

The keywords that the editor can highlight are based on an internal list of keywords and information obtained from the
JDBC driver. You can extend the list of known keywords using text files located in the config directory.

SQL Workbench/J reads four different types of keywords: regular keywords (e.g. SELECT), datatypes (e.g.
VARCHAR), functions (e.g. upper()) and operators (e.g. JOIN). Each keyword type is read from a separate file:
keywords.wb, datatypes.wb, functions.wb and operators.wb.

The files contain one keyword per line. Case does not matter (SELECT and select are treated identically). If you
want to add a specific word to the list of global keywords, simply create a plain text file keywords.wb in the config
directory and put one keyword per line into the file, e.g:

ALIAS
ADD
ALTER

If you want to define keywords specific for a DBMS, you need to add the DBID as a prefix to the filename, e.g.
oracle.datatypes.wb.

To add the word geometry as a datatype for the editor when connected to a PostgreSQL database, create the file
postgresql.datatypes.wb in the config directory with the following contents:

geometry

The words defined for a specific database are added to the globally recognized keywords, so you don't need to repeat all
existing words in the file.

The color for each type of keyword can be changed in the options dialog.

6.5. Reformat SQL

When you analyze statements from e.g. a log file, they are not necessarily formatted in a way that can be easily read,
let alone understood. The editor of the SQL Workbench/J can reformat SQL statements into a format that's easier to
read and understand for a human being. This feature is often called pretty-printing. Suppose you have the following
statement (pasted from a log file)

select user.* from user, user_profile, user_data
where user.user_id = user_profile.user_id and
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user_profile.user_id = uprof.user_id and user_data.user_role = 1
and user_data.delete_flag = 'F' and not exists
(select 1 from data_detail where data_detail.id = user_data.id and
data_detail.flag = 'X' and data_detail.value > 42)

this will be reformatted to look like this:

SELECT user.*
FROM user,
     user_profile,
     user_data
WHERE user.user_id = user_profile.user_id
AND   user_profile.user_id = uprof.user_id
AND   user_data.user_role = 1
AND   user_data.delete_flag = 'F'
AND   NOT EXISTS (SELECT 1
                  FROM data_detail
                  WHERE data_detail.id = user_data.id
                  AND   data_detail.flag = 'x'
                  AND   data_detail.value > 42)

You can configure a threshold up to which sub-SELECTs will not be reformatted but put into one single line. The
default for this threshold is 80 characters. Meaning that any subselect that is shorter than 80 characters will not be
reformatted as the sub-SELECT in the above example. Please refer to Formatting options for details.

6.6. Create SQL value lists

Sometimes when you Copy & Paste lines of text from e.g. a spreadsheet, you might want to use those values as a
condition for a SQL IN expression. Suppose you a have a list of ID's in your spreadsheet each in one row of the same
column. If you copy and paste this into the editor, each ID will be put on a separate line. If you select the text, and then
choose SQL » Create SQL List the selected text will be converted into a format that can be used as an expression for an
IN condition:

Dent
Beeblebrox
Prefect
Trillian
Marvin

will be converted to:

('Dent',
 'Beeblebrox',
 'Trillian',
 'Prefect',
 'Marvin')

The function SQL » Create non-char SQL List is basically the same. The only difference is, that it assumes that each
item in the list is a numeric value, and no single quotes are placed around the values.

The following list:

42
43
44
45
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will be converted to:

(42, 43, 44, 45)

These two functions will only be available when text is selected which spans more then one line.

6.7. Programming related editor functions

The editor of the SQL Workbench/J offers two functions to aid in developing SQL statements which should be used
inside your programming language (e.g. for SQL statements inside a Java program).

6.7.1. Copy Code Snippet

Suppose you have created the SQL statement that you wish to use inside your application to access your DBMS. The
menu item SQL » Copy Code Snippet will create a piece of code that defines a String variable which contains the
current SQL statement (or the currently selected statement if any text is selected).

If you have the following SQL statement in your editor:

SELECT p.name,
       p.firstname,
       a.street,
       a.zipcode,
       a.phone
FROM person p,
     address a
WHERE p.person_id = a.person_id;

When copying the code snippet, the following text will be placed into the clipboard

String sql="SELECT p.name, \n" +
"       p.firstname, \n" +
"       a.street, \n" +
"       a.zipcode, \n" +
"       a.phone \n" +
"FROM person p, \n" +
"     address a \n" +
"WHERE p.person_id = a.person_id; \n";

You can now paste this code into your application.

If you don't like the \n character in your code, you can disable the generation of the newline characters in you
workbench.settings file. See Manual settings for details. You can also customize the prefix (String sql =)
and the concatenation character that is used, in order to support the programming language that you use.

6.7.2. Clean Java code

When using the Copy Code Snippet feature during development, the SQL statement usually needs refinement after
testing the Java class. You can Copy & Paste the generated Java code into SQL Workbench/J, then when you select
the pasted text, and call SQL » Clean Java Code the selected text will be "cleaned" from the Java stuff around it. The
algorithm behind that is as follows: remove everything up to the first " at the beginning of the line. Delete everything
up to the first " searching backwards from the end of the line. Any trailing white-space including escaped characters
such as \n will be removed as well. Lines starting with // will be converted to SQL single line comments starting with --
(keeping existing quotes!). The following code:
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String sql="SELECT p.name, \n" +
"       p.firstname, \n" +
"       a.street, \n" +
//"       a.county, \n" +
"       a.zipcode, \n" +
"       a.phone \n" +
"FROM person p, \n" +
"     address a \n" +
"WHERE p.person_id = a.person_id; \n"

will be converted to:

SELECT p.name,
       p.firstname,
       a.street,
--"       a.county, " +
       a.zipcode,
       a.phone
FROM person p,
     address a
WHERE p.person_id = a.person_id;

6.7.3. Support for prepared statements

For better performance Java applications usually make use of prepared statements. The SQL for a prepared statement
does not contain the actual values that should be used e.g. in the WHERE clause, but uses quotation marks instead. Let's
assume the above example should be enhanced to retrieve the person information for a specific ID. The code could look
like this:

String sql="SELECT p.name, \n" +
"       p.firstname, \n" +
"       a.street, \n" +
"       a.zipcode, \n" +
"       a.phone \n" +
"FROM person p, \n" +
"     address a \n" +
"WHERE p.person_id = a.person_id; \n" +
"  AND p.person_id = ?";

You can copy and clean the SQL statement but you will not be able to execute it, because there is no value available for
the parameter denoted by the question mark. To run this kind of statements, you need to enable the prepared statement
detection using SQL » Detect prepared statements

Once the prepared statement detection is enabled, SQL Workbench/J will examine each statement to check whether it
is a prepared statement. This examination is delegated to the JDBC driver and does cause some overhead when running
the statement. For performance reasons you should disable the detection, if you are not using prepared statements in the
editor (especially when running large scripts).

If a prepared statement is detected, you will be prompted to enter a value for each defined parameter. The dialog will
list all parameters of the statement together with their type as returned by the JDBC driver. Once you have entered
a value for each parameter, clicking OK will execute the statement using those values. When you execute the SQL
statement the next time, the old values will be presevered, and you can either use them again or modify them before
running the statement.

Once you are satisfied with your SQL statement, you can copy the statement and paste the Java code into your program.

Prepared statements are supported for SELECT, INSERT, UPDATE and DELETE statements.

http://java.sun.com/javase/6/docs/api/java/sql/PreparedStatement.html
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This feature requires that the getParameterCount() and getParameterType() methods of the
ParameterMetaData class are implemented by the JDBC driver and return the correct information about
the available parameters.

The following drivers have been found to support (at least partially) this feature:

• PostgreSQL, driver version 8.1-build 405

• H2 Database Engine, Version 1.0.73

• Apache Derby, Version 10.2

• Firebird SQL, Jaybird 2.0 driver

• HSQLDB, version 1.8.0

Drivers known to not support this feature:

• Oracle 10g driver (ojdbc14.jar)

• Microsoft SQL Server 2000/2005 driver (sqljdbc.jar)

http://java.sun.com/javase/6/docs/api/java/sql/ParameterMetaData.html#getParameterCount()
http://java.sun.com/javase/6/docs/api/java/sql/ParameterMetaData.html#getParameterType(int)
http://www.postgresql.org
http://www.h2database.com
http://db.apache.org/derby/
http://www.firebirdsql.org/
http://hsqldb.sourceforge.net
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7. Using SQL Workbench/J

7.1. Displaying help

You have two possibilities to display help for SQL Workbench/J. Either a HTML based help or a PDF version of the
manual.

The HTML help is available through the menu item Help » Contents It is expected that the HTML manual is stored in a
directory called manual in the same directory where sqlworkbench.jar is located. This is automatically the case
when you extract the distribution archive with sub-directories.

You can choose to display a single-page version of the HTML help (easier to search) or a multi-page version of the help
that is easier to navigatie. This can be switched in the options dialog, that is accessible from Tools » Option.

The the PDF manual can be displayed by selecting Help » Manual. In order to be able to display the PDF manual, you
need to define the path to the executable for the PDF reader in the General options section of the options dialog.

The file SQLWorkbench-Manual.pdf must be available in the directory where sqlworkbench.jar is located.

When connected to a database, the menu item Help » DBMS Manual will display the online manual for the current
DBMS (if there is one). The default configuration includes the URLs for PostgreSQL, Oracle 10g, H2, HSQLDB,
MySQL 5.1 and Microsoft SQL Server 2005.

The URL that is used to display the manual can be changed in the configuration file workbench.settings.

7.2. Resizing windows

Every window that is opened by SQL Workbench/J for the first time is displayed with a default size. In certain cases it
can happen that not all labels are readable or all controls are visible on the window. This can happen, e.g. when a large
default font is selected (or defined through the look and feel).

Every window in SQL Workbench/J can be resized and will remember its size. So in case no everything is readable on a
dialog, just resize the window so that the missing parts become visible, and that size will be kept for the future.

7.3. Executing SQL statements

7.3.1. Control the statement to be executed

There are three different ways to execute a SQL command

Execute the selected text

When you press Ctrl-E or select SQL » Execute selected the currently selected text will be send to the DBMS for
execution. If no text is selected the complete contents of the editor will be send to the database.

Execute current statement

When you press Ctrl-Enter or select SQL » Execute current the current statement will be executed. The "current"
statement will be the text between the next delimiter before the current cursor position and the delimiter after the cursor
position.

Example (| indicating the cursor position)

SELECT firstname, lastname FROM person;
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DELETE FROM person| WHERE lastname = 'Dent';
COMMIT;

When pressing Ctrl-Enter the DELETE statement will be exectuted

You can configure SQL Workbench/J to automatically jump to the next statement, after executing the current statement.
Simply select SQL » Auto advance to next The check mark next to the menu item indicates if this option is enabled.
This option can also be changed through the Options dialog

Execute All

If you want to execute the complete text in the editor regardless of the current selection, use the Execute all command.
Either by pressing Ctrl-Shift-E or selecting SQL » Execute All

When executing all statements in the editor you have to delimit each statement, so that SQL Workbench/J can identify
each statement. If your statements are not delimited using a semicolon, the whole editor text is sent as a single statement
to the database. Some DBMS support this (e.g. Microsoft SQL Server), but most DBMS will throw an error in that case.

A script with two statements could look like this:

UPDATE person SET numheads = 2 WHERE name='Beeblebrox';
COMMIT;

or:

DELETE FROM person;
DELETE FROM address;
COMMIT;

INSERT INTO person
(id, firstname, lastname)
VALUES
(1, 'Arthur', 'Dent');

INSERT INTO person
(id, firstname, lastname)
VALUES
(4, 'Mary', 'Moviestar');

INSERT INTO person
(id, firstname, lastname)
VALUES
(2, 'Zaphod', 'Beeblebrox');

INSERT INTO person
(id, firstname, lastname)
VALUES
(3, 'Tricia', 'McMillian');

COMMIT;

You can specifiy an alternate delimiter that can be used instead of the semicolon. See the description of the alternate
delimiter for details. This is also needed when running DDL scripts (e.g. for stored procedures) that contain semicolons
that should not delimit the statements.

As long as at least one statement is running the title of the main window will be prefixed with the » sign. Even if the
main window is minimized you can still see if a statement is running by looking at the window title.
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You can use variables in your SQL statements that are replaced when the statement is executed. Details on how to use
variables can be found in the chapter Variable substitution.

JDBC drivers do not support multi-threaded execution of statements on the same physical connection. If you want to
run two statements at the same time, you will need to enable the Separate connection per tab option in your connection
profile. In this case SQL Workbench/J will open a physical connection for each SQL tab, so that statements in the
different tabs can run concurrently.

Statement history

When executing a statement the contents of the editor is put into an internal buffer together with the information about
the text selection and the cursor position. Even when you select a part of the current text and execute that statement, the
whole text is stored in the history buffer together with the selection information. When you select and execute different
parts of the text and then move through the history you will see the selection change for each history entry.

The previous statement can be recalled by pressing Alt-Left or choosing SQL » Previous Statement statement from the
menu. Once the previous statement(s) have been recalled the next statement can be shown using Alt-Right or choosing
SQL » Next Statement from the menu. This is similar to browsing through the history of a web browser.

You can clear the statement history for the current tab, but selecting SQL » Clear history
When you clear the content of the editor (e.g. by selecting the whole text and then pressing the Del key) this
will not clear the statement history. When you load the associated workspace the next time, the editor will
automatically display the last statement from the history. You need to manually clear the statement history, if
you want an empty editor the next time you load the workspace.

7.4. Displaying results

When you run SQL statements that produce a result (such as a SELECT statement) these results will be displayed in the
lower pane of the window, next to the message panel. For each result that is returned from the server, one tab (labelled
"Result") will be created. If you select and execute three SELECT statements, the lower pane will show three result tabs
and the message tab. If your statement(s) did not produce any result, only the messages tab will be displayed.

SQL Workbench/J will read all rows returned by your statement into memory. When retrieving large results
you might run out of memory. To adjust the memory available to SQL Workbench/J please refer to this
chapter.

When you run a SQL statement, the current results will be cleared and replaced by the new results. You can turn this
off by selecting SQL » Append new results. Every result that is retrieved while this option is turned on, will be added to
the set of result tabs, until you de-select this option. This can also be toggled using the button on the toolbar. Additional
result tabs can be closed using Data » Close result

You can also run stored procedures that return result sets. These result will be displayed in the same way. For DBMS's
that support mulitple result sets from a single stored procedure (e.g. Microsoft SQL Server), one tab will be displayed
for each result returned.

7.4.1. Displaying values with embedded newlines

Data from VARCHAR or CHAR columns is displayed as a single-line if the column's max. size is below 250 characters. If
you have data in smaller columns that contains newlines (linebreaks) and you want to display directly in the result set,
please adjust the limit to match your needs. The limit can be changed in the Data Display Options.

7.4.2. Naming result tabs

You can change the name of the result tab associated with a statement. To give a result set a name you have to provide
a comment before the SQL statement that contains the keyword @wbresult followed by a whitespace and then the
name that should appear as the result's name. The keywords must be specified in lowercase!
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The following examples executes two statements. The result for the first will be labelled "List of contacts" and the
second will be labelled "List of companies":

-- @wbresult List of contacts
SELECT * FROM person;

/*
 @wbresult List of companies
 this will retrieve all companies from the database
*/
SELECT * FROM company;

As you can see, you can put the @wbresult keyword into a single-line or multi-line comment. The name that is used,
will be everything after the keyword until the end of the line.

For the second select (with the multi-line comment), the name of the result tab will be List of companies, the
comment on the second line will not be considered.

7.5. Creating stored procedures and triggers

SQL Workbench/J will send the contents of the editor unaltered to the DBMS, so executing DDL statements (CREATE
TABLE, ...) is possible.

However when executing statements such as CREATE PROCEDURE which in turn contain valid SQL statement,
delimited with a ; the SQL Workbench/J will send everything up to the first semicolon to the backend. In case of a
CREATE PROCEDURE statement this will obviously result in an error as the statement is not complete.

This is an example of a CREATE PROCEDURE which will not work due to the embedded semicolon in the procedure
source itself.

CREATE OR REPLACE FUNCTION proc_sample RETURN INTEGER
IS
  result INTEGER;
BEGIN
  SELECT max(col1) INTO result FROM sometable;
  RETURN result;
END;

When executing this script, Oracle would return an error because SQL Workbench/J will send everything up to the
keyword INTEGER to the database. Obviously that fragment would not be correct.

The solution is to terminate the script with a character sequence called the "alternate delimiter". The value of this
sequence can be configured in the options dialog as a global default, or per connection profile (so you can use different
alternate delimiters for different database systems). The default is the forward slash / defined as a single line delimiter.

If a SQL statement is terminated with the alternate delimiter, that delimiter is used instead of a semicolon. This way the
semicolons embedded in CREATE PROCEDURE statements will be sent correctly to the backend DBMS.

So the solution to the above problem is the following script:

CREATE OR REPLACE FUNCTION proc_sample RETURN INTEGER
IS
  result INTEGER;
BEGIN
  SELECT max(col1) INTO result FROM sometable;
  RETURN result;
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END;
/

Note the trailing forward slash (/) at the end in order to "turn on" the use of the alternate delimiter. If you run scripts
with embedded semicolons and you get an error, please verify the setting for your alternate delimiter.

When is the alternate delimiter used?

As soon as the statement (or script) that you execute is terminated with the alternate delimiter, the alternate delimiter
is used to separate the individual SQL statements. When you execute selected text from the editor, be sure to select the
alternate delimiter as well, otherwise it will not be recognized (if the alternate delimiter is not selected, the statement to
be executed does not end with the alternate delimiter).

You cannot mix the standard semicolon and the alternate delimiter inside one script.

If you use the alternate delimiter (by terminating the whole script with it), then all statements have to be delimited
with it. You cannot mix the use of the normal semicolon and the alternate delimiter for one execution. The following
statement (when executed completely) would produce an error message:

SELECT sysdate FROM DUAL;

CREATE OR REPLACE FUNCTION proc_sample RETURN INTEGER
IS
  result INTEGER;
BEGIN
  SELECT max(col1) INTO result FROM sometable;
  RETURN result;
END;
/

SQL Workbench/J will use the alternate delimiter present, the SELECT statement at the beginning will also be sent to
the database together with the CREATE statement. This of course is an invalid statement. You will need to either select
and run each statement individually or change the delimiter after the SELECT to the alternate delimiter.

7.6. Dealing with BLOB and CLOB columns

SQL Workbench/J supports reading and writing BLOB (Binary Large OBject) or CLOB (Character Large OBject)
columns from and to external files. BLOB clumns are sometimes also referred to as binary data. CLOB columns are
sometimes also referred to as LONG VARCHAR. The exact data type depends on the DBMS used.

To insert and update LOB columns the usual INSERT and UPDATE statements can be used by using a special
placeholder to define the source for the LOB data. When updating the LOB column, a different placeholder for BLOB
and CLOB columns has to be used as the process of reading and sending the data is different for binary and character
data.

When working with Oracle, only the 10g driver supports the standard JDBC calls used by SQL Workbench/J to
read and write the LOB data. Earlier drivers will not work as described in this chapter.

7.6.1. Updating BLOB data through SQL

To update a BLOB (or binary) column, use the placeholder {$blobfile=path_to_file} in the place where the
actual value has to occur in the INSERT or UPDATE statement:

UPDATE theTable
  SET blob_col = {$blobfile=c:/data/image.bmp}
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WHERE id=24;

SQL Workbench/J will rewrite the UPDATE statement and send the contents of the file located in c:/data/
image.bmp to the database. The syntax for inserting BLOB data is similar. Note that some DBMS might not allow
you to supply a value for the blob column during an insert. In this case you need to first insert the row without the blob
column, then use an UPDATE to send the blob data. You should make sure to update only one row by specifying an
approriate WHERE clause.

INSERT INTO theTable
(id, blob_col)
VALUES
(42,{$blobfile=c:/data/image.bmp});

This will create a new record with id=42 and the content of c:/data/image.bmp in the column blob_col

7.6.2. Updating CLOB data through SQL

The process of updating or inserting CLOB data is identical to the process for BLOB data. The only difference is in the
syntax of the placeholder used to specify the source file. Firstly, the placeholder has to start with {$clobfile= and
can optionally contain a parameter to define the encoding of the source file.

UPDATE theTable
  SET clob_col = {$clobfile=c:/data/manual.html encoding=utf8}
WHERE id=42;

If you ommit the encoding parameter, SQL Workbench/J will leave the data conversion to the JDBC driver (technically,
it will use the PreapredStatement.setAsciiStream() method whereas with an encoding it will use the
PreparedStatement.setCharacterStream() method).

The format of the {$clobfile=} or {$blobfile=} parameter has to be entered exactly as described here.
You may not put e.g. spaces before or after the equal sign or the braces. If you do this, SQL Workbench/J will
not recognize the parameter and will pass the statement "as is" to the JDBC driver.

7.6.3. Saving BLOB data to a file using SQL

To save the data stored in a BLOB column, the command WbSelectBlob can be used. The syntax of this command
is similar to the regular SELECT command except that a target file has to be specified where the read data should be
stored.

You can also use the WbExport command to export data. The contents of the BLOB columns will be saved into
separate files. This works for both export formats (XML and Text).

7.6.4. BLOB data in the result set

When the result of your SELECT query contains BLOB columns, they will be displayed as (BLOB) together with a
button. When you click on the button a dialog will be displayed allowing you to save the data to a file, view the data as
text (using the selected encoding), display the blob as an image or display a hex view of the blob.

When displaying the BLOB content as a text, you can edit the text. When saving the data, the entered text will be
converted to raw data using the selected encoding.

The window will also let you open the contents of the BLOB data with a predefined external tool. The tools that are
defined in the options dialog can be selected from a dropdown. To open the BLOB content with one of the tools,
select the tool from the dropdown list, then click on the button Open with next to the external tools dropdown. SQL
Workbench/J will then retrieve the BLOB data from the server, store it in a temporary file on your harddisk, and run the
selected application, passing the temporary file as a parameter.
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From within this information dialog, you can also upload a file to be stored in that BLOB column. The file contents will
not be sent to the database server until you actually save the changes to your result set (this is the same for all changes
you make directly in the result set, for details please refer to Editing the data)

When using the upload function in the BLOB info dialog, SQL Workbench/J will use the file content for any
subsequent display of the binary data or the the size information in the information dialog. You will need to re-
retrieve the data, in order to use the blob data from the server.

7.7. Performance tuning when executing SQL

There are some configuration settings that affect the performance of SQL Workbench/J. On slow computers it is
recommended to turn off the usage of the animated icon as the indicator for a running statement.

When running large scripts, the feedback which statement is executed can also slow down the execution. It is
recommended to either turn off the feedback using WBFEEDBACK OFF or by consolidating the script log

When running imports or exports it is recommended to turn off the progress display in the statusbar that shows the
current row that is imported/exported because this will slow down the process as well. In both cases you can use -
showProgress to turn off the display (or set it to a high number such as 1000) in order to reduce the overhead
caused by updating the screen.

7.8. SQL Macros

SQL Workbench/J offers so called SQL macros, or abbreviations. You can define macros for often used SQL
statements. Once defined, you only need to enter the defined macro name and the underlying SQL statement will be
executed.

7.8.1. Defining Macros

There are two ways to define a SQL macro.

If the current statement in the editor should be defined as a macro, select (highlight) the statement's text and select
Macros » Add SQL macro from the main menu. You will be prompted to supply a name for the new macro. If you
supply the name of an existing macro, the existing macro will be overwritten.

Alternatively you can add a new macro through Macros » Manage Macros.... This dialog can also be used to delete and
and edit existing macros. You can put macros into separate groups (e.g. one for PostgreSQL macros, one for Oracle
etc). If you have only one group defined (or only one visible group), all macros of that group will be listed in the menu
directly. If you define more than one group, each group will appear as a separate sub-menu.

The order in which the macros (or groups) appear in the menu can be changed by dragging them to the desired position
in the manage macro dialog.

7.8.2. Executing macros

To execute a macro, you can either type the alias you have defined, or select the macro from the Macros menu. Note
that the alias needs to be unique to be used as a "SQL Statement". If you have two different macros in two different
macro groups with the same name, it is not defined which of them will be executed.

To view the complete list of macros select Macros » Manage Macros... After selecting a macro, it can be executed
by clicking on the Run Run button. If you check the option "Replace current SQL", then the text in the editor will be
replaced with the text from the macro when you click on the run button.
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Macros will no be evaluated when running in batch mode.

7.8.3. Parameters in macros

Apart from the SQL Workbench/J script variables for SQL Statements, additional "parameters" can be used inside a
macro definition. These parameters will be replaced before replacing the script variables.

Parameter Description

${selection}$ This parameter will be replaced with the currently selected text. The selected text will not
be altered in any way.

${selected_statement}$ This behaves similar to ${selection}$ except that any trailing semicolon will be
removed from the selection. Thus the macro definition can always contain the semicolon
(e.g. when the macro actually defines a script with multiple statements) but when selecting
the text, you do not need to worry whether a semicolon is selected or not (and would
potentially break the script).

${current_statement}$ This key will be replaced with the current statement (without the trailing delimiter). The
current statement is defined by the cursor location and is the statement that would be
executed when using SQL » Execute current [33]

${text}$ This key will be replaced with the complete text from the editor (regardless of any
selection).

The SQL statement that is eventually executed will be logged into the message panel when invoking the macro from the
menu. Macros that use the above paramters cannot correctly be executed by entering the macro alias in the SQL editor
(and then executing the "statement").

The parameter keywords are case sensitiv, i.e. the text ${SELECTION}$ will not be replaced!

This feature can be used to create SQL scripts that work only with with an additional statement. e.g. for Oracle you
could define a macro to run an explain plan for the current statement:

EXPLAIN PLAN FOR
${current_statement}$
;

COMMIT;

SELECT * FROM TABLE(DBMS_XPLAN.DISPLAY);

When you run this macro, it will run an EXPLAIN PLAN for the statement in which the cursor is currently located,
and will immediately display the results for the explain. Note that the ${current_statement}$ keyword is
terminated with a semicolon, as the replacement for ${current_statement}$ will never add the semicolon. If
you use ${selection}$ instead, you have to pay attention to not select the semicolon in the editor before running
this macro.

For PostgreSQL you can define a similar macro that will automatically run the EXPLAIN command for a statemet:

explain ${current_statement}$

Another usage of the parameter replacement could be a SQL Statement that retrieves the rowcount that would be
returned by the current statement:

SELECT count(*) FROM
(
  ${current_statement}$
)
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7.9. Using workspaces

The complete history for all editor tabs is saved and loaded into one file, called a workspace. These workspaces can be
saved and loaded to restore a specific editing context. You can assign a saved workspace to a connection profile. When
the connection is established, the workspace is loaded into SQL Workbench/J. Using this feature you can maintain a
completely different set of statements for different connections.

If you do not assign a workspace to a connection profile, a workspace with the name Default.wksp will be used for
storing the statement history. This default workspace is shared between all profiles that have no workspace assigned.

To save the current SQL statement history and the visible tabs into a new workspace, select Workspace » Save
Workspace as....

The default file extension for workspaces is wksp.

Once you have loaded a workspace, you can save it with Workspace » Save Workspace. The current workspace is
automatically saved, when you exit SQL Workbench/J.

An existing workspace can be loaded with Workspace » Load Workspace

If you have an external file open in one of the editor tabs, the filename itself will be stored in workspace. When loading
the workspace SQL Workbench/J will try to load the external file again. If the file does not exist, the last history entry
from the saved history for that tab will be displayed.

The workspace file itself is a normal ZIP file, which contains one file with the statement history for each tab. The
individual files can be extracted from the workspace using your favorite UNZIP tool.

7.10. Saving and loading SQL scripts

The text from the current editor can be saved to an external file, by choosing File » Save or File » Save as. The filename
for the current editor will be remembered. To close the current file, select File » Discard file (Ctrl-F4) or use the
context menu on the tab label itself.

Detaching a file from the editor will remove the text from editor as well. If you only want to detach the
filename from the editor but keep the text, then press Ctrl-Shift-F4 or hold down the Shift key while selecting
the Discard menu item.

When you load a SQL script and execute the statements, be aware that due to the history management in SQL
Workbench/J the content of the external file will be placed into the history buffer. If you load large files, this might lead
to massive memory consumption. Currently only the number of statements put into the history can be controlled, but
not the total size of the history itself. You can prevent files from being put into the history by unchecking the option
"Files in history" in the Editor section of the options dialog.

7.11. Viewing server messages

7.11.1. PostgreSQL

PostgreSQL supports sending of messages to the client using the RAISE statement in PL/pgSQL. The following
function will display a result set (with the number 42) and the message area will contain the message Thinking hard...

CREATE OR REPLACE FUNCTION the_answer()
  RETURNS integer
  LANGUAGE plpgsql
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AS
$body$
BEGIN
  RAISE NOTICE 'Thinking hard...';
  RETURN 42;
END;
$body$
/

7.11.2. Oracle

For Oracle the DBMS_OUTPUT package is supported. Support for this package can be turned on with the
ENABLEOUT command. If this support is not turned on, the messages will not be displayed. This is the same as using
the SET SERVEROUTPUT ON command in SQL*Plus.

If you want to turn on support for DBMS_OUTPUT automatically when connecting to an Oracle database, you can put
the ENABLEOUT command into the pre-connect script.

Any message "printed" with DBMS_OUTPUT.put_line() will be displayed in the message part after the SQL
command has finished. Please refer to the Oracle documentation if you want to learn more about the DBMS_OUTPUT
package.

dbms_output.put_line("The answer is 42");

Once the command has finished, the following will be displayed in the Messages tab.

The answer is 42

7.11.3. MS SQL Server

For MS SQL Server, any message written with the PRINT command will be displayed in the Messages tab after the
SQL command has finished. The PRINT command is usually used in stored procedures for logging purposes, but it can
also be used as a command on its own:

PRINT "Deleting records...";
DELETE from my_table WHERE value = 42;
PRINT "Done."

This will execute the DELETE. Once this script has finished, the Messages tab will contain the text:

Deleting records...
Done.

7.11.4. Other database systems

If your DBMS supports something similar, please let me know. I will try to implement it - provided I have free access
to the DBMS. Please send your request to <support@sql-workbench.net>.

7.12. Editing data

Once the data has been retrieved from the database, it can be edited directly in the result set. SQL Workbench/J assumes
that enough columns have been retrieved from the table so that at a unique identifier is available to identify the rows to
be updated.
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If you have primary keys defined for the underlying tables, those primary key columns will be used for the WHERE
statements for UPDATE and DELETE. If no primary key columns are found, the JDBC driver is asked for a best row
identifier. If that doesn't return any information, your defined PK Mapping will be queried. If still no PK columns can
be found, you will be prompted to select the key columns based on the current result set.

The changes (modified, new or deleted rows) will not be saved to the database until you choose Data » Save
Changes to Database.

If the update is successful (no database errors) a COMMIT will be sent to the database automatically.

If your SELECT was based on more than one table, you will be prompted to specify which table should be updated.
Only columns for the chosen table will be included in the UPDATE or INSERT statements. If no primary key can be
found for the update table, you will be prompted to select the columns that should be used to uniquel identify a row in
the update table.

If an error is reported during the update, a ROLLBACK will be sent to the database. The COMMIT or ROLLBACK will
only be sent if autocommit is turned off.

Columns containing BLOB data will be displayed with a ... button. By clicking on that button, you can view the blob
data, save it to a file or upload the content of a file to the DBMS. Please refer to BLOB support for details.

When editing, SQL Workbench/J will highlight columns that are defined as NOT NULL in the database. You can turn
this feature off, or change the color that is used in the options dialog.

When editing date, timestamp or time fields, the format specified in the options dialog is used for parsing the
entered value and converting that into the internal representation of a date. The value entered must match the
format defined there.

If you want to input the current date and time you can use now, today, sysdate, current_timestamp,
current_date instead. This will then use the current date & time and will convert this to the approriate data type for
that column. e.g. now will be converted to the current time for a time column, the current date for a date column and
the current date/time for a timestamp column. These keywords also work when importing text files using WbImport or
importing a text file into the result set. The exact keywords that are recognized can be configure in the settings file

If the option Empty String is NULL is disabled for the current connection profile, you can still set a column's value to
null when editing it. To do this, double click the current value, so that you can edit it. In the context menu (right mouse
button) the option "Set to NULL" is available. This will clear the value and set it to NULL. You can assign a shortcut to
this action, but the shortcut will only be active when editing a value inside a column.

7.13. Deleting rows from the result

To delete a row from the result, select Data » Delete Row from the menu. This will remove the currently selected row(s)
from the result and will mark them for deletion once the changes are saved. No foreign key checks will be done when
using this option.

The generated DELETE statements will fail if the deleted row(s) are still referenced by another table. In that case, you
can use Delete With Dependencies.

7.14. Deleting rows with foreign keys

To delete rows including all dependent rows, choose Data » Delete With Dependencies. In this case SQL Workbench/J
will analyze all foreign keys referencing the update table, and will generate the necessary DELETE statements to delete
the dependent rows, before sending the DELETE for the selected row(s).

Delete With Dependencies might take some time to detect all foreign key dependencies for the current update table.
During this time a message will be displayed in the status bar. The selected row(s) will not be removed from the result
set until the dependency check has finished.
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Note that the generated SQL statements to delete the dependent rows will only be shown if you have enabled
the preview of generated DML statements in the options dialog

You can also generate a script to delete the selected and all depending rows through Data » Generate delete script. This
will not remove any rows from the current result set, but instead create and display a script that you can run at a later
time.

7.15. Navigating referenced rows

Once you have retrieved data from a table that has foreign key relations to other tables, you can navigate the
relationship for specific rows in the result set. Select the rows for which you want to find the data in the related tables,
then right click inside the result set. In the context menu two items are available:

Referenced rows
Referencing rows

Consider the following tables:

Referenced rows
Referencing rows
BASE (b_id, name)
DETAIL (d_id, base_id, description) with base_id referencing BASE(b_id)
MORE_DETAIL (md_id, detail_id, description) with detail_id referencing DETAIL (d_id)

The context menu for the selected rows will give you the choice in which SQL tab you want the generated SELECT to
be pasted. This is similar to the Put SELECT into feature in the table list of the DbExplorer.

Once you have obtained a result set from the table BASE, select (mark) the rows for which you want to retrieve the
related rows, e.g. the one where id=1. Using Referencing rows » DETAIL SQL Workbench/J will create the following
statement:

SELECT *
FROM DETAIL
WHERE base_id = 1;

The result of the generated statement will always be added to the existing results of the chosen SQL panel. By default
the generated SQL statement will be appended to the text editor. If you don't want the generated statement to be
appended to the editor, hold down the Ctrl key while selecting the desired menu item. In that case, the generated
statement will only be written to the messages panel of the SQL tab. If the target tab contains an external file, the
statement will never be appended to the editor's text.

To navigate from the child data to the "parent" data, use Referenced rows

The additional result tabs can be closed using Data » Close result

7.16. Sorting the result

The result will be displayed in the order returned by the DBMS (i.e. if you use an ORDER BY in your SELECT the
display will be displayed as sorted by the DBMS).

You can change the sorting of the displayed data by clicking on the header of the column that should be used for
sorting. After the first click the data will be sorted ascending (lower values at the top). If you click on the column again
the sort order will be reversed. The sort order will be indicated by a little triangle in the column header. If the triangle
points upward the data is sorted ascending, if it points downward the data is sorted descending. Clicking on a column
will remove any previous sorting (including the secondary columns) and apply the new sorting.
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If you want to sort by more than one column, hold down the Ctrl key will clicking on the (second) header. The initial
sort order is ascending for that additional column. To switch the sort order hold down the Ctrl key and click on the
column header again. The sort order for all "secondary" sort columns will be indicated with a slightly smaller triangle
than the one for the primary sort column.

To define a different secondary sort column, you first have to remove the current secondary column. This can be done
by holding down the Shift key and clicking on the secondary column again. Note that the data will not be resorted.
Once you have removed the secondary column, you can define a different secondary sort column.

By default SQL Workbench/J will use "ASCII" sorting which is case-sensitive and will not sort special characters
according to your language. You can change the locale that is used for sorting data in the options dialog under the
category "Data Display". Sorting using a locale is a bit slower than "ASCII" sorting.

7.17. Filtering the result

Once the data has been retrieved from the Server it can be filtered with the need to re-retrieve the data. You can define
the filter in two ways: either enter column and their filter values manually, or create a filter from the currently selected
values in the result set.

7.17.1. Defining a filter manually

To define a filter, click on the Filter button ( ) in the toolbar or select Data » Filter data. A dialog will appear
where you can define a filter for the current result set. Each line in the filter dialog defines an expression that will be
applied to the column selected in the first dropdown. If you select * for the column, the filter condition will be applied
to all columns of the result set.

To add a multi-column expression, press the More button, to create a new line. To remove a column expression

from the filter, click the Remove ( ) button. For character based column data, you can select to ignore the case
of the column's data when applying the expression, i.e. when Ignore case is selected, the expression 'NAME =
arthur' will match the column value 'Arthur', and 'ARTHUR'.

By default, the column expressions are combined with an OR, i.e. that a row will be displayed if at least one of the
column expressions evaluates to true. If you want to view only rows where all column expressions must match, select
the AND radio button at the top of the dialog.

Once you have saved a filter to an external file, this filter will be available in the pick list, next to the filter icon. The
list will show the last filters that were saved. The number of items displayed in this drop down can be controlled in the
settings file.

7.17.2. Defining a filter from the selection

You can also quickly filter the data based on the value(s) of the currenlty selected column(s). To apply the filter, select

the column values by which you want to filter then click on the Quickfilter button ( ) in the toolbar or select
Data » Filter by value from the menu bar.

Using the Alt key you can select individual columns of one or more rows. Together with the Ctrl key you can select
e.g. the first, third and fourth column. You can also select the e.g. second column of the first, second and fifth row.

Whether the quick filter is available depends on the selected rows and columns. It will be enabled when:

• You have selected one or more columns in a single row
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• You have selected one column in multiple rows

If only a single row is selected, the quick filter will use the values of the selected columns combined with AND to define
the filter (e.g. username = 'Bob' AND job = 'Clerk'). Which columns are used depends on the way you select the row
and columns. If the whole row in the result is selected, the quick filter will use the value of the focused column (the one
with the yellow rectangle), otherwise the individually selected columns will be used.

If you select a single column in multiple rows, this will create a filter for that column, but with the values will be
combined with OR (e.g. name = 'Dent' OR name = 'Prefect'). The quick filter will not be available if you select more
than one column in multiple rows.

Once you have applied a quick filter, you can use the regular filter definition dialog to check the definition of the filter
or to further modify it.

7.18. Running stored procedures

Stored procedures can be executed by using the SQL Workbench/J command WbCall which replaces the standard
commands available for the DBMS (e.g. CALL or EXECUTE). By using a special command, additional checks can be
carried out by SQL Workbench/J. This is especially necessary when dealing with OUT parameters or REF CURSORS.

The simplest way to run a stored procedure is:

WbCall my_proc();

When using Microsoft SQL Server, WbCall is not necessary as long as the stored procedure does not have OUT or REF
CURSOR parameters. So with SQL Server you can simply write:

sp_who2;

To run the stored procedure sp_who2 and to display it's results.

For more details on running a stored procedure with OUT parameters or REF CURSORS please refer to the description
of the WbCall command.

7.19. Export result data

You can export the data of the  into local files of the following formats:

• HTML

• SQL statements (INSERT, UPDATE or DELETE & INSERT)

• XML format

• Tab separated text file. Columns are separated with a tab, rows are separated with a newline character

• Spreadsheet Format (OpenDocument, Microsoft Excel)

In order to write the proprietary Microsoft Excel format, additional libraries are needed. Please refer to Exporting Excel
files for details.

To save the data from the current result set into an external file, choose Data » Save Data as You will be prompted for
the filename. On the right side of the file dialog you will have the possibility to define the type of the export. The export
parameters on the right side of the dialog are split into two parts. The upper part defines parameters that are available
for all export types. These are the encoding for the file, the format for date and date/time data and the columns that
should be exported.
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All format specific options that are available in the lower part, are also available when using the WbExport command.
For a detailed discussion of the individual options please refer to that section.

The options SQL UPDATE and SQL DELETE/INSERT are only available when the current result has a single table
that can be updated, and the primary key columns for that table could be retrieved. If the current result does not have
key columns defined, you can select the key columns that should be used when creating the file. If the current result is
retrieved from multiple tables, you have to supply a table name to be used for the SQL statements.

Please keep in mind that exporting the data from the result set requires you to load everything into memory. If you need
to export data sets which are too big to fit into memory, you should use the WbExport command to either create SQL
scripts or to save the data as text or XML files that can be imported into the database using the WbImport command.
You can also use SQL » Export query result to export the result of the currently selected SQL statement.

7.20. Copy data to the clipboard

You can also copy the data from the result into the system  in four different formats. In any case default settings are
used for the various options of the respective format.

• Text (tab separated)

This will use a tab as the column separator, and will not quote any values. The end-of-line sequence will be a newline
(Unix style) and the column headers will be part of the copied data. Special characters (e.g. newlines) in the actual
data will not be replaced (as it is possible with the WbExport command).

When you hold down the Shift key when you select the menu item, the column headers will not be copied to the
clipboard. When you hold down the Ctrl key when selecting the menu item, you can choose which columns should
be copied to the clipboard. Pressing Shift and Ctrl together is also supported.

• SQL (INSERT, UPDATE, or DELETE & INSERT)

The end-of-line sequence will be a newline (Unix style). No cleanup of data will be done as it is possible with the
WbExport command, apart from correctly quoting single quotes inside the values (which is required to generate valid
SQL)

As with the Save Data as command, the options SQL UPDATE and SQL DELETE/INSERT are only available
when the current result set is updateable. If no key columns could be retrieved for the current result, you can manually
define the key columns to be used, using Data » Define key columns

If you do not want to copy all columns to the clipboard, hold down the the CTRL key while selecting one of
the menu items related to the clipboard. A dialog will then let you select the columns that you want to copy.

Alternatively you can hold down the Alt key while selecting rows/columns in the result set. This will allow you to
select only the columns and rows that you want to copy. If you then use one of the formats available in the Copy
selected submenu, only the selected cells will be copied. If you choose to copy the data as UPDATE or DELETE/
INSERT statements, the generated SQL statements will not be correct if you did not select the primary key of the
underlying update table.

7.21. Import data into the result set

7.21.1. Import a file into the current result set

SQL Workbench/J can import tab separated text files into the current result set. This means, that you need to issue the
approriate SELECT statement first. The structure of the file has to match the structure of the result set, otherwise an
error will occur. To initiate the import select Data » Import file
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When selecting the file, you can change some parameters for the import:

Option Description

Header if this option this is checked, the first line of the import file will be
ignored

Delimiter the delimiter used to separate column values. Enter \t for the tab
character

Date Format The format in which date fields are specified.

Decimal char The character that is used to indicate the decimals in numeric values
(typically a dot or a comma)

Quote char The character used to quote values with special characters. Make
sure that each opening quote is followed by a closing quote in your
text file.

You can also import text and XML files using the WbImport command. Using the WbImport command is the
recommended way to import data, as it is much more flexible, and - more important - it does not read the data into
memory.

7.21.2. Import the clipboard into the current result

You can import the contents of the  into the current result, if the format matches the result set. When you select Data »
Import from Clipboar SQL Workbench/J will check if the current clipboard contents can be imported into the current
result. The data can automatically be imported if the first row of the data contains the column names. One of the
following two conditions must be true in order for the import to succeed

• The columns are delimited with a tab character and the first row contains column names. All matching columns will
then be imported

• If no column name matches (i.e. no header row is present) but the number of columns (identified by the number of
tab characters in the first row) is identical to the number of columns in the current result.

If SQL Workbench/J cannot identify the format of the clipboard a dialog will be opened where you can specify the
format of the clipboard contents. This is mainly necessary if the delimiter is not the tab character. You can manually
open that dialog, by holding down the Ctrl key when clicking on the menu item.
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8. Variable substitution in SQL statements

8.1. Defining variables

You can define variables within SQL Workbench/J that can be referenced in your SQL statements. This is done through
the internal command WbVarDef, e.g.: wbvardef myvar=42 This example defines a variable with the name
myvar and the value 42. If the variable does not exist, it will be created. If it exists its value will be overwritten with
the new value. To remove a variable simply set its value to nothing: wbvardef myvar=. Alternatevily you can use
the command wbvardelete myvar to remove a variable definition.

Variable substitution is also done within Macros. If your macro definition contains a reference to a SQL Workbench/J
variable, this will be treated the same way as in regular statements.

Variables are case sensitive.

Variables can also be read from a properties file, either by specifying -file=filename for the WbVarDef
command, or by passing the -vardef parameter when starting SQL Workbench/J. Please see the description for the
command line parameters for details.

wbvardef -file=/temp/myvars.def

This file has to be a standard Java "properties" file. Each variable is listed on a single line in the format
variable=value. Lines starting with a # character are ignored (comments). Assuming the file myvars.def had
the following content:

#Define the ID that we need later
var_id=42
person_name=Dent
another_variable=24

After executing wbvardef -file=/temp/myvars.def there would be three variables available in the system:
var_id, person_name, another_variable, that could be used e.g. in a SELECT query:

SELECT * FROM person where name='$[person_name]' or id=$[var_id];

SQL Workbench/J would expand the variables and send the following statement to the server:

SELECT * FROM person where name='Dent' or id=42;

A variable can also be defined as the result of a SELECT statement. This indicated by using @ as the first character
after the equal sign. The SELECT needs to be enclosed in double quotes, if you are using single quotes e.g. in the where
clause:

wbvardef myvar=@"SELECT id FROM person WHERE name='Dent'"

When executing the statement, SQL Workbench/J uses the first column of the first row of the result set for retrieving
the value for the variable. Everything else (additional columns, additional rows) will be ignored.

You can also use PreparedStatements in the SQL editor. In this case the parameters are denoted by quotation marks
and you will be prompted for a value each time you run the statement (which is different to using SQL Workbench/J
variables. For details on how to use prepared statements refer to support for prepared statements
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8.2. Editing variables

To view a list of currently defined variables execute the command WBVARLIST. This will display a list of currently
defined variables and their values. You can edit the resulting list similar to editing the result of a SELECT statement.
You can add new variables by adding a row to the result, remove existing variables by deleting rows from the result, or
edit the value of a variable. If you change the name of a variable, this is the same as removing the old, and creating a
new one.

8.3. Using variables in SQL statements

The defined variables can be used by enclosing them in special characters inside the SQL statement. The default is set
to $[ and ] thus you can use a variable this way:

SELECT firstname, lastname FROM person WHERE id=$[id_variable];

If you have a variable with the name id_variable defined, the sequence $[id_variable] will be replaced with
the current value of the variable.

Variables will be replaced after replacing macro parameters.

If the SQL statement requires quotes for the SQL literal, you can either put the quotes into the value of the variable
(e.g. wbvardef name="'Arthur'") or you put the quotes around the variable's placeholder, e.g.: WHERE
name='$[name]';

As you can see the variable substitution is also done inside quoted literals.

If you are using values in your regualar statements that actually need the prefix ($[ or suffix (]) characters, please
make sure that you have no variables defined. Otherwise you will unpredictable results. If you want to use variables but
need to use the default prefix for marking variables in your statements, you can configure a different prefix and suffix
for flagging variables. To change the the prefix e.g. to %# and the suffix (i.e end of the variable name) to #, add the
following lines to your workbench.settings file:

workbench.sql.parameter.prefix=%#
workbench.sql.parameter.suffix=#

You may leave the suffix empty, but the prefix definition may not be empty.

8.4. Prompting for values during execution

You can also use variables in a way that SQL Workbench/J will prompt you during execution of a SQL statement that
contains a variable.

If you want to be prompted for a value, simply reference the value with a quotation mark in front of its name:

SELECT id FROM person WHERE name like '$[?search_name]%'

If you execute this statement, SQL Workbench/J will prompt you for the value of the variable search_name. If the
variable is already defined you will see the current value of the variable. If the variable is not yet defined it will be
implicitely defined with an empty value.

If you use a variable more then once in your statement it is sufficient to define it once as a prompt variable. Prompting
for a variable value is especially useful inside a macro definition.

You can also define a conditional prompt with using an ampersand instead of a quotation mark. In this case you will
only be prompted if no value is assigned for the variable:
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SELECT id FROM person WHERE name like '$[&search_name]%'

The first time you execute this statement (and no value has been assigned to search_name before using WBVARDEF
or on the commandline) you will be prompted for a value for search_name. Any subsequent execution of the
statement (or any other statement referencing $[&search_name]) will re-use the value you entered.
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9. Using SQL Workbench/J in batch files

SQL Workbench/J can also be used from batch files to execute SQL scripts. This can be used to e.g. automatically
extract data from a database or run other SQL queries or statements.

To start SQL Workbench/J in batch mode, either the -script or -command must be passed as an argument on the
commandline.

If neither of these parameters is present, SQL Workbench/J will run in GUI mode.

When running SQL Workbench/J on Windows, you either need to use sqlwbconsole or start SQL
Workbench/J using the Java command. You cannot use the Windows launcher SQLWorkbench.exe, as it
will run in the background without a console window, and thus you will not see any output from the batch run.

Please refer to Starting SQL Workbench/J for details on how to start SQL Workbench/J with the java command.

When you need to quote parameters inside batch or shell scripts, you have to use single quotes ('test-
script.sql') to quote these values. Most command line shells (including Windows®) do not pass double quotes to
the application and thus the parameters would not be evaluated correctly by SQL Workbench/J

If you want to start the application from within another program (e.g. an Ant script or your own program), you will
need to start SQL Workbench/J's main class directly.

java -cp sqlworkbench.jar workbench.WbStarter

Inside an Ant build script this would need to be done like this:

<java classname="workbench.WbStarter" classpath="sqlworkbench.jar" fork="true">
  <arg value="-profile='my profile'"/>
  <arg value="-script=load_data.sql"/>
</java>

The parameters to specifiy the connection and the SQL script to be executed have to be passed on the commandline.

9.1. Specifying the connection

When running SQL Workbench/J in batch mode, you can define the connection using a profile name or specifying the
connection properties directly .

9.2. Specifying the script file(s)

The script that should be run is specified with the parameter -script=<filename> Multiple scripts can be
specified by separating them with a comma. The scripts will then be executed in the order in which they appear in the
commandline. If the filenames contain spaces or dashes (i.e. test-1.sql) the names have to be quoted.

You can also execute several scripts by using the WbInclude command inside a script.

9.3. Specifying a SQL command directly

If you do not want to create an extra SQL script just to run one or more short SQL commands, you can specify the
commands to be executed directly with the -command parameter. to specifiy more than on SQL statement use the
standard delimiter to delimit them, e.g. -command='delete from person; commit;'

http://ant.apache.org


SQL Workbench/J User's Manual

53

If a script has been specified using the -script parameter, the -command parameter is ignored.

9.4. Specifying a delimiter

If your script files use a non-standard delimiter for the statements, you can specify an alternate delimiter through
the profile or through the -altDelimiter parameter. The alternate delimiter should be used if you have several
scripts that use the regular semicolon and the alternate delimiter. If your scripts exceed a certain size, they won't be
processed in memory and detecting the alternate delimiter does not work in that case. If this is the case you can use the
-delimiter switch to change the default delimiter for all scripts. The usage of the alternate delimiter will be disabled
if this parameter is specified.

9.5. Specifying an encoding for the file(s)

In case your script files are not using the default encoding, you can specify the encoding of your script files with the -
encoding parameter. Note that this will set for all script files passed on the commandline. If you need to run several
scriptfiles with different encodings, you have to create one "master" file, which calls the individual files using the
WbInclude command together with its -encoding parameter.

9.6. Specifying a logfile

If you don't want to write the messages to the default logfile which is defined in workbench.settings an alternate
logfile can be specified with -logfile

9.7. Handling errors

To control the behavior when errors occur during script execution, you can use the parameter -
abortOnError=[true|false]. If any error occurs, and -abortOnError is true, script processing is
completely stopped (i.e. SQL Workbench/J will be stopped). The only script which will be executed after that point is
the script specified with the parameter -cleanupError.

If -abortOnError is false all statements in all scripts are executed regardless of any errors. As no error information
is evaluated the script specified in -cleanupSuccess will be executed at the end.

If this parameter is not supplied it defaults to true, meaning that the script will be aborted when an error occurs.

You can also specify whether errors from DROP commands should be ignored. To enable this, pass the parameter -
ignoreDropErrors=true on the commandline. This works when connecting through a profile or through a full
connection specification. If this parameter is set to true only a warning will be issued, but any error reported from the
DBMS when executing a DROP command will be ignored.

Note that this will not always have the desired effect. When using e.g. PostgreSQL with autocommit off, the current
transaction will be aborted by PostgreSQL until a COMMIT or ROLLBACK is issued. So even if the error during the
DROP is ignored, subsequent statements will fail nevertheless.

9.8. Specify a script to be executed on successful completion

The script specified with the parameter -cleanupSuccess=<filename> is executed as the last script if either no
error occurred or AbortOnError is set to false.
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If you update data in the database, this script usually contains a COMMIT command to make all changes permanent. The
abort script usually contains a ROLLBACK command.

9.9. Specify a script to be executed after an error

The script specified with the parameter -cleanupError=<filename> is executed as the last script if
AbortOnError is set to true and an error occurred during script execution.

The failure script usually contains a ROLLBACK command to undo any changes to the database in case an error
occured.

9.10. Ignoring errors from DROP statements

When connecting without a profile, you can use the switch -ignoreDropErrors=[true|false] to ignore errors
that are reported from DROP statements. This has the same effect as connecting with a profile where the Ignore DROP
errors property is enabled.

9.11. Changing the connection

You can change the current connection inside a script using the command WbConnect.

9.12. Controlling console output during batch execution

Any output generated by SQL Workbench/J during batch execution is sent to the standard output (stdout, System.out)
and can be redirected if desired.

9.12.1. Displaying result sets

If you are running SELECT statements in your script without "consuming" the data through an WbExport, you can
optionally display the results to the console using the parameter -displayResult=true. If this parameter is not
passed or set to false, results sets will not be visible (for a SELECT statement you will simply see the message 'SELECT
executed successfully'.

9.12.2. Controlling execution feedback

When running statements, SQL Workbench/J reports success or failure of each statement. Inside a SQL script the
WbFeedback command can be used to control this feedback. If you don't want to add a WbFeedback command
to your scripts, you can control the feedback using the -feedback switch on the command line. Passing -
feedback=false has the same effect as putting a WbFeedback off in your script.

As displaying the feedback can be quite some overhead especially when executing thousands of statements in a script
file, it is recommended to turn off the result logging using WbFeedback off or -feedback=false

To only log a summary of the script execution (per script file), specify the parameter -
consolidateMessages=true. This will then display the number of statements executed, the number of failed
statements and the total number of rows affected (updated, deleted or inserted).

When using -feedback=false, informational messages like the total number of statements executed, or a
successful connection are not logged either.
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9.12.3. Controlling statement progress information

Several commands (like WbExport) show progress information in the statusbar. When running in batch mode, this
information is usually not shown. When you specifiy -showProgress=true these messages will also be displayed
on the console.

9.13. Running batch scripts interactively

By default neither parameter prompts nor execution confirmations ("Confirm Updates") are processed when running in
batch mode. If you have batch scripts that contain parameter prompts and you want to enter values for the parameters
while running the batch file, you have to start SQL Workbench/J using the parameter -interactive=true.

9.14. Setting configuration properties

When running SQL Workbench/J in batch mode, with no workbench.settings file, you can set any property by
passing the property as a system property when starting the JVM. To change the loglevel to DEBUG you need to pass -
Dworkbench.log.level=DEBUG when starting the application:

java -Dworkbench.log.level=DEBUG -jar sqlworkbench.jar 

9.15. Examples
For readability the examples in this section are displayed on several lines. If you enter them manually on the
commandline you will need to put everything in one line, or use the escape character for your operating system
to extend a single command over more then one input line.

Connect to the database without specifying a connection profile:

java -jar sqlworkbench.jar -url=jdbc:postgresql:/dbserver/mydb
     -driver=org.postgresql.Driver
     -username=zaphod
     -password=vogsphere
     -driverjar=C:/Programme/pgsql/pg73jdbc3.jar 
     -script='test-script.sql'

This will start SQL Workbench/J, connect to the database server as specified in the connection parameters and execute
the script test-script.sql. As the script's filename contains a dash, it has to be quoted. This is also necessary
when the filename contains spaces.

Executing several scripts with a cleanup and failure script:

java -jar sqlworkbench.jar
     -script='c:/scripts/script-1.sql','c:/scripts/script-2.sql',c:/scripts/script3.sql
     -profile=PostgreSQL
     -abortOnError=false
     -cleanupSuccess=commit.sql
     -cleanupError=rollback.sql

Note that you need to quote each file individually (where it's needed) and not the value for the -script parameter

Run a SQL command in batch mode without using a script file

The following example exports the table "person" without using the -script parameter:
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java -jar sqlworkbench.jar
     -profile='TestData'
     -command='WbExport -file=person.txt -type=text -sourceTable=person'

The following example shows how to run two different SQL statements without using the -script parameter:

java -jar sqlworkbench.jar 
     -profile='TestData'
     -command='delete from person; commit;'
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10. Using SQL Workbench/J in console mode

SQL Workbench/J can also be used from the commandline without starting the GUI, e.g. when you only have a console
window (Putty, SSH) to access the database. In that case you can either run scripts using the batch mode, or start SQL
Workbench/J in console mode, where you can run statements interactively, similar to the GUI mode (but of course with
less comfortable editing possibilities).

When using SQL Workbench/J in console mode, you cannot use the Windows launcher. Please use the supplied scripts
sqlwbconsole.cmd (Windows batch file) or sqlwbconsole.sh (Unix shell script) to start the console. On
Windows you can also use the sqlwbconsole.exe program to start the console mode.

When starting SQL Workbench/J in console mode, you can define the connection using a profile name or specifying the
connection properties directly . Additionally you can specify all parameters that can be used in batch mode.

The following batch mode parameters will be ignored in console mode:

script - you cannot specify a script to be run during startup. If you want to run a script in console mode, use the
command WbInclude.
encoding - as you cannot specify a script, the encoding parameter is ignored as well
displayResult - always true in console mode
cleanupSuccess and cleanupError- as no script is run, there is no "end of script" after which a "cleanup" is
necessary
abortOnError

10.1. Entering statements

After starting the console mode, SQL Workbench/J displays the prompt SQL> where you can enter SQL statements.
The statement will not be sent to the database until it is either terminated with the standard semicolon, or with the
alternate delimiter (that can be specified either in the used connection profile or on the commandline when starting the
console mode).

As long as a statement is not complete, the prompt will change to ..>. Once a delimiter is identified the statement(s)
are sent to the database.

SQL> SELECT *<ENTER>
..>FROM person;

A delimiter is only recognized at the end of the input line, thus you can enter more than one statement on a line (or
multiple lines) if the intermediate delimiter is not at the end of one of the input lines:

SQL> DELETE FROM person; rollback;
DELETE executed successfully
4 row(s) affected.

ROLLBACK executed successfully
SQL>

10.2. Exiting console mode

To exit the application in console mode, enter exit when the default prompt is displayed. If the "continuation
prompt" (..>) is displayed, this will not terminate the application. The keyword exit may not be terminated with a
semicolon.
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10.3. Setting or changing the connection

If you did not specify a connection on the commandline when starting the console, you can set or change the current
connection in console mode using the WbConnect command. Using WbConnect in console mode will automatically
close the current connection, before establishing the new connection.

To disconnect the current connection in console mode, run the statement WbDisconnect. Note that this statement is
only available in console mode.

10.4. Displaying result sets

If you are running SELECT statements in console mode, the result is displayed on the screen in "tabular" format. Note
that SQL Workbench/J reads the whole result into memory in order to be to adjust the column widths to the displayed
data.

You can disable the buffering of the results using the commandline parameter bufferResults=false. In that case,
the width of the displayed columns will not be adjusted properly. The column widths are taken from the information
returned by the driver which typically results is a much larger display than needed.

The output in tabular format (if results are buffered) looks like this:

SQL> select id, firstname, lastname, comment from person;
id | firstname | lastname   | comment
---+-----------+------------+--------------------
1  | Arthur    | Dent       | this is a comment
2  | Zaphod    | Beeblebrox |
4  | Mary      | Moviestar  | comment
3  | Tricia    | McMillian  | test1

(4 Rows)
SQL>

If the size of the column values exceed the console's width the display will be wrapped, which makes it hard to read. In
that case, you can switch the output so that each column is printed on a single line.

This is done by running the statement: WbDisplay record

SQL> WbDisplay record;
Display changed to single record format
Execution time: 0.0s
SQL> select id, firstname, lastname, comment from person;
---- [Row 1] -------------------------------
id        : 1
firstname : Arthur
lastname  : Dent
comment   : this is a very long comment that would not fit onto the screen when printed as the last column
---- [Row 2] -------------------------------
id        : 2
firstname : Zaphod
lastname  : Beeblebrox
comment   :
---- [Row 3] -------------------------------
id        : 4
firstname : Mary
lastname  : Moviestar
comment   :
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---- [Row 4] -------------------------------
id        : 3
firstname : Tricia
lastname  : McMillian
comment   :

(4 Rows)
SQL> 

To switch back to the "tabular" display, use: WbDisplay tab.

10.5. Running SQL scripts that produce a result

Normally when executing a SQL script using WbInclude, the result of such a script (e.g. when it contains a SELECT
statement) is not displayed on the console.

To run such a script, use the command WbRun instead of WbInclude. If you have the following SQL script (named
select_person.sql):

SELECT *
FROM person;

and execute that using the WbInclude command:

SQL> WbInclude -file=select_person.sql;
SQL> Execution time: 0.063s

If you execute this script using WbRun the result of the script is displayed:

SQL> WbRun select_people.sql;
select *
from person;

id | firstname | lastname
---+-----------+------------
1  | Arthur    | Dent
4  | Mary      | Moviestar
2  | Zaphod    | Beeblebrox
3  | Tricia    | McMillian

(4 Rows)
Execution time: 0.078s
SQL>

10.6. Controlling the number of rows displayed

In the SQL Workbench/J GUI window, you can limit the reusult of a query by entering a value in the "Max. Rows"
field. If you want to limit the number of rows in console mode you can do this by running the statement

SQL> set maxrows 42;
MAXROWS set to 42
Execution time: 0.0s
SQL>

This will limit the number of rows retrieved to 42.
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SET MAXROWS has no effect when run as a post-connect script.

10.7. Controlling the query timeout

To set the query timeout in console mode, you can run the following statement

SQL> set timeout 42;
TIMEOUT set to 42
Execution time: 0.0s
SQL>

This will set a query timeout of 42 seconds. Note that not all JDBC drivers support a query timout.

SET TIMEOUT has no effect when run as a post-connect script.

10.8. Managing connection profiles

Connection profiles can be managed through several commands that are only available in console mode.

10.8.1. List available profiles - WbListProfiles

The command WbListProfiles will display a list of all displayed profiles

10.8.2. Delete a profile - WbDeleteProfile

You can delete an existing profile using the command WbDeleteProfile. The command takes one argument, which
is the name of the profile. If the name is unique across all profile groups you don't have to specify a group name. If the
name is not unique, you need to include the group name, e.g.

SQL> WbDeleteProfile {MyGroup}/SQL Server
Do you really want to delete the profile '{MyGroup}/SQL Server'? (Yes/No) yes
Profile '{MyGroup}/SQL Server' deleted
SQL>

As the profile name is the only parameter to this command, no quoting is necessary. Everything after the keyword
WbDeleteProfile will be assumed to be the profile's name

All profiles are automatically saved after executing WbDeleteProfile.

10.8.3. Save the current profile - WbStoreProfile

Saves the currently active connection as a new connection profile. This can be used when SQL Workbench/J if
the connection information was passsed using individual parameters (-url, -username and so on) either on the
commandline or through WbConnect.

SQL> WbStoreProfile {MyGroup}/PostgreSQL Production
Profile '{MyGroup}/PostgreSQL Production' added
SQL> 

As the profile name is the only parameter to this command, no quoting is necessary. Everything after the keyword
WbDeleteProfile will be assumed to be the profile's name. If there is already a profile with the same name, that
profile is overwritten.
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If the current connection references a JDBC driver that is not already defined, a new entry for the driver defintions is
created referencing the library that was passed on the commandline.

All profiles are automatically saved after executing WbStoreProfile.
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11. Export data using WbExport
The WbExport exports contents of the database into external files, e.g. plain text ("CSV") or XML.

The WbExport command can be used like any other SQL command (such as UPDATE or INSERT). This includes the
usage in scripts that are run in batch mode.

The WbExport command exports either the result of the next SQL Statement (which has to produce a result set) or the
content of the table(s) specified with the -sourceTable parameter. The data is directly written to the output file and
not loaded into memory. The export file(s) can be compressed ("zipped") on the fly. WbImport can import the zipped
(text or XML) files directly without the need to unzip them.

If you want to save the data that is currently displayed in the result area into an external file, please use the Save Data as
feature. You can also use the Database Explorer to export multiple tables.

When using a SELECT based export, you have to run both statements (WbExport and SELECT) as one script.
Either select both statements in the editor and choose SQL » Execute selected, or make the two statements the
only statements in the editor and choose SQL » Execute all.

You can also export the result of a SELECT statement, by selecting the statment in the editor, and then choose SQL »
Export query result.

When exporting data into a Text or XML file, the content of BLOB columns is written into separate files. One file
for each column of each row. Text files that are created this way can most probably only be imported using SQL
Workbench/J as the main file will contain the filename of the BLOB data file instead of the actual BLOB data. The only
other application that I know of, that can handle this type of imports is Oracle's SQL*Loader utility. If you run the
text export together with the parameter -writeoracleloader=true the control file will contain the approriate
definitions to read the BLOB data from the external file.

11.1. Memory usage and WbExport

WbExport is designed to directly write the rows that are retrieved from the database to the export file without buffering
them in memory.

Some JDBC drivers (e.g. PostgreSQL, jTDS and the Microsoft Driver) read the full result obtained from the database
into memory. In that case, exporting large results might still require a lot of memory. Please refer to the chapter
Common problems for details on how to configure the individual drivers if this happens to you.

11.2. Exporting Excel files

If you need to export data for Microsoft Excel, additional libraries are required to write the native Excel formats (xls
and the new xlsx introduced with Office 2007). Exporting the "SpreadsheetML" format introduced with Office 2003
does not require additional libraries.

Before Build 108 -type=xlsx referred to the Office 2003 file format. To distinguish between the two (XML
based) formats from Microsoft, the naming has been changed to reflect the default file extensions that are used
by Microsoft.

SQL Workbench/J supports three different Excel file formats:

• Office 2003 (xlsm) - this is a plain XML format that does not need additional libraries

• The "old" binary format (xls) - only poi.jar is needed

• Office 2007 (xlsx) - additional libraries from the POI project are needed

Instead of downloading and renaming the POI libraries from the Apache website, you can download all of them as a
single archive from the SQL Workbench/J homepage: http://www.sql-workbench.net/poi-add-on.zip

http://poi.apache.org/download.html
http://www.sql-workbench.net/poi-add-on.zip
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Simply unzip the archive into the directory where sqlworkbench.jar is located.

WbExport and the "Max. Rows" option

When you use the WbExport command together with a SELECT query, the "Max. Rows" setting will be ignored for
the export.

11.3. General WbExport parameters

Parameter Description

-type Possible values: text, sqlinsert, sqlupdate, sqldeleteinsert, xml,
ods, xlsm, xls, xlsx, html

Defines the type of the output file. sqlinsert will create the necessary INSERT
statements to put the data into a table. If the records may already exist in the target
table but you don't want to (or cannot) delete the content of the table before running the
generated script, SQL Workbench/J can create a DELETE statement for every INSERT
statement. To create this kind of script, use the sqldeleteinsert type.

In order for this to work properly the table needs to have keycolumns defined, or you have
to define the keycolumns manually using the -keycolumns switch.

sqlupdate will generate UPDATE statements that update all non-key columns of
the table. This will only generate valid UPDATE statements if at least one key column
is present. If the table does not have key columns defined, or you want to use different
columns, they can be specified using the -keycolumns switch.

ods will generate a spreadsheet file in the OpenDocument format that can be opened e.g.
with OpenOffice.org.

xlsm will generate a spreadsheet file in the Microsoft Excel 2003 XML format
("SpreadsheetML"). This format has been introduced with build 108 as xlsx now selects
the Office 2007 format.

xls will generate a spreadsheet file in the propriatary (binary) format for Microsoft
Excel. The file poi.jar is required.

xlsx will generate a spreadsheet file in the Office Open XML format introduced with
Microsof Office 2007. Additional external libraries are required in order to be able to use
this format. Please read the note at the beginning of this section.

xlsx

-file The output file to which the exported data is written. This parameter is ignored if -
outputDir is also specified.

-createDir If this parameter is set to true, SQL Workbench/J will create any needed directories when
creating the output file.

-sourceTable Defines a list of tables to be exported. If this switch is used, -outputdir is also
required unless exactly one table is specified. If one table is specified, the -file parameter
is used to generate the file for the table. If more then one table is specified, the -
outputdir parameter is used to defined the directory where the generated files should
be stored. Each file will be named as the exported table with the approriate extension
(.xml, .sql, etc). You can specify * as the table name which will then export all tables
accessible by the current user.
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If you want to export tables from a different user or schema you can use a schema
name combined with a wildcard e.g.  -sourcetable=otheruser.*. In this case
the generated output files will contain the schema name as part of the filename (e.g.
otheruser.person.txt). When importing these files, SQL Workbench/J will try
to import the tables into the schema/user specified in the filename. If you want to import
them into a different user/schema, then you have to use the -schema switch for the
import command.

-types Selects the object types to be exported. By default only TABLEs are exported. If you want
to export the content of VIEWs or SYNONYMs as well, you have to specify all types with
this parameter.

-sourceTable=* -types=VIEW,SYNONYM or -sourceTable=T% -
types=TABLE,VIEW,SYNONYM

-excludeTables The tables listed in this parameter will not be exported. This can be used when all but
a few tables should be exported from a schema. First all tables specified through -
sourceTable will be evaluated. The tables specified by -excludeTables can include
wildcards in the same way, -sourceTable allows wildcards.

-sourceTable=* -excludeTables=TEMP* will export all tables, but not those
starting with TEMP.

-sourceTablePrefix Define a common prefix for all tables listed with -sourceTable. When this parameter
is specified the existence of each table is not tested any longer (as it is normally done).

When this paarameter is specified the generated statement for exporting the table is
changed to a SELECT * FROM [prefix]tableName instead of listing all columns
individually.

This can be used when exporting views on tables, when for each table e.g. a view with a
certain prefix exists (e.g. table PERSON has the view V_PERSON and the view does some
filtering of the data.

-outputDir When using the -sourceTable switch with multiple tables, this parameter is
mandatory and defines the directory where the generated files should be stored.

-continueOnError When exporting more than one table, this parameter controls whether the whole export
will be terminated if an error occurs during export of one of the tables.

-encoding Defines the encoding in which the file should be written. Common encodings are
ISO-8859-1, ISO-8859-15, UTF-8 (or UTF8). To get a list of available encodings, execut
WbExport with the parameter -showencoding. This parameter is ignored for XLS,
XLSX and ODS exports.

-showEncodings Displays the encodings supported by your Java version and operating system. If this
parameter is present, all other parameters are ignored.

-lineEnding Possible values are: crlf, lf

Defines the line ending to be used for XML or text files. crlf puts the ASCII characters
#13 and #10 after each line. This is the standard format on Windows based systems. dos
and win are synonym values for crlf, unix is a synonym for lf.

lf puts only the ASCII character #10 at the end of each line. This is the standard format
on Unix based systems (unix is a synonym value for this format).

The default line ending used depends on the platform where SQL Workbench/J is running.

-header Possible values: true, false



SQL Workbench/J User's Manual

65

Parameter Description

If this parameter is set to true, the header (i.e. the column names) are placed into the first
line of output file. The default is to not create a header line. You can define the default
value for this parameter in the file workbench.settings. This parameter is valid for text and
spreadsheet (OpenDocument, Excel) exports.

-compress Selects whether the output file should be compressed and put into a ZIP archive. An
archive will be created with the name of the specified outputfile but with the extension
zip. The archive will then contain the specified file (e.g. if you specify data.txt,
an archive data.zip will be created containing exactly one entry with the name
data.txt). If the exported result set contains BLOBs, they will be stored in a separate
archive, named data_lobs.zip.

When exporting multiple tables using the -sourcetable parameter, then SQL
Workbench/J will create one ZIP archive for each table in the specified output directory
with the filename "tablename".zip. For any table containing BLOB data, one
additional ZIP archive is created.

-tableWhere Defines an additional WHERE clause that is appended to all SELECT queries to retrieve
the rows from the database. No validation check will be done for the syntax or the
columns in the where clause. If the specified condition is not valid for all exported tables,
the export will fail.

-clobAsFile Possible values: true, false

For SQL, XML and Text export this controls how the contents of CLOB fields are
exported. Usually the CLOB content is put directly into the output file When generating
SQL scripts with WbExport this can be a problem as not all DBMS can cope with long
character literals (e.g. Oracle has a limit of 4000 bytes). When this parameter is set to true,
SQL Workbench/J will create one file for each CLOB column value. This is the same
behaviour as with BLOB columns.

Text files that are created with this parameter set to true, will contain the filename of the
generated output file instead of the actual column value. When importing such a file using
WbImport you have to specify the -clobIsFilename=true parameter. Otherwise
the filenames will be stored in the database and not the clob data. This parameter is not
necessary when importing XML exports, as WbImport will automatically recognize the
external files.

Note that SQL exports (-type=sqlinsert) generated with -clobAsFile=true
can only be run with SQL Workbench/J!

All CLOB files that are written using the encoding specified with the -encoding switch.
If the -encoding parameter is not specified the default file encoding will be used.

-lobIdCols When exporting CLOB or BLOB columns as external files, the filename with the LOB
content is generated using the row and column number for the currently exported LOB
column (e.g. data_r15_c4.data). If you prefer to have the value of a unique column
combination as part of the file name, you can specify those columns using the -
lobIdCols parameter. The filename for the LOB will then be generated using the
base name of the export file, the column name of the LOB column and the values of
the specified columns. If you export your data into a file called user_info and specify -
lobIdCols=id and your result contains a column called img, the LOB files will be
named e.g. user_info_img_344.data



SQL Workbench/J User's Manual

66

Parameter Description

-lobsPerDirectory When exporting CLOB or BLOB columns as external files, the generated files can be
distributed over several directories to avoid an excessive number of files in a single
directory. The parameter lobsPerDirectory defines how many LOB files are written
into a single directory. When the specified number of files have been written, a new
directory is created. The directories are always created as a sub-directory of the target
directory. The name for each directory is the base export filename plus "_lobs" plus a
running number. So if you export the data into a file "the_big_table.txt", the LOB files
will be stored in "the_big_table_lobs_1", "the_big_table_lobs_2", "the_big_table_lobs_3"
and so on.

The directories will be created if needed, but if the directories already exist (e.g. because
of a previous export) their contents will not be deleted!

-extensionColumn When exporting CLOB or BLOB columns as external files, the extension of the generated
filenames can be defined based on a column of the result set. If the exported table
contains more than one type of BLOBs (e.g. JPEG, GIF, PDF) and your table stores the
information to define the extension based on the contents, this can be used to re-generate
proper filenames.

This parameter only makes sense if exactly one BLOB column of a table is exported.

-filenameColumn When exporting CLOB or BLOB columns as external files, the complete filename can
be taken from a column of the result set (instead of dynamically creating a new file name
based on the row and column numbers).

This parameter only makes sense if exactly one BLOB column of a table is exported.

-append Possible values: true,false

Controls whether results are appended to an existing file, or overwrite an existing file.
This parameter is only supported for text or SQL export types.

-dateFormat The date format to be used when writing date columns into the output file. This parameter
is ignored for SQL exports.

-timestampFormat The format to be used when writing datetime (or timestamp) columns into the output file.
This parameter is ignored for SQL exports.

-blobType Possible values: file, dbms, ansi, base64

This parameter controls how BLOB data will be put into the generated SQL statements.
By default no conversion will be done, so the actual value that is written to the output file
depends on the JDBC driver's implementation of the Blob interface. It is only valid for
Text, SQL and XML exports, although not all parameter values make sense for all export
types.

The type base64 is primarily intended for Text exports (e.g. to be used with
PostgreSQL's COPY command)

The types dbms and ansi are intended for SQL exports and generate a representation of
the binary data as part of the SQL statement. DBMS will use a format that is understood
by the DBMS you are exporting from, while ansi will generate a standard hex based
representation of the binary data. The syntax generated by the ansi format is not
understood by all DBMS!
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Two additional SQL literal formats are available that can be used together with
PostgreSQL: pgDecode and pgEscape. pgDecode will generate a hex representation
using PostgreSQL's decode() function. Using decode is a very compact format.
pgEscape will use PostgreSQL's escaped octets, and generates much bigger statements
(due to the increase escaping overhead).

When using file, base64 or ansi the file can imported using WbImport

The parameter value file, will cause SQL Workbench/J to write the contents of each
blob column into a separate file. The SQL statement will contain the SQL Workbench/
J specific extension to read the blob data from the file. For details please refer to BLOB
support. If you are planning to run the generated SQL scripts using SQL Workbench/J this
is the recommended format.

Note that SQL scripts generated with -blobType=file can only be run with SQL
Workbench/J

The parameter value ansi, will generate "binary strings" that are compatible with the
ANSI definition for binary data. MySQL and Microsoft SQL Server support these kind of
literals.

The parameter value dbms, will create a DBMS specific "binary string". MySQL,
HSQLDB, H2 and PostgreSQL are known to support literals for binary data. For other
DBMS using this option will still create an ansi literal but this might result in an invalid
SQL statement.

-replaceExpression -
replaceWith

Using these parameters, arbitrary text can be replaced during the export. -
replaceExpression defines the regular expression that is to be replaced. -
replaceWith defines the replacement value. -replaceExpression='(\n|\r
\n)' -replaceWith=' ' will replace all newline characters with a blank.

The search and replace is done on the "raw" data retrieved from the database before the
values are converted to the corresponding output format. In particular this means replacing
is done before any character escaping takes place.

Because the search and replace is done before the data is converted to the output format,
it can be used for all export types. Only character columns (CHAR, VARCHAR, CLOB,
LONGVARCHAR) are taken into account.

-showProgress Valid values: true, false, <numeric value>

Control the update frequence in the statusbar (when running in GUI mode). The default
is every 10th row is reported. To disable the display of the progress specifiy a value of 0
(zero) or the value false. true will set the progress interval to 1 (one).

11.4. Parameters for text export

Parameter Description

-delimiter The given string sequence will be placed between two columns. The default is a tab
character (-delimiter=\t

-rowNumberColumn If this parameter is specified with a value, the value defines the name of an additional
column that will contain the rownumber. The row number will always be exported as the
first column. If the text file is not created with a header (-header=false) a value must
still be provided to enable the creation of the additional column.

http://www.postgresql.org/docs/current/static/functions-binarystring.html
http://www.postgresql.org/docs/current/static/datatype-binary.html
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Parameter Description

-quoteChar The character (or sequence of characters) to be used to enclose text (character) data if the
delimiter is contained in the data. By default quoting is disabled until a quote character
is defined. To set the double quote as the quote character you have to enclose it in single
quotes: -quotechar='"'

-quoteCharEscaping Possible values: none, escape, duplicate

Defines how quote characters that appear in the actual data are written to the output file.

If no quote character has been defined using the -quoteChar switch, this option is ignored.

If escape is specified a quote character (defined through -quoteChar) that is
embedded in the exported (character) data is written as e.g. here is a \" quote
character.

If duplicate is specified, a quote character (defined through -quoteChar) that is
embedded in the exported (character) data is written as two quotes e.g. here is a ""
quote character.

-quoteAlways Possible values: true, false

If quoting is enabled (via -quoteChar, then character data will normally only be
quoted if the delimiter is found inside the actual value that is written to the output file.
If -quoteAlways=true is specified, character data will always be enclosed in the
specified quote character. This parameter is ignored if not quote character is specified. If
you expect the quote character to be contained in the values, you should enable character
escaping, otherwise the quote character that is part of the exported value will break the
quote during import.

NULL values will not be quoted even if this parameter is set to true. This is usefull to
distinguish between NULL values and empty strings.

-decimal The decimal symbol to be used for numbers. The default is a dot (e.g. 3.14152)

-escapeText This parameter controls the escaping of non-printable or non-ASCII characters. Valid
options are ctrl which will escape everything below ASCII 32 (newline, tab, etc), 7bit
which will escape everything below ASCII 32 and above 126, 8bit which will escape
everything below ASCII 32 and above 255 and extended which will escape everything
outside the range [32-126] and [161-255]

This will write a unicode representation of the character into the text file e.g. \n for a
newline, \u00F6 for ö. This file can only be imported using SQL Workbench/J (at least I
don't know of any DBMS specific loader that will decode this properly)

If character escaping is enabled, then the quote character will be escaped inside quoted
values and the delimiter will be escaped inside non-quoted values. The delimiter could
also be escaped inside a quoted value if the delimiter falls into the selected escape range
(e.g. a tab character).

-formatFile Possible values: postgres, oracle, sqlserver, db2

This parameter controls the creation of a control file for the bulk load utilities of Oracle
and Microsoft SQL Server. oracle will create a control file for Oracle's SQL*Loader
utility, sqlserver will create a format file for Microsoft's bcp utility. The format file
has the same filename as the output file but with the ending .ctl for Oracle and .fmt
for SQL Server. For PostgreSQL, this will create the necessary COPY syntax to import the
generated text file. For DB2 this will create an IMPORT command to import the exported
data.
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You can specify several formats at the same time. In that case one control file for each
format specified will be created.

The generated format file(s) are intended as a starting point for your own adjustments.
Don't expect them to be complete specifying all possible options.

11.5. Parameters for XML export

Parameter Description

-table The given tablename will be put into the <table> tag as an attribute.

-decimal The decimal symbol to be used for numbers. The default is a dot (e.g. 3.14152)

-useCDATA Possible values: true, false

Normally all data written into the xml file will be written with escaped XML characters
(e.g. < will be written as &lt;). If you don't want that escaping, set -useCDATA=true
and all character data (VARCHAR, etc) will be enclosed in a CDATA section.

With -useCDATA=true a HTML value would be written like this:

<![CDATA[<b>This is a title</b>]]>

With -useCDATA=false (the default) a HTML value would be written like this:

&lt;b&gt;This is a title&lt;/b&gt;

-stylesheet The name of the XSLT stylesheet that should be used to transform the SQL Workbench/
J specific XML file into a different format. If -stylesheet is specified, -xsltoutput has to be
specified as well.

-xsltOutput The resulting output file (specified with the -file parameter), can be transformed using
XSLT after the export has finished. This parameter then defines the name of the outputfile
of the transformation.

-verboseXML Possible values: true, false

This parameter controls the tags that are used in the XML file and minor formatting
features. The default is -verboseXML=true and this will generate more readable
tags and formatting. However the overhead imposed by this is quite high. Using -
verboseXML=false uses shorter tag names (not longer then two characters) and does put
more information in one line. This output is harder to read for a human but is smaller in
size which could be important for exports with large result sets.

11.6. Parameters for type SQLUPDATE, SQLINSERT or SQLDELETEINSERT

Parameter Description

-table Define the tablename to be used for the UPDATE or INSERT statements. This parameter
is required if the SELECT statement has multiple tables in the FROM list. table.

-charfunc If this parameter is given, any non-printable character in a text/character column will be
replaced with a call to the given function with the ASCII value as the parameter.

If -charfunc=chr is given (e.g. for an Oracle syntax), a CR (=13) inside a character column
will be replaced with:
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INSERT INTO ... VALUES ('First line'||chr(13)||'Second
line' ... )

This setting will affect ASCII values from 0 to 31

-concat If the parameter -charfunc is used SQL Workbench/J will concatenate the individual
pieces using the ANSI SQL operator for string concatenation. In case your DBMS does
not support the ANSI standard (e.g. MS ACCESS) you can specify the operator to be
used: -concat=+ defines the plus sign as the concatenation operator.

-sqlDateLiterals Possible values: jdbc, ansi, dbms, default

This parameter controls the generation of date or timestamp literals. By default literals that
are specific for the current DBMS are created. You can also choose to create literals that
comply with the JDBC specification or ANSI SQL literals for dates and timestamps.

jdbc selects the creation of JDBC compliant literals. These should be usable with
every JDBC based tool, including your own Java code: {d '2004-04-28'} or {ts
'2002-04-02 12:02:00.042'}. This is the recommended format if you plan to use
SQL Workbench/J (or any other JDBC based tool) to run the generated statements.

ansi selects the creation of ANSI SQL compliant date literals: DATE '2004-04-28'
or TIMESTAMP '2002-04-02 12:04:00'. Please consult the manual of the target
DBMS, to find out whether it supports ANSI compliant date literals.

default selects the creation of quoted date and timestamp literals in ISO format (e.g.
'2004-04-28'). Several DBMS support this format (e.g. PostgreSQL, Microsoft SQL
Server)

dbms selects the creation of specific literals to be used with the current DBMS (using e.g.
the to_date() function for Oracle). The format of these literals can be customized if
necessary in workbench.settings using the keys workbench.sql.literals.
[type].[datatype].pattern where [type] is the type specified with this
parameter and [datatype] is one of time, date, timestamp. If you add new literal
types, please also adjust the key workbench.sql.literals.types which is
used to show the possible values in the GUI (auto-completion "Save As" dialog, Options
dialog). If no type is specified (or dbms), SQL Workbench/J first looks for an entry where
[type] is the current dbid. If no value is found, default is used.

You can define the default literal format to be used for the WbExport command in the
options dialog.

-commitEvery A numeric value which identifies the number of INSERT or UPDATE statements after
which a COMMIT is put into the generated SQL script.

-commitevery=100

will create a COMMIT; after every 100th statement.

If this is not specified one COMMIT; will be added at the end of the script. To
suppress the final COMMIT, you can use -commitEvery=none. Passing -
commitEvery=atEnd is equivalent to -commitEvery=0

-createTable Possible values: true, false

If this parameter is set to true, the necessary CREATE TABLE command is put into the
output file. This parameter is ignored when creating UPDATE statements.

-useSchema Possible values: true, false
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If this parameter is set to true, all table names are prefixed with the approriate schema.
The default is taken from the global option Include owner in export

-keyColumns A comma separated list of column names that occur in the table or result set that should be
used as the key columns for UPDATE or DELETE

If the table does not have key columns, or the source SELECT statement uses a join over
several tables, or you do not want to use the key columns defined in the database, this key
can be used to define the key columns to be used for the UPDATE statements. This key
overrides any key columns defined on the base table of the SELECT statement.

11.7. Parameters for Spreadsheet types (ods, xslm, xls, xlsx)

Parameter Description

-title The name to be used for the worksheet

-infoSheet Possible values: true, false

If set to true, a second worksheet will be created that contains the generating SQL of
the export. For ods exports, additional export information is available in the document
properties.

Default value: false

-fixedHeader Possible values: true, false

If set to true, the header row will be "frozen" in the Worksheet so that it will not scroll out
of view.

Default value: true

-autoFilter Possible values: true, false

If set to true, the "auto-filter" fetaure for the column headers will be turned on. This is only
valid for ODS and XLSM exports. It is not supported for XLS or XLSX.

Default value: true

11.8. Parameters for HTML export

Parameter Description

-createFullHTML Possible values: true, false

Default value: true

If this is set to true, a full HTML page (including <html>, <body> tags) will be created.

-escapeHTML Possible values: true, false

Default value: true

If this is set to true, values inside the data will be escaped (e.g. the < sign will be written
as &lt;) so that they are rendered properly in an HTML page. If your data contains HTML
tag that should be saved as HTML tags to the output, this parameter must be false.
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-title The title for the HTML page (put into the <title> tag of the generated output)

-preDataHtml With this parameter you can specify a HTML chunk that will be added before the export
data is written to the output file. This can be used to e.g. create a heading for the data: -
preDataHtml='<h1>List of products</h1>'.

The value will be written to the output file "as is". Any escaping of the HTML must be
provided in the parameter value.

-postDataHtml With this parameter you can specify a HTML chunk that will be added after the data has
been written to the output file.

11.9. Compressing export files

The WbExport command supports compressing of the generated output files. This includes the "main" export file as
well as any associated LOB files.

When using WbImport you can import the data stored in the archives without unpacking them. Simply specify the
archive name with the -file parameter. SQL Workbench/J will detect that the input file is an archive and will extract
the information "on the fly". Assume the following export command:

WbExport -type=text -file=/home/data/person.txt -compress=true -sourcetable=person;

This command will create the file /home/data/person.zip that will contain the specified person.txt. To
import this export into the table employee, you can use the following command:

WbImport -type=text -file=/home/data/person.zip -table=employee;

Assuming the PERSON table had a BLOB colum (e.g. a picture of the person), the WbExport command would have
created an additional file called person_blobs.zip that would contain all BLOB data. The WbImport command
will automatically read the BLOB data from that archive.

11.10. Examples

11.10.1. Simple plain text export

WbExport -type=text
         -file='c:/data/data.txt'
         -delimiter='|'
         -decimal=','
         -sourcetable=data_table;

Will create a text file with the data from data_table. Each column will be separated with the character | Each
fractional number will be written with a comma as the decimal separator.

11.10.2. Exporting multiple tables

WbExport -type=text
         -outputDir='c:/data'
         -delimiter=';'
         -header=true
         -sourcetable=table_1, table_2, table_3, table_4;
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This will export each specified table into a text file in the specified directory. The files are named "table_1.txt",
"table_2.txt" and so on.

Limiting the export data when using a table based export, can be done using the -tableWhere argument. This
requires that the specified WHERE condition is valid for all tables, e.g. when every table has a column called
MODIFIED_DATE

WbExport -type=text
         -outputDir='c:/data'
         -delimiter=';'
         -header=true
         -tableWhere="WHERE modified_date > DATE '2009-04-02'"
         -sourcetable=table_1, table_2, table_3, table_4;

This will add the specified where clause to each SELECT, so that only rows are exported that were changed after April
2nd, 2009

11.10.3. Export based on a SELECT statement

WbExport -type=text
         -file='c:/data/data.txt'
         -delimiter=','
         -decimal=','
         -dateFormat='yyyy-MM-dd';
SELECT * FROM data_table;

11.10.4. Export a complete schema

To export all tables from the current connection into tab-separated files and compress the files, you can use the
following statement:

WbExport -type=text
         -outputDir=c:/data/export
         -compress=true
         -sourcetable=*;

This will create one zip file for each table containing the exported data as a text file. If a table contains BLOB columns,
the blob data will be written into a separate zip file.

The files created by the above statement can be imported into another database using the following command:

WbImport -type=text
         -sourceDir=c:/data/export
         -checkDependencies=true;

11.10.5. Export as SQL INSERT script

To generate a file that contains INSERT statements that can be executed on the target system, the following command
can be used:

WbExport -type=sqlinsert
         -file='c:/data/newtable.sql'
         -table=newtable;
SELECT * FROM table1, table2
WHERE table1.column1 = table2.column1;
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will create a SQL script which that contains statements like INSERT INTO newtable (...) VALUES (...);
and the list of columns are all columns that are defined by the SELECT statement.

If the parameter -table is omitted, the creation of SQL INSERT statements is only possible, if the SELECT is based on
a single table (or view).

11.10.6. Exporting LOB data
To extract the contents of CLOB columns you have to specify the parameter -clobAsFile=true, otherwise
the contents of the CLOB columns will be written directly into the export file. BLOB columns will always be
exported into separate tables.

When exporting tables that contain BLOB columns, one file for each blob column and row will be created. By default
the generated filenames will contain the row and column number to make the names unique. You can however control
the creation of filenames when exporting LOB columns using several different approaches. If a unique name is stored
within the table you can use the -filenameColumn parameter to generate the filenames based on the contents of that
column:

WbExport -file='c:/temp/blob_table.txt'
         -type=text
         -delimiter=','
         -filenameColumn=file_name;

Will create the file blob_table.txt and for each blob a file where the name is retrieved from the column
BLOB_TABLE.FILE_NAME. Note that if the filename column is not unique, blob files will be overwritten without an
error message.

You can also base the export on a SELECT statement and then generate the filename using several columns:

WbExport -file='c:/temp/blob_table.txt'
         -type=text
         -delimiter=','
         -filenameColumn=fname;
SELECT blob_column, 'data_'||id_column||'_'||some_name||'.'||type_column as fname
FROM blob_table;

This examples assumes that the following columns are part of the table blob_table: id_column, some_name and
type_column. The filenames for the blob of each row will be taken from the computed column fname. To be able
to reference the column in the WbExport you must give it an alias.

This approach assumes that only a single blob column is exported. When exporting multiple blob columns from a single
table, it's only possible to create unique filenames using the row and column number (the default behaviour).

11.10.7. Replace data during export

When writing the export data, values in character columns can be replaced using regular expressions.

WbExport -file='/path/to/export.tx'
         -type=text
         -replaceExpression='(\n|\r\n)' -replaceWith='*'
         -sourceTable=export_table;

This will replace each newline (either DOS CR/LF or Unix LF) with the character *.

The value for -replaceExpression defines a regular expression. In the example above multiple new lines will
be replace with multiple * characters. To replace consecutive new lines with a single * character, use the regular
expression -replaceExpression='(\n|\r\n)+'. (Note the + sign after the brackets)
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12. Import data using WbImport

The WbImport command can be used to import data from text or XML files into a table of the database. WbImport
can read the XML files generated by the WbExport command's XML format. It can also read text files created by the
WbExport command that escape non-printable characters.

The WbImport command can be used like any other SQL command (such as UPDATE or INSERT), inlcuding scripts
that are run in batch mode.

During the import of text files, empty lines (i.e. lines which only contain whitespace) will be silently ignored.

WbImport recognizes certain "literals" to identify the current date or time when converting values from text files to
the approriate data type of the DBMS. Thus, input values like now, or current_timestamp for date or timestamp
columns are converted correctly. For details on which "literals" are supported, please see the description about editing
data [43].

The DataPumper can also be used to import text files into a database table, though it does not offer all of the
possibilities from the WbImport command.

Archives created with the WbExport command using the -compress=true parameter can be imported using
WbImport command. You simply need to specifiy the archive file created by WbExport, and WbImport will
automatically detect the archive. For an example to create and import compressed exports, please refer to compressing
export files

If you use continueOnError=true and expect a substantial number of rows to fail, it is highly
recommended to also use a "bad file" to log all rejected records. Otherwise the rejected records are stored in
memory (until the import finishes) which may lead to an out of memory error.

12.1. General parameters

The WbImport command has the following syntax

Parameter Description

-type Possible values: xml, text

Defines the type of the input file

-mode Defines how the data should be sent to the database. Possible values are 'INSERT',
'UPDATE', 'INSERT,UPDATE' and 'UPDATE,INSERT' For details please refer to the
update mode explanation.

-file Defines the full name of the input file. Alternatively you can also specify a directory
(using -sourcedir) from which all files are imported.

-table Defines the table into which the data should be imported

This parameter is ignored, if the files are imported using the -sourcedir parameter

-sourceDir Defines a directory which contains import files. All files from that directory will be
imported. If this switch is used with text files and no target table is specified, then it is
assumed that each filename (without the extension) defines the target table. If a target
table is specified using the -table parameter, then all files will be imported into the
same table. The -deleteTarget will be ignored if multiple files are imported into a
single table.

-extension When using the -sourcedir switch, the extension for the files can be defined. All
files ending with the supplied value will be processed. (e.g. -extension=csv). The
extension given is case-sensitiv (i.e. TXT is something different than txt
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Parameter Description

-ignoreOwner If the file names imported with from the directory specified with -sourceDir contain the
owner (schema) information, this owner (schema) information can be ignored using this
parameter. Otherwise the files might be imported into a wrong schema, or the target tables
will not be found.

-excludeFiles Using -excludeFiles, files from the source directory (when using -sourceDir) can be
excluded from the import. The value for this parameter is a comma separated list of partial
names. Each file that contains at least one of the values supplied in this parameter is
ignored. -excludeFiles=back,data will exclude any file that contains the value
back or data in it, e.g.: backup, to_back, log_data_store etc.

-checkDependencies When importing more than one file (using the -sourcedir switch), into tables with
foreign key constraints, this switch can be used to import the files in the correct order
(child tables first). When -checkDependencies=true is passed, SQL Workbench/
J will check the foreign key dependencies for all tables. Note that this will not check
dependencies in the data. This means that e.g. the data for a self-referencing table (parent/
child) will not be order so that it can be imported. To import self-referencing tables, the
foreign key constraint should be set to "initially deferred" in order to postpone evaluation
of the constraint until commit time.

-commitEvery If your DBMS neeeds frequent commits to improve performance and reduce locking on
the import table you can control the number of rows after which a COMMIT is sent to the
server.

-commitEveryis numeric value that defines the number of rows after which a COMMIT
is sent to the DBMS. If this parameter is not passed (or a value of zero or lower), then the
import is run as a single transaction that is committed at the end.

When using batch import and your DBMS requires frequent commits to improve import
performance, the -commitBatch option should be used instead.

You can turn off the use of a commit or rollback during import completely by using the
option -transactionControl=false.

Using -commitEvery means, that in case of an error the already imported rows cannot
be rolled back, leaving the data in a potential invalid state.

-transactionControl Possible values: true, false

Controls if SQL Workbench/J handles the transaction for the import, or if the import
must be committed (or rolled back) manually. If -transactionControl=false is
specified, SQL Workbench/J will neither send a COMMIT nor a ROLLBACK at the end.
This can be used when multiple files need to be imported in a single transaction. This can
be combined with the cleanup and error scripts in batch mode.

-continueOnError Possible values: true, false

This parameter controls the behaviour when errors occur during the import. The default is
true, meaning that the import will continue even if an error occurs during file parsing or
updating the database. Set this parameter to false if you want to stop the import as soon
as an error occurs.

The default value for this parameter can be controlled in the settings file and it will be
displayed if you run WbImport without any parameters.

With PostgreSQL continueOnError will only work, if the use of savepoints is
enabled using -useSavepoint=true.

-useSavepoint Possible values: true, false
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Parameter Description

Controls if SQL Workbench/J guards every insert or update statement with a savepoint to
recover from individual error during import, when continueOnError is set to true.

Using a savepoint for each DML statement can drastically reduce the performance of the
import.

-keyColumns Defines the key columns for the target table. This parameter is only necessary if import is
running in UPDATE mode.

This parameter is ignored if files are imported using the -sourcedir parameter

-schema Defines the schema into which the data should be imported. This is necessary for DBMS
that support schemas, and you want to import the data into a different schema, then the
current one.

-encoding Defines the encoding of the input file (and possible CLOB files)

-deleteTarget Possible values: true, false

If this parameter is set to true, data from the target table will be deleted (using DELETE
FROM ...) before the import is started. This parameter will only be used if -
mode=insert is specified.

-truncateTable Possible values: true, false

This is essentially the same as -deleteTarget, but will use the command TRUNCATE
to delete the contents of the table. For those DBMS that support this command, deleting
rows is usually faster compared to the DELETE command, but it cannot be rolled back.
This parameter will only be used if -mode=insert is specified.

-batchSize A numeric value that defines the size of the batch queue. Any value greater than 1
will enable batch mode. If the JDBC driver supports this, the INSERT (or UPDATE)
performance can be increased drastically.

This parameter will be ignored if the driver does not support batch updates or if
the mode is not UPDATE or INSERT (i.e. if -mode=update,insert or -
mode=insert,update is used).

-commitBatch Possible values: true, false

If using batch execution (by specifying a batch size using the -batchSize parameter)
each batch will be committed when this parameter is set to true. This is slightly different
to using -commitEvery with the value of the -batchSize parameter. The latter one
will add a COMMIT statement to the batch queue, rather than calling the JDBC commit()
method. Some drivers do not allow to add different statements in a batch queue. So, if a
frequent COMMIT is needed, this parameter should be used.

When you specify -commitBatch the parameter -commitEvery will be ignored. If
no batch size is given (using -batchSize, then -commitBatch will also be ignored.

-updateWhere When using update mode an additional WHERE clause can be specified to limit the rows
that are updated. The value of the -updatewhere parameter will be added to the
generated UPDATE statement. If the value starts with the keyword AND or OR the value
will be added without further changes, otherwise the value will be added as an AND clause
enclosed in brackets. This parameter will be ignored if update mode is not active.

-startRow A numeric value to define the first row to be imported. Any row before the specified row
will be ignored. The header row is not counted to determine the row number. For a text
file with a header row, the pysical line 2 is row 1 (one) for this parameter.
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Parameter Description

When importing text files, empty lines in the input file are silently ignored and do not add
to the count of rows for this parameter. So if your input file has two lines to be ignored,
then one empty line and then another line to be ignored, startRow must be set to 4.

-endRow A numeric value to define the last row to be imported. The import will be stopped after
this row has been imported. When you specify -startRow=10 and -endRow=20 11
rows will be imported (i.e. rows 10 to 20). If this is a text file import with a header row,
this would correspond to the physical lines 11 to 21 in the input file as the header row is
not counted.

-badFile Possible values: true, false

If -continueOnError=true is used, you can specify a file to which rejected rows
are written. If the provided filename denotes a directory a file with the name of the import
table will be created in that directory. When doing multi-table inserts you have to specify
a directory name.

If a file with that name exists it will be deleted when the import for the table is started. The
fill will not be created unless at least one record is rejected during the import. The file will
be created with the same encoding as indicated for the input file(s).

-maxLength With the parameter -maxLength you can truncate data for character columns
(VARCHAR, CHAR) during import. This can be used to import data into columns that are
not big enough (e.g. VARCHAR columns) to hold all values from the input file and to
ensure the import can finish without errors.

The parameter defines the maximum length for certain columns using the following
format: -maxLength='firstname=30,lastname=20' Where firstname and
lastname are columns from the target table. The above example will limit the values
for the column firstname to 30 characters and the values for the column lastname to 20
characters. If a non-character column is specified this is ignored. Note that you have quote
the parameter's value in order to be able to use the "embedded" equals sign.

-booleanToNumber Possible values: true, false

When exporting data from a DBMS that supports the BOOLEAN datatype, the export
file will contain the literals "true" or "false" for the value of the boolean columns. When
importing this file into a DBMS that does not support the BOOLEAN datatype, the import
would fail.

In case you are importing the boolean column into a numeric column in the target DBMS,
SQL Workbench/J will automatically convert the literal true to the numeric value
1 (one) and the literal false to the numeric value 0 (zero). If you do not want this
automatic conversion, you have to specify -booleanToNumber=false for the import.
The default values for the true/false literals can be overwritten with the -literalsFalse and -
literalsTrue switches.

-literalsFalse -literalsTrue When dealing with boolean values in the input file, these two switches define the literals
that represent the value false and the value true when parsing the input data.

The value to these switches is a comma separated list of literals that should
be treated as the specified value, e.g.: -literalsFalse='false,0' -
literalsTrue='true,1' will define the most commonly used values for true/false.

Please note:

• The definition of the literals is case sensitive!
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• You always have to specify both switches, otherwise the definition will be ignored

-constantValues With this parameter you can supply constant values for one or more columns that will be
used when inserting new rows into the database.

The constant values will only be used when inserting rows (e.g. using -mode=insert)

The format of the values is -
constantValues="column1=value1,column2=value2".
The parameter can be repeated multiple times, to make quoting
easier: -constantValues="column1=value1" -
constantValues="column2=value2" The values will be converted by the same
rules as the input values from the input file. If the value for a character column is enclosed
in single quotes, these will be removed from the value before sending it to the database.
To include single quotes at the start or end of the input value you need to use two single
quotes, e.g.-constantValues="name=''Quoted'',title='with space'"
For the field name the value 'Quoted' will be sent to the database. for the field title
the value with space will be sent to the database.

To specify a function call to be executed, enclose the function call in ${...}, e.g.
${mysequence.nextval} or ${myfunc()}. The supplied function will be put into
the VALUES part of the INSERT statement without further checking (after removing the
${ and } characters, of course). So make sure that the syntax is valid for your DBMS. If
you do need to store a literal like ${some.value} into the database, you need to quote
it: -constantValues="varname='${some.value}'".

You can also specify a SELECT statement that retrieves information from the database
based on values from the input file. This is useful when the input file contains e.g. values
from a lookup table (but not the primary key from the lookup table).

The syntax to specify a SELECT statement is similar to a function call: -
constantValues="$@{SELECT type_id FROM type_definition WHERE
type_name = $4" where $4 references the fourth column from the input file. The first
column is $1 (not $0).

The parameter for the SELECT statement do not need to be quoted as internally a
prepared statement is used. However the values in the input file must be convertible by the
JDBC driver.

Please refer to the examples for more details on the usage.

-insertSQL Define the statement to be used for inserting rows.

This can be used to use hints or customize the generated INSERT statement. The
parameter may only contain the INSERT INTO part of the statement (i.e. INSERT
INTO is the default if nothing is specified). This can be used to pass special hints to the
database, e.g. to specify an append hint for Oracle:

You have to quote the parameter value using single quotes, otherwise comments
will be removed from the SQL statement!

-insertSQL='INSERT /*+ append */ INTO'

-preTableStatement -
postTableStatement

This parameter defines a SQL statement that should be executed before the import
process starts inserting data into the target table. The name of the current table (when e.g.
importing a whole directory) can be referenced using ${table.name}.
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Parameter Description

To define a statement that should be executed after all rows have been inserted and have
been committed, you can use the -postTableStatement parameter.

These parameters can e.g. be used to enable identity insert for MS SQL Server:

-preTableStatement="set identity_insert ${table.name} on"
-postTableStatement="set identity_insert ${table.name} off"

Errors resulting from executing these statements will be ignored. If you want to abort
the import in that case you can specify -ignorePrePostErrors=false and -
continueOnError=false.

-
ignorePrePostErrors=false

Controls handling of errors for the -preTableStatement and -
postTableStatement parameters. If this is set to false, errors resulting from
executing the supplied parameters are ignored. If set to true (default) then error handling
depends on the parameter -continueOnError.

-showProgress Valid values: true, false, <numeric value>

Control the update frequence in the statusbar (when running in GUI mode). The default
is every 10th row is reported. To disable the display of the progress specifiy a value of 0
(zero) or the value false. true will set the progress interval to 1 (one).

12.2. Parameters for the type TEXT

Parameter Description

-fileColumns A comma separated list of the table columns in the import file Each column from the file
should be listed with the approriate column name from the target table. This parameter
also defines the order in which those columns appear in the file. If the file does not contain
a header line or the header line does not contain the names of the columns in the database
(or has different names), this parameter has to be supplied. If a column from the input file
has no match in the target table, then it should be specified with the name $wb_skip$. You
can also specify the $wb_skip$ flag for columns which are present but that you want to
exclude from the import.

This parameter is ignored when the -sourceDir parameter is used.

-importColumns Defines the columns that should be imported. If all columns from the input file should
be imported (the default), then this parameter can be ommited. If only certain columns
should be imported then the list of columns can be specified here. The column names
should match the names provided with the -filecolumns switch. The same result can be
achieved by providing the columns that should be excluded as $wb_skip$ columns in
the -filecolumns switch. Which one you choose is mainly a matter of taste. Listing all
columns and excluding some using -importcolumns might be more readable because
the structure of the file is still "visible" in the -filecolumns switch.

This parameter is ignored when the -sourcedir parameter is used.

-delimiter Define the character which separates columns in one line. Records are always separated
by newlines (either CR/LF or a single a LF character) unless -multiLine=true is
specified

Default value: \t (a tab character)
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Parameter Description

-columnWidths To import files that do not have a delimiter but a fixed width for each column, this
parameters defines the width of each column in the input file. The value for this parameter
is a comma separated list, where each element defines the width for a single column. If
this parameter is given, the -delimiter parameter is ignored.

e.g.: -columnWidths='name=10,lastname=20,street=50,flag=1'

Note that the whole list must be enclosed in quotes as the parameter value contains the
equal sign.

If you want to import only certain columns you have to use -fileColumns and -
importColumns to select the columns to import. You cannot use $wb_skip$ in the -
fileColumns parameter with a fixed column width import.

-dateFormat The format for date columns.

-timestampFormat The format for datetime (or timestamp) columns in the input file.

-quoteChar The character which was used to quote values where the delimiter is contained. This
parameter has no default value. Thus if this is not specified, no quote checking will take
place. If you use -multiLine=true you have to specify a quote character in order for
this to work properly.

-quoteAlways Possible values: true, false

WbImport will always handled quoted values correctly, if a quote character is defined
through -quoteChar.

Using -quoteAlways=true enables the distinction between NULL values and empty
strings in the import file, but only if -quoteAlways=true has also been used when
running WbExport. Remember to also use -emptyStringIsNull=false, as by
default empty string values are treated as NULLs

-quoteCharEscaping Possible values: none, escape, duplicate

Defines how quote characters that appear in the actual data are stored in the input file.

You have to define a quote character in order for this option to have an effect. The
character defined with the -quoteChar switch will then be imported according to the
setting defined by this switch.

If escape is specified, it is expected that a quote that is part of the data is preceded with
a backslas, e.g. the input value here is a \" quote character will be imported
as here is a " quote character

If duplicate is specified, it is expected that the quote character is duplicated in the
input data. This is similar to the handling of single quotes in SQL literals. The input value
here is a "" quote character will be imported as here is a " quote
character

-multiLine Possible values: true, false

Enable support for records spanning more than one line in the input file. These records
have to be quoted, otherwise they will not be recognized.

If you create your exports with the WbExport command, it is recommended to encode
special characters using the -escapetext switch rather then using multi-line records.
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The default value for this parameter can be controlled in the settings file and it will be
displayed if you run WbImport without any parameters.

-decimal The decimal symbol to be used for numbers. The default is a dot

-header Possible values: true, false

If set to true, indicates that the file contains a header line with the column names for the
target table. This will also ignore the data from the first line of the file. If the column
names to be imported are defined using the -filecolumns or the -importcolumns
switch, this parameter has to be set to true nevertheless, otherwise the first row would be
treated as a regular data row.

This parameter is always set to true when the -sourcedir parameter is used.

The default value for this option can be changed in the  settings file and it will be
displayed if you run WbImport without any parameters. It defaults to true

-decode Possible values: true, false

This controls the decoding of escaped characters. If the export file was e.g. written with
escaping enabled then you need to set -decode=true in order to interpret string
sequences like \t, \n or escaped Unicode characters properly. This is not enabled by default
because applying the necessary checks has an impact on the performance.

-columnFilter This defines a filter on column level that selects only certain rows from
the input file to be sent to the database. The filter has to be defined as
column1="regex",column2="regex". Only Rows matching all of the supplied
regular expressions will be included by the import.

This parameter is ignored when the -sourcedir parameter is used.

-lineFilter This defines a filter on the level of the whole input row (rather than for each column
individually). Only rows matching this regular expression will be included in the import.

The complete content of the row from the input file will be used to check the regular
expression. When defining the expression, remember that the (column) delimiter will be
part of the input string of the expression.

-emptyStringIsNull Possible values: true, false

Controls whether input values for character type columns with a length of zero are treated
as NULL (value true) or as an empty string.

The default value for this parameter is true

Note that, input values for non character columns (such as numbers or date columns) that
are empty or consist only of whitespace will always be treated as NULL.

-trimValues Possible values: true, false

Controls whether leading and trailing whitespace are removed from the input
values before they are stored in the database. When used in combination with -
emptyStringIsNull=true this means that a column value that contains only
whitespace will be stored as NULL in the database.

The default value for this parameter can be controlled in the settings file and it will be
displayed if you run WbImport without any parameters.
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Note that, input values for non character columns (such as numbers or date columns) are
always trimmed before converting them to their target datatype.

-blobIsFilename Possible values: true, false

This is a deprecated parameter. Please use -blobType instead.

When exporting tables that have BLOB columns using WbExport into text files, each
BLOB will be written into a separate file. The actual column data of the text file will
contain the file name of the external file. When importing text files that do not reference
external files into tables with BLOB columns setting this paramter to false, will send the
content of the BLOB column "as is" to the DBMS. This will of course only work if the
JDBC driver can handle the data that in the BLOB columns of the text file. The default for
this parameter is true

This parameter is ignored, if -blobType is also specified.

-blobType Possible values: file, ansi, base64

Specifies how BLOB data is stored in the input file. If file is specified, it is assumed
that the column value contains a filename that in turn contains the real blob data. This is
the default format when using WbExport.

For the other two type, WbImport assumes that the blob data is stored as encoded
character data in the column.

If this parameter is specified, -blobIsFilename is ignored.

-clobIsFilename Possible values: true, false

When exporting tables that have CLOB columns using WbExport and the parameter -
clobAsFile=true the generated text file will not contain the actual CLOB contents,
but the a filename indicating the file in which the CLOB content is stored. In this case -
clobIsFilename=true has to be specified in order to read the CLOB contents from
the external files. The CLOB files will be read using the encoding specified with the -
encoding parameter.

12.3. Text Import Examples

12.3.1. Importing date columns

WbImport -file=c:/temp/contacts.txt
         -table=person
         -filecolumns=lastname,firstname,birthday
         -dateformat="yyyy-MM-dd";

This imports a file with three columns into a table named person. The first column in the file is lastname, the second
column is firstname and the third column is birhtday. Values in date columns are formated as yyyy-MM-dd

A special timestamp format millis is availalbe to identify times represented in milliseconds (since January 1,
1970, 00:00:00 GMT).

12.3.2. Excluding input columns from the import

WbImport -file=c:/temp/contacts.txt
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         -table=person
         -filecolumns=lastname,firstname,$wb_skip$,birthday
         -dateformat="yyyy-MM-dd";

This will import a file with four columns. The third column in the file does not have a corresponding column in the
table person so its specified as $wb_skip$ and will not be imported.

WbImport -file=c:/temp/contacts.txt
         -table=person
         -filecolumns=lastname,firstname,phone,birthday
         -importcolumns=lastname,firstname;

This will import a file with four columns where all columns exist in the target table. Only lastname and
firstname will be imported. The same effect could be achieved by specifying $wb_skip$ for the last two columns
and leaving out the -importcolumns switch. Using -importcolumns is a bit more readable because you can still see the
structure of the input file. The version with $wb_skip$ is mandatory if the input file contains columns that do not
exist in the target table.

12.3.3. Filtering rows during import

If you want to import certain rows from the input file, you can use regular expressions:

WbImport -file=c:/temp/contacts.txt
         -table=person
         -filecolumns=lastname,firstname,birthday
         -columnfilter=lastname="^Bee.*",firstname="^Za.*"
         -dateformat="yyyy-MM-dd";

The above statement will import only rows where the column lastname contains values that start with Bee and the
column firstname contains values that start with Za. So Zaphod Beeblebrox would be imported, Arthur
Beeblebrox would not be imported.

If you want to learn more about regular expressions, please have a look at http://www.regular-expressions.info/

If you want to limit the rows that are updated but cannot filter them from the input file using -columnfilter or -
linefilter, use the -updatewhere parameter:

WbImport -file=c:/temp/contacts.txt
         -table=person
         -filecolumns=id,lastname,firstname,birthday
         -keycolumns=id
         -mode=update
         -updatewhere="source <> 'manual'"

This will update the table PERSON. The generated UPDATE statement would normally be: UPDATE person SET
lastname=?, firstname=?, birthday=? WHERE id=?. The table contains entries that are maintained
manually (identified by the value 'manual' in the column source) and should not be updated by SQL Workbench/J.
By specifying the -updatewhere parameter, the above UPDATE statement will be extended to WHERE id=? AND
(source <> 'manual'). Thus skipping records that are flagged as manual even if they are contained in the input
file.

12.3.4. Importing several files

WbImport -sourceDir=c:/data/backup
         -extension=txt
         -header=true

http://www.regular-expressions.info/
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This will import all files with the extension txt located in the directory c:/data/backup into the database. This
assumes that each filename indicates the name of the target table.

WbImport -sourceDir=c:/data/backup
         -extension=txt
         -table=person
         -header=true

This will import all files with the extension txt located in the directory c:/data/backup into the table person
regardless of the name of the input file. In this mode, the parameter -deleteTarget will be ignored.

12.3.5. Populating columns from the database

When your input file does not contain the actual values to be stored in the target table, but e.g. lookup values, you can
specify a SELECT statement to retrieve the necessary primary key of the lookup table.

Consider the following tables:

contact (contact_id, first_name, last_name, type_id)
contact_type (type_id, type_name)

The table contact_type contains: (1, 'business'), (2, 'private'), (3, 'other').

Your input file only contains contact_id, first_name, last_name, type_name. Where type_name
references an entry from the contact_type table.

To import this file, the following statement can be used:

WbImport
  -file=contacts.txt
  -type=text
  -header=true
  -table=contact
  -importColumns=contact_id, first_name, last_name
  -constantValues="type_id=$@{SELECT type_id FROM contact_type WHERE type_name = $4}"
         

For every row from the input file, SQL Workbench/J will run the specified SELECT statement. The value of the first
column of the first row that is returned by the SELECT, will then be used to populate the type_id column. The
SELECT statement will use the value of the third column of the row that is currently being inserted as the value for the
WHERE condition.

You must use the -importColumns parameter as well to make sure the type_name column is not processed! As an
alternative you can also use -fileColumns=contact_id, first_name, last_name, $wb_skip$
instead of -importColumns.

The "placeholders" with the column index must not be quoted (e.g. '$1' for a character column will not work)!

If the column contact_id should be populated by a sequence, the above statement can be extended to include a
function call to retrieve the sequence value (PostgreSQL syntax:)

WbImport
  -file=contacts.txt
  -type=text
  -header=true
  -table=contact
  -importColumns=first_name, last_name
  -constantValues="id=${nextval('contact_id_seq'::regclass)}"
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  -constantValues="type_id=$@{SELECT type_id FROM contact_type WHERE type_name = $4}"

As the ID column is now populated through a constant expression, it may not appear in the -importColumns list.
Again you could alternatively use -fileColumns=$wb_skip$, first_name, last_name, $wb_skip$
to make sure the columns that are populated through the -constantValue parameter are not taken from the input file.

12.4. Parameters for the type XML

The XML import only works with files generated by the WbExport command.

Parameter Description

-verboseXML Possible values: true, false

If the XML was generated with -verboseXML=false then this needs to be specified
also when importing the file. Beginning with build 78, the SQL Workbench/J writes the
information about the used tags into the meta information. So it is no longer necessary to
specify whether -verboseXML was true when creating the XML file.

-sourceDir Specify a directory which contains the XML files. All files in that directory ending with
".xml" (lowercase!) will be processed. The table into which the data is imported is read
from the XML file, also the columns to be imported. The parameters -keycolumns, -
table and -file are ignored if this parameter is specified. If XML files are used that
are generated with a version prior to build 78, then all files need to use either the long
or short tag format and the -verboseXML=false parameter has to be specified if the
short format was used.

When importing several files at once, the files will be imported into the tables specified
in the XML files. You cannot specify a different table (apart from editing the XML file
before starting the import).

-importColumns Defines the columns that should be imported. If all columns from the input file should be
imported (the default), then this parameter can be ommited. When specified, the columns
have to match the column names available in the XML file.

-createTarget If this parameter is set to true the target table will be created, if it doesn't exist. Valid
values are true or false.

12.5. Update mode

The -mode parameter controls the way the data is sent to the database. The default is INSERT. SQL Workbench/J will
generate an INSERT statement for each record. If the INSERT fails no further processing takes place for that record.

If -mode is set to UPDATE, SQL Workbench/J will generate an UPDATE statement for each row. In order for this to
work, the table needs to have a primary key defined, and all columns of the primary key need to be present in the import
file. Otherwise the generated UPDATE statement will modify rows that should not be modified. This can be used to
update existing data in the database based on the data from the export file.

To either update or insert data into the table, both keywords can be specified for the -mode parameter. The order in
which they appear as the parameter value, defines the order in which the respective statements are sent to the database.
If the first statement fails, the second will be executed. For -mode=insert,update to work properly a primary or
unique key has to be defined on the table. SQL Workbench/J will catch any exception (=error) when inserting a record,
then it will try updating the record, based on the specified keycolumns. The -mode=update,insert works the
other way. First SQL Workbench/J will try to update the record based on the primary keys. If the DBMS signals that
no rows have been updated, it is assumed that the row does not exist and the record will be inserted into the table. This
mode is recommended when no primary or unique key is defined on the table, and an INSERT would always succeed.
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The keycolumns defined with the -keycolumns parameter don't have to match the real primary key, but they should
identify one row uniquely.

You cannot use the update mode, if the tables in question only consist of key columns (or if only key columns are
specified). The values from the source are used to build up the WHERE clause for the UPDATE statement.

If you specify a combined mode (e.g.: update,insert) and one of the tables involved consists only of key columns,
the import will revert to insert mode. In this case database errors during an INSERT are not considered as real errors
and are silently ignored.

For maximum performance, choose the update strategy that will result in a succssful first statement more often. As a
rule of thumb:

• Use -mode=insert,update, if you expect more rows to be inserted then updated.

• Use -mode=update,insert, if you expect more rows to be updated then inserted.

To use insert/update or update/insert with PostgreSQL, make sure you have enabled savepoints for the import (which is
enabled by default).
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13. Copy data across databases

The WbCopy is essentially the command line version of the the DataPumper. For a more detailed explanation of the
copy process, please refer to that section. It bascially chains a WbExport and a WbImport statement without the need
of an intermediate data file. The WbCopy command requires that a connection to the source and target database can be
made at the same time.

13.1. General parameters for the WbCopy command.

Parameter Description

-sourceProfile The name of the connection profile to use as the source connection. If -sourceprofile is not
specified, the current connection is used as the source.

If the profile name contains spaces or dashes, it has to be quoted.

-sourceGroup If the name of your source profile is not unique across all profiles, you will need to specify
the group in which the profile is located with this parameter.

If the group name contains spaces or dashes, it has to be quoted.

-targetProfile The name of the connection profile to use as the target connection. If -targetprofile
is not specified, the current connection is used as the target.

If the profile name contains spaces or dashes, it has to be quoted.

-targetGroup If the name of your target profile is not unique across all profiles, you will need to specify
the group in which the profile is located with this parameter.

If the group name contains spaces or dashes, it has to be quoted.

-commitEvery The number of rows after which a commit is sent to the target database. This parameter is
ignored if JDBC batching (-batchSize) is used.

-deleteTarget Possible values: true, false

If this parameter is set to true, all rows are deleted from the target table before copying the
data.

-mode Defines how the data should be sent to the database. Possible values are INSERT,
UPDATE, 'INSERT,UPDATE' and 'UPDATE,INSERT'. Please refer to the description of
the WbImport command for details on.

-syncDelete If this option is enabled -syncDelete=true, SQL Workbench/J will check each
row from the target table if it's present in the source table. Rows in the target table that
are not present in the source will be deleted. As this is implemented by checking each
row individually in the source table, this can take some time for large tables. This option
requires that each table in question has a primary key defined.

Combined with an UPDATE,INSERT or UPDATE,INSERT mode this creates an exact
copy of the source table.

If more than one table is copied, the delete process is started after all inserts and updates
have been processed. It is recommended to use the -checkDependencies parameter
to make sure the deletes are processed in the correct order (which is most probably already
needed to process inserts correctly).

To only generate the SQL statements that would synchronize two databases, you can use
the command WbDataDiff
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Parameter Description

-keyColumns Defines the key columns for the target table. This parameter is only necessary if import is
running in UPDATE mode. It is ignored when specifying more than one table with the -
sourceTable argument. In that case each table must have a primary key.

-batchSize Enable the use of the JDBC batch update feature, by setting the size of the batch queue.
Any value greater than 1 will enable batch modee. If the JDBC driver supports this, the
INSERT (or UPDATE) performance can be increased.

This parameter will be ignored if the driver does not support batch updates or if
the mode is not UPDATE or INSERT (i.e. if -mode=update,insert or -
mode=insert,update is used).

-commitBatch Valid values: true, false

When using the -batchSiez parameter, the -commitEvery is ignored (as not
all JDBC drivers support a COMMIT inside a JDBC batch operation. When using -
commitBatch=true SQL Workbench/J will send a COMMIT to the database server
after each JDBC batch is sent to the server.

-continueOnError Defines the behaviour if an error occurs in one of the statements. If this is set to true the
copy process will continue even if one statement fails. If set to false the copy process
will be halted on the first error. The default value is false.

With PostgreSQL continueOnError will only work, if the use of savepoints is
enabled using -useSavepoint=true.

-useSavepoint Possible values: true, false

Controls if SQL Workbench/J guards every insert or update statement with a savepoint to
recover from individual error during import, when continueOnError is set to true.

Using a savepoint for each DML statement can drastically reduce the performance of the
import.

-showProgress Valid values: true, false, <numeric value>

Control the update frequence in the statusbar (when running in GUI mode). The default
is every 10th row is reported. To disable the display of the progress specifiy a value of 0
(zero) or the value false. true will set the progress interval to 1 (one).

13.2. Copying data from one or more tables

Parameter Description

-sourceTable The name of the table(s) to be copied. You can either specifiy a list of tables: -
sourceTable=table1,table2. Or select the tables using a wildcard: -
sourceTable=* will copy all tables accessible to the user. If more than one table is
specified using this parameter, the -targetTable parameter is ignored.

-checkDependencies When copying more than one file into tables with foreign key constraints, this
switch can be used to import the files in the correct order (child tables first). When -
checkDependencies=true is passed, SQL Workbench/J will check the foreign key
dependencies for the tables specified with -sourceTable

-sourceWhere A WHERE condition that is applied to the source table.

-targetTable The name of the table into which the data should be written. This parameter is ignored if
more than one table is copied.
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Parameter Description

-createTarget If this parameter is set to true the target table will be created, if it doesn't exist. Valid
values are true or false.

When using this option with different source and target DBMS, the information about
the datatypes to be used in the target database are retrieved from the JDBC driver. In
some cases this information might not be accurate or complete. You can enhance the
information from the driver by configuring your own mappings in workbench.settings.
Please see the section Customizing data type mapping for details.

-tableType When -createTarget is set to true, this parameter can be used to control the SQL
statement that is generated to create the target table. This is useful if the target table should
e.g. be a temporary table

When using the auto-completion for this parameter, all defined "create types" that are
configured in workbench.settings (or are part of the default settings) are displayed together
with the name of the DBMS they are used for. The list is not limited to definitions for the
target database! The specified type must nonetheless match a type defined for the target
connection. If you specify a type that does not exist, the default CREATE TABLE will be
used.

For details on how to configure a CREATE TABLE template for this parameter, please
refer to the chapter Settings related to SQL statement generation

-skipTargetCheck Normally WbCopy will check if the specified target table does exist. However, some
JDBC drivers do not always return all table information correctly (e.g. temporary tables).
If you know that the target table exists, the parameter -skipTargetCheck=true can
be used to tell WbCopy, that the (column) definition of the source table should be assumed
for the target table and not further test for the target table will be done.

-dropTarget If this parameter is set to true the target table will be dropped before it is created.

-columns Defines the columns to be copied. If this parameter is not specified, then all matching
columns are copied from source to target. Matching is done on name and data type. You
can either specify a list of columns or a column mapping.

When supplying a list of columns, the data from each column in the source table
will be copied into the corresponding column (i.e. one with the same name) in the
target table. If -createTarget=true is specified then this list also defines the
columns of the target table to be created. The names have to be separated by comma: -
columns=firstname, lastname, zipcode

A column mapping defines which column from the source table maps to which column of
the target table (if the column names do not match) If -createtable=true then the
target table will be created from the specified target names: -columns=firstname/
surname, lastname/name, zipcode/zip Will copy the column firstname
from the source table to a column named surname in the target table, and so on.

This parameter is ignored if more than one table is copied.

When using a SQL query as the data source a mapping cannot be specified.
Please check Copying data based on a SQL query for details.

-preTableStatement -
postTableStatement

This parameter defines a SQL statement that should be executed before the import
process starts inserting data into the target table. The name of the current table (when e.g.
importing a whole directory) can be referenced using ${table.name}.

To define a statement that should be executed after all rows have been inserted and have
been committed, you can use the -postTableStatement parameter.
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Parameter Description

These parameters can e.g. be used to enable identity insert for MS SQL Server:

-preTableStatement="set identity_insert ${table.name} on"
-postTableStatement="set identity_insert ${table.name} off"

Errors resulting from executing these statements will be ignored. If you want to abort
the import in that case you can specify -ignorePrePostErrors=false and -
continueOnError=false.

-
ignorePrePostErrors=false

Controls handling of errors for the -preTableStatement and -
postTableStatement parameters. If this is set to false, errors resulting from
executing the supplied parameters are ignored. If set to true (default) then error handling
depends on the parameter -continueOnError.

13.3. Copying data based on a SQL query

Parameter Description

-sourceQuery The SQL query to be used as the source data (instead of a table).

-columns The list of columns from the target table, in the order in which they appear in the source
query.

If the column names in the query match the column names in the target table, this
parameter is not necessary.

If you do specify this parameter, note that this is not a column mapping. It only lists the
columns in the correct order .

13.4. Update mode

The WbCopy command understands the same update mode parameter as the WbImport command. For a discussion on
the different update modes, please refer to the WbImport command.

13.5. Synchronizing tables

Using -mode=update,insert ensures that all rows that are present in the source table do exist in the target table
and that all values for non-key columns are identical.

When you need to keep two tables completely in sync, rows that are present in the target table that do not exist
in the source table need to be deleted. This is what the parameter -syncDelete is for. If this is enabled (-
syncDelete=true) then SQL Workbench/J will check every row from the target table if it is present in the source
table. This check is based on the primary keys of the target table and assumes that the source table as the same primary
key.

Testing if each row in the target table exists in the source table is a substantial overhead, so you should enable this
option only when really needed. DELETEs in the target table are batched according to the -batchSize setting of the
WbCopy command. To increase performance, you should enable batching for the whole process.

Internally the rows from the source table are checked in chunks, which means that SQL Workbench/J will generate a
SELECT statement that contains a WHERE condition for each row retrieved from the target table. The default chunk size
is relatively small to avoid problems with large SQL statements. This approach was taken to minimize the number of
statements sent to the server.
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The automatic fallback [87] from update,insert or insert,update mode to insert mode applies for
synchronizing tables using WbCopy as well.

13.6. Examples

13.6.1. Copy one table to another where all column names match

WbCopy -sourceProfile=ProfileA
       -targetProfile=ProfileB
       -sourceTable=the_table
       -targetTable=the_other_table;

13.6.2. Synchronize the tables between two databases

This example will copy the data from the tables in the source database to the corresponding tables in the target database.
Rows that are not available in the source tables are deleted from the target tables.

WbCopy -sourceProfile=ProfileA
       -targetProfile=ProfileB
       -sourceTable=*
       -mode=update,insert
       -syncDelete=true;

13.6.3. Copy only selected rows

WbCopy -sourceProfile=ProfileA
       -targetProfile=ProfileB
       -sourceTable=the_table
       -sourceWhere="lastname LIKE 'D%'"
       -targetTable=the_other_table;

This example will run the statement SELECT * FROM the_table WHERE lastname like 'D%' and copy
all corresponding columns to the target table the_other_table.

13.6.4. Copy data between tables with different columns

This example copies only selected columns from the source table. The column names in the two tables do not match and
a column mapping is defined. Before the copy is started all rows are deleted from the target table.

WbCopy -sourceProfile=ProfileA
       -targetProfile=ProfileB
       -sourceTable=person
       -targetTable=contacts
       -deleteTarget=true
       -columns=firstname/surname, lastname/name, birthday/dob;

13.6.5. Copy data based on a SQL query

When using a query as the source for the WbCopy command, the column mapping is specified by simply supplying the
order of the target columns as they appear in the SELECT statement.

WbCopy -sourceProfile=ProfileA
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       -targetProfile=ProfileB
       -sourceQuery="SELECT firstname, lastname, birthday FROM person"
       -targetTable=contacts
       -deleteTarget=true
       -columns=surname, name, dob;

This copies the data based on the SELECT statement into the table CONTACTS of the target database. The -columns
parameter defines that the first column of the SELECT (firstname) is copied into the target column with the name
surname, the second result column (lastname) is copied into the target column name and the last source column
(birthday) is copied into the target column dob.

This example could also be written as:

WbCopy -sourceProfile=ProfileA
       -targetProfile=ProfileB
       -sourceQuery="SELECT firstname as surname, lastname as name, birthday as dob FROM person"
       -targetTable=contacts
       -deleteTarget=true
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14. Other SQL Workbench/J specific commands

In addtion to the WbExport, WbImport and WbCopy commands, SQL Workbench/J implements a set of additional
SQL commands that are not part of the SQL standard. These commands can be used like any other SQL command
(such as UPDATE inside SQL Workbench/J, i.e. inside the editor or as part of a SQL script that is run through SQL
Workbench/J in batch mode.

As those commands are implemented by SQL Workbench/J you will not be able to use them when running your SQL
scripts using a different client program (e.g. psql, SQL*Plus or phpmyadmin.

14.1. Create a report of the database objects - WbSchemaReport

Creates an XML report of selected tables. This report could be used to generate an HTML documentation of the
database (e.g. using the XSLT command). This report can also be generated from within the Database Object Explorer

The resulting XML file can be transformed into a HTML documentation of your database schema. Sample stylesheets
can be downloaded from http://www.sql-workbench.net/xstl.html. If you have XSLT stylsheets that you would like to
share, please send them to <support@sql-workbench.net>.

To see table and column comments with an Oracle database, you need to enable remarks reporting for the
JDBC driver, otherwise the driver will not return comments.

The command supports the following parameters:

Parameter Description

-file The filename of the output file.

-tables A (comma separated) list of tables to report. Default is all tables. If this parameter
is specified -schemas is ignored. If you want to generate the report on tables
from different users/schemas you have to use fully qualified names in the list (e.g.
-tables=MY_USER.TABLE1,OTHER_USER.TABLE2) You can also specify
wildcards in the table name: -table=CONTRACT_% will create an XML report for all
tables that start with CONTRACT_.

-excludeTableNames A (comma separated) list of tables to exclude from reporting. This is only used if -tables is
also specified. To create a report on all tables, but exclude those that start with 'DEV', use
-tables=* -excludeTableNames=DEV*

-schemas A (comma separated) list of schemas to generate the report from. For each user/schema
all tables are included in the report. e.g. -schemas=MY_USER,OTHER_USER would
generate a report for all tables in the schemas MY_USER and OTHER_USER.

-includeTables Control the output of table information for the report. The default is true. Valid values
are true, false.

-includeTableGrants If tables are included in the output, the grants for each table can also be included with this
parameter. The default value is false.

-includeProcedures Control the output of stored procedure information for the report. The default is false.
Valid values are true, false.

-includeTriggers This parameter controls if table triggers are added to the output. The default value is
true.

-includeSequences Control the output of sequence information for the report. The default is false. Valid
values are true, false.

-reportTitle Defines the title for the generated XML file. The specified title is written into the tag
<report-title> and can be used when transforming the XML e.g. into a HTML file.

-stylesheet Apply a XSLT transformation to the generated XML file.

http://www.sql-workbench.net/xstl.html
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Parameter Description

-xsltOutput The name of the generated output file when applying the XSLT transformation.

14.2. Compare two database schemas - WbSchemaDiff

WbSchemaDiff analyzes two schemas (or a list of tables) and outputs the differences between those schemas as an
XML file. The XML file describes the changes that need to be applied to the target schema to have the same structure as
the reference schema, e.g. modify column definitions, remove or add tables, remove or add indexes.

The output is intended to be transformed using XSLT (e.g. with the XSLT Command). Sample XSLT transformations
can be found on the SQL Workbench/J homepage

The command supports the following parameters:

Parameter Description

-referenceProfile The name of the connection profile for the reference connection. If this is not specified,
then the current connection is used.

-referenceGroup If the name of your reference profile is not unique across all profiles, you will need to
specify the group in which the profile is located with this parameter.

-targetProfile The name of the connection profile for the target connection (the one that needs to be
migrated). If this is not specified, then the current connection is used.

If you use the current connection for reference and target, then you should prefix the
table names with schema/user or use the -referenceschema and -targetschema
parameters.

-targetGroup If the name of your target profile is not unique across all profiles, you will need to specify
the group in which the profile is located with this parameter.

-file The filename of the output file. If this is not supplied the output will be written to the
message area

-referenceTables A (comma separated) list of tables that are the reference tables, to be checked.

-targetTables A (comma separated) list of tables in the target connection to be compared to the source
tables. The tables are "matched" by their position in the list. The first table in the -
referenceTables parameter is compared to the first table in the -targetTables
parameter, and so on. Using this parameter you can compare tables that do not have the
same name.

If you omit this parameter, then all tables from the target connection with the same names
as those listed in -referenceTables are compared.

If you omit both parameters, then all tables that the user can access are retrieved from the
source connection and compared to the tables with the same name in the target connection.

-referenceSchema Compare all tables from the specified schema (user)

-targetSchema A schema in the target connection to be compared to the tables from the reference schema.

-encoding The encoding to be used for the XML file. The default is UTF-8

-includePrimaryKeys Select whether primary key constraint definitions should be compared as well. The default
is true. Valid values are true or false.

-includeForeignKeys Select whether foreign key constraint definitions should be compared as well. The default
is true. Valid values are true or false.

-includeTableGrants Select whether table grants should be compared as well. The default is false.

http://www.sql-workbench.net/xslt.html
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Parameter Description

-includeTriggers Select whether table triggers are compared as well. The default value is true.

-includeConstraints Select whether table and column (check) constraints should be compared as well. SQL
Workbench/J compares the constraint definition (SQL) as stored in the database.

The default is to compare table constraints (true) Valid values are true or false.

-useConstraintNames When including check constraints this parameter controls whether constraints should be
matched by name, or only by their expression. If comparing by names is enabled, the
diff output will contain elements for constraint modification otherwise only drop and add
entries will be available.

The default is to compare by names(true) Valid values are true or false.

-includeViews Select whether views should also be compared. When comparing views, the source as it is
stored in the DBMS is compared. This comparison is case-sensitiv, which means SELECT
* FROM foo; will be reported as a difference to select * from foo; even if they
are logically the same. A comparison across different DBMS will also not work properly!

The default is true Valid values are true or false.

-includeProcedures Select whether stored procedures should also be compared. When comparing procedures
the source as it is stored in the DBMS is compared. This comparison is case-sensitiv. A
comparison across different DBMS will also not work!

The default is false Valid values are true or false.

-includeIndex Select whether indexes should be compared as well. The default is to not compare index
definitions. Valid values are true or false.

-includeSequences Select whether sequences should be compared as well. The default is to not compare
sequences. Valid values are true, false.

-useJdbcTypes Define whether to compare the DBMS specific data types, or the JDBC data type returned
by the driver. When comparing tables from two different DBMS it is recommended
to use -useJdbcType=true as this will make the comparison a bit more DBMS-
independent. When comparing e.g. Oracle vs. PostgreSQL a column defined as
VARCHAR2(100) in Oracle would be reported as beeing different to a VARCHAR(100)
column in PostgreSQL which is not really true As both drivers ropert the column
as java.sql.Types.VARCHAR, they would be considered as identical when using -
useJdbcType=true.

Valid values are true or false.

-stylesheet Apply a XSLT transformation to the generated XML file.

-xsltOutput The name of the generated output file when applying the XSLT transformation.

14.3. Compare data across databases - WbDataDiff

The WbDataDiff command can be used to generate SQL scripts that update a target database such that the data is
identical to a reference database. This is similar to the WbSchemaDiff but compares the actual data in the tables
rather than the table structure.

For each table the command will create up to three script files, depending on the needed statements to migrate the
data. One file for UPDATE statements, one file for INSERT statements and one file for DELETE statements (if -
includeDelete=true is specified)

As this command needs to read every row from the reference and the target table, processing large tables can
take quite some time, especially if DELETE statements should also be generated.
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WbDataDiff requires that all involved tables have a primary key defined. If a table does not have a primary key,
WbDataDiff will stop the processing.

To improve performance (a bit), the rows are retrieved in chunks from the target table by dynamically constructing a
WHERE clause for the rows that were retrieved from the reference table. The chunk size can be controlled using the
property workbench.sql.sync.chunksize The chunk size defaults to 25. This is a conservative setting to avoid
problems with long SQL statements when processing tables that have a PK with multiple columns. If you know that
your primary keys consist only of a single column and the values won't be too long, you can increase the chunk size,
possibly increasing the performace when generating the SQL statements. As most DBMS have a limit on the length of a
single SQL statement, be careful when setting the chunksize too high. The same chunk size is applied when generating
DELETE statements by the WbCopy command, when syncDelete mode is enabled.

The command supports the following parameters:

Parameter Description

-referenceProfile The name of the connection profile for the reference connection. If this is not specified,
then the current connection is used.

-referenceGroup If the name of your reference profile is not unique across all profiles, you will need to
specify the group in which the profile is located with this parameter. If the profile's name
is unique you can omit this parameter

-targetProfile The name of the connection profile for the target connection (the one that needs to be
migrated). If this is not specified, then the current connection is used.

If you use the current connection for reference and target, then you should prefix the
table names with schema/user or use the -referenceschema and -targetschema
parameters.

-targetGroup If the name of your target profile is not unique across all profiles, you will need to specify
the group in which the profile is located with this parameter.

-file The filename of the main script file. The command creates two scripts per table. One
script named update_<tablename>.sql that contains all needed UPDATE or
INSERT statements. The second script is named delete_<tablename>.sql and
will contain all DELETE statements for the target table. The main script merely calls
(using WbInclude) the generated scripts for each table.

-referenceTables A (comma separated) list of tables that are the reference tables, to be checked. You can
specify the table with wildcards, e.g. -referenceTables=P% to compare all tables
that start with the letter P.

-targetTables A (comma separated) list of tables in the target connection to be compared to the source
tables. The tables are "matched" by their position in the list. The first table in the -
referenceTables parameter is compared to the first table in the -targetTables
parameter, and so on. Using this parameter you can compare tables that do not have the
same name.

If you omit this parameter, then all tables from the target connection with the same names
as those listed in -referenceTables are compared.

If you omit both parameters, then all tables that the user can access are retrieved from the
source connection and compared to the tables with the same name in the target connection.

-referenceSchema Compare all tables from the specified schema (user)

-targetSchema A schema in the target connection to be compared to the tables from the reference schema.

-checkDependencies Valid values are true, false.

Sorts the generated scripts in order to respect foreign key dependencies for deleting and
inserting rows.
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Parameter Description

The default is true.

-includeDelete Valid values are true, false.

Generates DELETE statements for rows that are present in the target table, but not in the
reference table. The default is false.

The default is false.

-type Valid values are sql, xml

Defines the type of the generated files.

-encoding The encoding to be used for the SQL scripts. The default depends on your operating
system. It will be displayed when you run WbDataDiff without any parameters. You
can overwrite the platform default with the property workbench.encoding in the file
workbench.settings

XML files are always stored in UTF-8

-sqlDateLiterals Valid values: jdbc, ansi, dbms, default

Controls the format in which the values of DATE, TIME and TIMESTAMP columns
are written into the generated SQL statements. For a detailed description of the possible
values, please refer to the WbExport command.

-ignoreColumns With this parameter you can define a list of column names that should not be considered
when comparing data. You can e.g. exclude columns that store the last access time of a
row, or the last update time if that should not be taken into account when checking for
changes.

-showProgress Valid values: true, false, <numeric value>

Control the update frequence in the statusbar (when running in GUI mode). The default
is every 10th row is reported. To disable the display of the progress specifiy a value of 0
(zero) or the value false. true will set the progress interval to 1 (one).

WbDataDiff Examples

Compare all tables between two connections, and write the output to the file migrate_staging.sql, but do not
generate DELETE statements.

WbDataDiff -referenceProfile="Production"
           -targetProfile="Staging"
           -file=migrate_staging.sql
           -includeDelete=false

Compare a list of matching tables between two databases and write the output to the file migrate_staging.sql
including DELETE statements.

WbDataDiff -referenceProfile="Production"
           -targetProfile="Staging"
           -referenceTables=person,address,person_address
           -file=migrate_staging.sql
           -includeDelete=true

Compare three tables that are differently named in the target database and ignore all columns (regardless in which table
they appear) that are named LAST_ACCESS or LAST_UPDATE

WbDataDiff -referenceProfile="Production"
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           -targetProfile="Staging"
           -referenceTables=person,address,person_address
           -targetTables=t_person,t_address,t_person_address
           -ignoreColumns=last_access,last_update
           -file=migrate_staging.sql
           -includeDelete=true

14.4. Search source of database objects - WbGrepSource

The command WbGrepSource can be used to search in the source code of the specified database objects.

The command basically retrieves the source code for all selected objects and does a simple search on that source code.
The source code that is searched is identical to the source code that is displayed in the "Source" tab in the various
DbExplorer panels.

The search values can be regular expressions. When searching the source code the specified expression must be found
somewhere in the source. The regex is not used to match the entire source.

The command supports the following parameters:

Parameter Description

-searchValues A comma separated list of values to be searched for.

-useRegex Valid values are true, false.

If this parameter is set to true, the values specified with -searchValues are treated as
regular expression

The default for this parameter is false.

-matchAll Valid values are true, false.

This specifies if all values specified with -searchValues have to match or only one.

The default for this parameter is false.

-ignoreCase Valid values are true, false.

When set to true, the comparison is be done case-insesitive ("ARTHUR" will match
"Arthur" or "arthur").

The default for this parameter is true.

-types Specifies if the object types to be searched. The values for this parameter are the same as
in the "Type" drop down of DbExplorer's table list. Additionally the types function,
procedure and trigger are supported.

When specifying a type that contains a space, the type name neeeds to be enclosed in
quotes, e.g. -types="materialized view"

The default for this parameter is view, procedure, function, trigger,
materialized view.

To search in all available object types, use -types=*

-objects A list of object names to be searched. These names may contain SQL wildcards, e.g. -
objects=PER%,NO%

-schemas Specifies a list of schemas to be searched (for DBMS that support schemas). If this
parameter is not specified the current schema is searched.
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The functionality of the WbGrepSource command is also available through a GUI at Tools » Search in object source

14.5. Search data in multiple tables - WbGrepData

The command WbGrepData can be used to search for occurances of a certain value in all columns of multiple tables.
It is the commandline version of the (client side) Search Table Data tab in the DbExplorer. A more detailed description
on how the searching is performed is available that chapter.

To search the data of a table a SELECT * FROM the_table is executed and processed on a row by row
basis. Although SQL Workbench/J only keeps one row at a time in memory it is possible that the JDBC drivers
caches the full result set in memory. Please see the chapter Common problems for your DBMS to check if the
JDBC driver you are using caches result sets.

The command supports the following parameters:

Parameter Description

-search The value to be searched for

-ignoreCase Valid values are true, false.

When set to true, the comparison is be done case-insesitive ("ARTHUR" will match
"Arthur" or "arthur").

The default for this parameter is true.

-compareType Valid values are contains, equals, matches, startsWith

When specifying matches, the search value is used as a regular expression. A column is
included in the search result if the regular expression is contained in the column value (not
when the column value matches the regular expression entirely!).

The default for this parameter is contains.

-tables A list of table names to be searched. These names may contain SQL wildcards, e.g. -
tables=PER%,NO%. If you want to search in different schemas, you need to prefix the
table names, e.g. -tables=schema1.p%,schema2.n%.

-types By default WbGrepData will search all tables and views (including materialized views).
If you want to search only one of those types, this can be specified with the -types
parameter. Using -types=table will only search table data and skip views in the
database.

-excludeTables A list of table names to be excluded from the search. If e.g. the wildcard for -tables
would select too many tables, you can exclude individual tables with this parameter. The
parameter values may include SQL wildcards.

-tables=p% -excludeTables=product_details,product_images
would process all tables starting with P but not the product_detail and the
product_images tables.

-excludeLobs If this parameter is set to true, CLOB and BLOB columns will not be retrieved at all,
which is useful if you retrieve a lot of rows from tables with columns of those type to
reduce the memory that is needed.

If this switch is set to true the content of CLOB columns will not be searched.
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14.6. Define a script variable - WbVarDef

This defines an internal variable which is used for variable substitution during SQL execution. Details can be found in
the chapter Variable substitution.

The syntax for defining a variable is: WbVarDef variable=value

The variable definition can also be read from a file. The file should list each variable definition on one line (this is
the format of a normal Java properties file). Lines beginning with a # sign are ignored. The syntax is WBVARDEF -
file=<filename>

You can also specify a file when starting SQL Workbench/J with the parameter -vardef=filename.ext. When
specifying a filename you can also define an encoding for the file using the -encoding switch. The specified file has
to be a regular Java properties file. For details see see Reading variables from a file.

14.7. Delete a script variable - WbVarDelete

This removes an internal variable from the variable list. Details can be found in the chapter Variable substitution.

14.8. Show defined script variables - WbVarList

This list all defined variables from the variable list. Details can be found in the chapter Variable substitution.

14.9. Confirm script execution - WbConfirm

The WbConfirm command pauses the execution of the current script and displays a message. You can then choose to
stop the script or continue. The message can be supplied as a parameter of the command. If no message is supplied, a
default message is displayed.

This command can be used to prevent accidental execution of a script even if confirm updates is not enabled.

This command has no effect in batch mode.

14.10. Run a stored procedure with OUT parameters - WbCall

If you want to run a stored procedure that has OUT parameters, you have to use the WbCall command to correctly see
the returned value of the parameters.

Consider the following (Oracle) procedure:

CREATE OR REPLACE procedure return_answer(answer OUT integer)
IS
BEGIN
  answer := 42;
END;
/

To call this procedure you need to supply a placeholder indicating that a parameter is needed.

SQL> WbCall return_answer(?);
PARAMETER | VALUE
----------+------
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ANSWER    | 42

(1 Row)
Converted procedure call to JDBC syntax: {call return_answer(?)}
Execution time: 0.453s
SQL>

Stored procedures with REF CURSORS

If the stored procedure has a REF CURSOR (as an output parameter), WbCall will detect this, and retrieve the result
of the ref cursors.

Consider the following (Oracle) stored procedure:

CREATE PROCEDURE ref_cursor_example(pid number, person_result out sys_refcursor, addr_result out sys_refcursor) is
BEGIN
    OPEN person_result FOR
      SELECT *
      FROM person
      WHERE person_id = pid;

    OPEN addr_result FOR
      SELECT a.*
      FROM address a JOIN person p ON a.address_id = p.address_id
      WHERE p.person_id = pid;
END;
/

To call this procedure you use the same syntax as with a regular OUT parameter:

WbCall ref_cursor_example(42, ?, ?);

SQL Workbench/J will display two result tabs, one for each cursor returned by the procedure. If you use WbCall
ref_cursor_example(?, ?, ?) you will be prompted to enter a value for the first parameter (because that is an
IN parameter).

PostgreSQL functions that return a refcursor

When using ref cursors in PostgreSQL, normally such a function can simply be used inside a SELECT statement, e.g.
SELECT * FROM refcursorfunc();. Unfortunately the PostgreSQL JDBC driver does not handle this correctly
and you will not see the result set returned by the function.

To display the result set returned by such a function, you have to use WbCall as well

CREATE OR REPLACE FUNCTION refcursorfunc()
  RETURNS refcursor
AS
$$
DECLARE
    mycurs refcursor;
 BEGIN
    OPEN mycurs FOR SELECT * FROM PERSON;
    RETURN mycurs;
 END;
$$ LANGUAGE plpgsql;
/
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You can call this function using

WbCall refcursorfunc();

This will then display the result from the SELECT inside the function.

14.11. Execute a SQL script - WbInclude (@)

With the WbInclude command you run SQL scripts without actually loading them into the editor, or call other
scripts from within a script. The format of the command is WbInclude -file=filename;. For DBMS other
then MS SQL, the command can be abbreviated using the @ sign: @filename; is equivalent to WbInclude -
file=filename;. The called script way may also include other scripts. Relative filens (e.g. as parameters for SQL
Workbench/J commands) in the script are always resolved to the directory where the script is located, not the current
directory of the application.

The reason for excluding MS SQL is, that when creating stored procedures in MS SQL, the procedure parameters
are identified using the @ sign, thus SQL Workbench/J would interpret the lines with the variable definition
as the WbInclude command. If you want to use the @ command with MS SQL, you can configure this in your
workbench.settings configuration file.

If the included SQL script contains SELECT queries, the result of those queries will not be displayed in the
GUI

The long version of the command accepts additional parameters. When using the long version, the filename needs to be
passed as a parameter as well.

Only files up to a certain size will be read into memory. Files exceeding this size will be processes statement by
statement. In this case the automatic detection of the alternate delimiter [37] will not work. If your scripts exceed the
maximum size and do use the alternate delimiter you will have to use the "long" version so that you can specify the
actual delimiter used in your script.

The command supports the following parameters:

Parameter Description

-file The filename of the file to be included.

-continueOnError Defines the behaviour if an error occurs in one of the statements. If this is set to true
then script execution will continue even if one statement fails. If set to false script
execution will be halted on the first error. The default value is false

-delimiter Specify the delimiter that is used in the script. This defaults to ;. If you want to define a
delimiter that will only be recognized when it's the only text in a line, append :nl to the
value, e.g.: -delimiter=/:nl

-encoding Specify the encoding of the input file. If no encoding is specified, the default encoding for
the current platform (operating system) is used.

-verbose Controls the logging level of the executed commands. -verbose=true has the same
effect as adding a WbFeedback on inside the called script. -verbose=false has the
same effect as adding the statement WbFeedback off to the called script.

-useSavepoint Control if each statement from the file should be guarded with a savepoint when executing
the script. Setting this to true will make execution of the script more robust, but also
slows down the processing of the SQL statements.

-ignoreDropErrors Controls if errors resulting from DROP statements should be treated as an error or as a
warning.

Execute my_script.sql
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@my_script.sql;

Execute my_script.sql but abort on the first error

wbinclude -file="my_script.sql" -continueOnError=false;

14.12. Extract and run SQL from a Liquibase ChangeLog - WbRunLB

If you manage your stored procedures in Liquibase ChangeLogs, you can use this command to run the necessary SQL
directly from the XML file, without the need to copy and paste it into SQL Workbench/J. This is useful when testing
and developing stored procedures that are managed by a Liquibase changeLog.

This is NOT a replacement for Liquibase.

WbRunLB will only extract SQL statements stored in <sql> or <createProcedure> tags.

It will not convert any of the Liquibase tags to "real" SQL.

WbRunLB will NOT update the Liquibase log table (DATABASECHANGELOG) nor will it check if the
specified changeSet(s) have already been applied to the database.

It is merely a convenient way to extract and run SQL statements stored in a Liquibase XML file!

The attribute splitStatements for the sql tag is evaluated. The delimiter used to split the statements follows the
usual SQL Workbench/J rules (including the use of the alternate delimiter).

WbRunLB supports the following parameters:

Parameter Description

-file The filename of the Liquibase changeLog (XML) file. The <include> tag is NOT
supported! SQL statements stored in files that are referenced using Liquibase's include
tag will not be processed.

-changeSet A list of changeSet ids to be run. If this is omitted, then the SQL from all changesets
(containing ) are executed. The value specified can include the value for the author
attribute as well, -changeSet="Arthur;42" selects the changeSet where
author="Arthur" and id="42". This parameter can be repeated in order to select
multiple changesets: -changeSet="Arthur;42" -changeSet="Arthur;43".

-author Select all changeSets with a given author, e.g. -author=Arthur. If this parameter is
specified, -changeSet is ignored. This parameter can be repeated in order to select
changesets from multiple authors: -author=Arthur -author=Zaphod.

-continueOnError Defines the behaviour if an error occurs in one of the statements. If this is set to true
then script execution will continue even if one statement fails. If set to false script
execution will be halted on the first error. The default value is false

-encoding Specify the encoding of the input file. If no encoding is specified, UTF-8 is used.

14.13. Handling tables or updateable views without primary keys

14.13.1. Define primary key columns - WbDefinePK

To be able to directly edit data in the result set (grid) SQL Workbench/J needs a primary key on the underlying table.
In some cases these primary keys are not present or cannot be retrieved from the database (e.g. when using updateable
views). To still be able to automatically update a result based on those tables (without always manually defining the
primary key) you can manually define a primary key using the WbDefinePk command.
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Assuming you have an updateable view called v_person where the primary key is the column person_id. When
you simply do a SELECT * FROM v_person, SQL Workbench/J will prompt you for the primary key when you try
to save changes to the data. If you run

WbDefinePk v_person=person_id

before retrieving the result, SQL Workbench/J will automatically use the person_id as the primary key (just as if this
information had been retrieved from the database).

To delete a definition simply call the command with an empty column list:

WbDefinePk v_person=

If you want to define certain mappings permanently, this can be done using a mapping file that is specified in the
configuration file. The file specified has to be a text file with each line containing one primary key definition in the
same format as passed to this command. The global mapping will automatically be saved when you exit the application
if a filename has been defined. If no file is defined, then all PK mappings that you define are lost when exiting the
application (unless you explicitely save them using WbSavePkMap

v_person=person_id
v_data=id1,id2

will define a primary key for the view v_person and one for the view v_data. The definitions stored in that file
can be overwritten using the WbDefinePk command, but those changes won't be saved to the file. This file will be
read for all database connections and is not profile specific. If you have conflicting primary key definitions for different
databases, you'll need to execute the WbDefinePk command each time, rather then specifying the keys in the mapping
file.

When you define the key columns for a table through the GUI, you have the option to remember the defined mapping.
If this option is checked, then that mapping will be added to the global map (just as if you had executed WbDefinePk
manually.

The mappings will be stored with lowercase table names internally, regardless how you specify them.

14.13.2. List defined primary key columns - WbListPKDef

To view the currently defined primary keys, execute the command WbListPkDef.

14.13.3. Load primary key mappings - WbLoadPKMap

To load the additional primary key definitions from a file, you can use the the WbLoadPKMap command. If a filename
is defined in the configuration file then that file is loaded. Alternatively if no file is configured, or if you want to load a
different file, you can specify the filename using the -file parameter.

14.13.4. Save primary key mappings - WbSavePKMap

To save the current primary key definitions to a file, you can use the the WbSavePKMap command. If a filename is
defined in the configuration file then the definition is stored in that file. Alternatively if no file is configured, or if you
want to store the current mapping into a different file, you can specify the filename using the -file parameter.

14.14. Change the default fetch size - WbFetchSize

The default fetch size for a connection can be defined in the connection profile. Using the command WbFetchSize
you can change the fetch size without changing the connection profile.
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The following script changes the default fetch size to 2500 rows and then runs a WbExport command.

WbFetchSize 2500;
WbExport -sourceTable=person -type=text -file=/temp/person.txt;

WbFetchSize will not change the current connection profile.

14.15. Run statements as a single batch - WbStartBatch, WbEndBatch

To send several SQL Statements as a single "batch" to the database server, the two commands WbStartBatch
and WbEndBatch can be used. All statements between these two will be sent as a single statement (using
executeBatch()) to the server.

Note that not all JDBC drivers support batched statements, and the flexibility what kind of statements can be batched
varies between the drivers as well. Most drivers will not accept different types of statements e.g. mixing DELETE and
INSERT in the same batch.

To send a group of statements as a single batch, simply use the command WbStartBatch to mark the beginning and
WbEndBatch to mark the end. You have to run all statements together either by using "Execute all" or by selecting
all statements (including WbStartBatch and WbEndBatch) and then using "Execute selected". The following example
sends all INSERT statements as a single batch to the database server:

WbStartBatch;
INSERT INTO person (id, firstname, lastname) VALUES (1, 'Arthur', 'Dent');
INSERT INTO person (id, firstname, lastname) VALUES (2, 'Ford', 'Prefect');
INSERT INTO person (id, firstname, lastname) VALUES (3, 'Zaphod', 'Beeblebrox');
INSERT INTO person (id, firstname, lastname) VALUES (4, 'Tricia', 'McMillian');
WbEndBatch;
COMMIT;

14.16. Extracting BLOB content - WbSelectBlob

To save the contents of a BLOB or CLOB column into an external file the WbSelectBlob command can be used.
Most DBMS support reading of CLOB (character data) columns directly, so depending on your DBMS (and JDBC
driver) this command might only be needed for binary data.

The syntax is very similar to the regular SELECT statement, an additional INTO keyword specifies the name of the
external file into which the data should be written:

WbSelectBlob blob_column
INTO c:/temp/image.bmp
FROM theTable
WHERE id=42;

Even if you specify more then one column in the column list, SQL Workbench/J will only use the first column. If
the SELECT returns more then one row, then one outputfile will be created for each row. Additional files will be
created with a counter indicating the row number from the result. In the above example, image.bmp, image_1.bmp,
image_3.bmp and so on, would be created.

WbSelectBlob is intended for an ad-hoc retrieval of a single LOB column. If you need to extract the contents of
several LOB rows and columns it is recommended to use the WbExport command.

You can also manipulate (save, view, upload) the contents of BLOB columns in a result set. Please refer to BLOB
support for details.
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14.17. Control feedback messages - WbFeedback

Normally SQL Workbench/J prints the results for each statement into the message panel. As this feedback can
slow down the execution of large scripts, you can disable the feedback using the WbFeedback command. When
WbFeedback OFF is executed, only a summary of the number of executed statements will be displayed, once the
script execution has finished. This is the same behaviour as selecting "Consolidate script log" in the options window.
The only difference is, that the setting through WbFeedback is temporary and does not affect the global setting.

14.18. Setting connection properties - SET

The SET command is passed on directly to the driver, except for the parameters described in this chapter as they have
an equivalent JDBC call which will be executed instead.

Oracle does not have a SQL set command. The SET command that is available in SQL*Plus is a specific SQL*Plus
command and will not work with other client software. Most of the SQL*Plus SET commands only make sense with
SQL*Plus (e.g. formatting of the results). To be able to run SQL scripts that are intended for Oracle SQL*PLus, any
error reported from the SET command when running against an Oracle database will silently be ignored and only
logged as a warning.

14.18.1. FEEEDBACK

SET feedback ON/OFF is equivalent to the WbFeedback command, but mimics the syntax of Oracle's SQL*Plus
utility.

14.18.2. SERVEROUTPUT

SET serveroutput on is equivalent to the ENABLEOUT command and SET serveroutput off is
equivalent to DISABLEOUT command.

14.18.3. AUTOCOMMIT

With the command SET autocommit ON/OFF autocommit can be turned on or off for the current connection.
This is equivalent to setting the autocommit property in the connection profile or toggling the state of the SQL »
Autocommit menu item.

14.18.4. MAXROWS

Limits the number of rows returned by the next statement. The behaviour of this command is a bit different between the
console mode and the GUI mode. In console mode, the maxrows stay in effect until you explicitely change it back using
SET maxrows again.

In GUI mode, the maxrows setting is only in effect for the script currently being executed and will only temporarily
overwrite any value entered in the "Max. Rows" field.

14.19. Changing read only mode - WbMode

In the connection profile two options can be specified to define the behaviour when running commands that might
change the update: a "read only" mode that ignores such commands and a "confirm all" mode, where you need to
confirm any statement that might change the database.

These states can temporarily be changed without actually changing the profile using the WbMode command.
This changes the mode for all editor tabs, not only for the one where you run the command.
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Parameters for the WbMode command are:

reset Resets the flags to the profile's definition

normal Makes all changes possible (turns off read only and confirmations)

confirm Enables confirmation for all updating commands

readonly Turns on the read only mode

The following example will turn on read only mode for the current connection, so that any subsequent statement that
updates the database will be ignored

WbMode readonly;

To change the current connection back to the settings from the profile use:

WbMode reset;

14.20. Show table structure - DESCRIBE

Describe shows the definition of the given table. It can be abbreviated with DESC. The command expects the table
name as a parameter. The output of the command will be several result tabs to show the table structure, indexes and
triggers (if present). If the "described" object is a view, the message tab will additionally contain the view source (if
available).

DESC person;

If you want to show the structure of a table from a different user, you need to prefix the table name with the desired user
DESCRIBE otheruser.person;

14.21. List tables - WbList

This command lists all available tables (including views and synonyms). This output is equivalent to the left part of the
Database Object Explorer's Table tab.

You can limit the displayed objects by either specifying a wildcard for the names to be retrieved: WbList P% will list
all tables or views starting with the letter "P"

The command supports two parameters to specify the tables and objects defined in a more detailed manner. If you want
to limit the result by specifying a wildcard for the name and the object type, you have to use the parameter switches:

Parameter Description

-objects Select the objects to be returned using a wildcard name, e.g. -objects=P%

-types Limit the result to specific object types, e.g. WbList -objects=V% -types=VIEW will return
all views starting with the letter "V".

14.22. List stored procedures - WbListProcs

This command will list all stored procedures available to the current user. The output of this command is equivalent to
the Database Explorer's Procedure tab.
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You can limit the list by supplying a wildcard search for the name, e.g.:

WbListProcs public.p%

14.23. List triggers - WbListTriggers

This command will list all stored triggers available to the current user. The output of this command is equivalent to the
Database Explorer's Triggers tab (if enabled)

14.24. Show the source of a stored procedures - WbProcSource

This command will show the source for a single stored procedure (if the current DBMS is supported by SQL
Workbench/J). The name of the procedure is given as an argument to the command:

WbProcSource theAnswer

14.25. List catalogs - WbListCat

Lists the available catalogs (or databases). It is the same information that is shown in the DbExplorer's "Database"
dropdown.

The output of this command depends on the underlying JDBC driver and DBMS. For MS SQL Server this lists the
available databases (which then could be changed with the command USE <dbname>)

For Oracle this command returns nothing as Oracle does not implement the concept of catalogs.

This command calls the JDBC driver's getCatalogs() method and will return its result. If on your database system
this command does not display a list, it is most likely that your DBMS does not support catalogs (e.g. Oracle) or the
driver does not implement this feature.

This command ignores the filter defined for catalogs in the connection profile and always returns all databases.

14.26. List schemas - WbListSchemas

Lists the available schemas from the current connection. The output of this command depends on the underlying JDBC
driver and DBMS. It is the same information that is shown in the DbExplorer's "Schema" dropdown.

This command ignores the filter defined for schemas in the connection profile and always returns all schemas.

14.27. Change the connection for a script - WbConnect

With the WbConnect command, the connection for the script that is currently be exected can be changed.

When this command is run in GUI mode, the connection is only changed for the remainder of the script execution.
Therefor at least one other statement should be executed together with the WbConnect command. Either by running
the complete script of the editor or selecting the WbConnect command together with other statements. Once the script
has finished, the connection is closed and the "global" connection (selected in the connect dialog) is active again. This
also applies to scripts that are run in batch mode or scripts that are started from within the console using WbInclude.
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When this command is entered directly in the commandline of the console mode, the current connection is closed and
the new connection is kept open until the application ends, or a new connection is established using WbConnect on the
commandline again.

The command supports the following parameters:

Parameter Description

-profile Defines the profile to connect to. If this parameter is specified all other parameters are
ignored.

  

or  

  

-url The JDBC connection URL

-username Specify the username for the DBMS

-password Specify the password for the user

-driver Specify the full class name of the JDBC driver

-driverJar Specify the full pathname to the .jar file containing the JDBC driver

-autocommit Set the autocommit property for this connection. You can also control the autocommit mode
from within your script by using the SET AUTOCOMMIT command.

-rollbackOnDisconnect If this parameter is set to true, a ROLLBACK will be sent to the DBMS before the connection
is closed. This setting is also available in the connection profile.

-trimCharData Turns on right-trimming of values retrieved from CHAR columns. See the description of the
profile properties for details.

-removeComments This parameter corresponds to the Remove comments setting of the connection profile.

-fetchSize This parameter corresponds to the Fetch size setting of the connection profile.

-ignoreDropError This parameter corresponds to the Ignore DROP errors setting of the connection profile.

If none of the parameters is supplied when running the command, it is assumed that any value after WbConnect is the
name of a connection profile, e.g.:

WbConnect production

will connect using the profile name production, and is equivalent to

WbConnect -profile=production

14.28. Run an XSLT transformation - WbXslt

Transforms an XML file via a XSLT stylesheet. This can be used to format XML input files into the correct format for
SQL Workbench/J or to transform the output files that are generated by the various SQL Workbench/J commands.

Parameters for the XSLT command:

Parameter Description

-inputfile The name of the XML source file.

-xsltoutput The name of the generated output file.

-stylesheet The name of the XSLT stylesheet to be used.



SQL Workbench/J User's Manual

111

Parameter Description

-xsltParameters A list of parameters (key/value pairs) that should be passed to the XSLT processor. When
using e.g. the wbreport2liquibase.xslt stylesheet, the value of the author
attribute can be set using -xsltParameters="authorName=42".

14.29. Using Oracle's DBMS_OUTPUT package

To turn on support for Oracle's DBMS_OUTPUT package you have to use the (SQL Workbench/J specific) command
ENABLEOUT.

After running ENABLEOUT the DBMS_OUTPUT package is enabled, and any message written with
dbms_output.put_line() is displayed in the message pane after executing a SQL statement. It is equivalent to
calling the dbms_output.enable() procedure.

You can control the buffer size of the DBMS_OUTPUT package by passing the desired buffer size as a parameter to the
ENABLEOUT command: ENABLEOUT 32000;

Due to a bug in Oracle's JDBC driver, you cannot retrieve columns with the LONG or LONG RAW data
type if the DBMS_OUTPUT package is enabled. In order to be able to display these columns support for
DBMS_OUTPUT has to be switched off.

To disable the DBMS_OUTPUT package again, use the (SQL Workbench/J specific) command DISABLEOUT. This is
equivalent to calling dbms_output.disable() procedure.
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15. DataPumper

15.1. Overview

The export and import features are useful if you cannot connect to the source and the target database at once. If your
source and target are both reachable at the same time, it is more efficient to use the DataPumper to copy data between
two systems. With the DataPumper no intermediate files are necessary. Especially with large tables this can be an
advantage.

To open the DataPumper, select Tools » DataPumper

The DataPumper lets you copy data from a single table (or SELECT query) to a table in the target database. The
mapping between source columns and target columns can be specified as well

Everything that can be done with the DataPumper, can also be accomplished with the WbCopy command. The
DataPumper can also generate a script which executes the WbCopy command with the correct parameters according to
the current settings in the window. This can be used to create scripts which copy several tables.

The DataPumper can also be started as a stand-alone application - without the main window - by specifying
-datapumper=true in the command line when starting SQL Workbench/J. You can also use the supplied
Windows executable DataPumper.exe or the Linux/Unix shell script datapumper

When opening the DatPumper from the main window, the main window's current connection will be used
as the initial source connection. You can disable the automatic connection upon startup with the property
workbench.datapumper.autoconnect in the workbench.settings file.

15.2. Selecting source and target connection

The DataPumper window is divided in three parts: the upper left part for defining the source of the data, the upper right
part for defining the target, and the lower part to adjust various settings which influence the way, the data is copied.

After you have opened the DataPumper window it will automatically connect the source to the currently selected
connection from the main window. If the DataPumper is started as a separate application, no initial connection will be
made.

To select the source connection, press the ellipsis right next to the source profile label. The standard connection dialog
will appear. Select the connection you want to use as the source, and click OK. The DataPumper will then connect to
the database. Connecting to the target database works similar. Simply click on the ellipsis next to the target profile box.

Instead of a database connection as the source, you can also select a text or XML file as the source for the DataPumper.
Thus it can also be used as a replacement of the WbImport command.

The dropdown for the target table includes an entry labelled "(Create new table)". For details on how to create a new
table during the copy process please refer to the advanced tasks section.

After source and target connection are established you can specify the tables and define the column mapping between
the tables.

15.3. Copying a complete table

To copy a single table select the source and target table in the dropdowns (which are filled as soon as the connection is
established)
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After both tables are selected, the middle part of the window will display the available columns from the source and
target table. This grid display represents the column mapping between source and target table.

15.3.1. Mapping source to target columns

Each row in the display maps a source column to a target column. Initially the DataPumper tries to match those columns
which have the same name and data type. If no match is found for a target column, the source column will display
(Skip target column) This means that the column from the target table will not be included when inserting data
into the target table (technically speaking: it will be excluded from the column list in the INSERT statement).

15.3.2. Restricting the data to be copied

You can restrict the number of rows to be copied by specifying a WHERE clause which will be used when retrieving the
data from the source table. The WHERE clause can be entered in the SQL editor in the lower part of the window.

15.3.3. Deleting all rows from the target table

When you select the option "Delete target table", all rows from the target table will be deleted before the copy process
is started. This is done with a DELETE FROM <tablename>; When you select this option, make sure the data can
be deleted in this way, otherwise the copy process will fail.

The DELETE will not be committed right away, but at the end of the copy process. This is obviously only of interest if
the connection is not done with autocommit = true

15.3.4. Continuing when an insert fails

In some cases inserting of individual rows in the target table might fail (e.g. a primary key violation if the table is not
empty). When selecting the option "Continue on error", the copy process will continue even if rows fail to insert

15.3.5. Committing changes

By default all changes are committed at the end, when all rows have been copied. By supplying a value in the field
"Commit every" SQL Workbench/J will commit changes every time the specified number of rows has been inserted
into the target. When a value of 50 rows has been specified, and the source table contains 175 rows, SQL Workbench/J
will send 4 COMMITs to the target database. After inserting row 50, row 100, row 150 and after the last row.

15.3.6. Batch execution

If the JDBC driver supports batch updates, you can enable the use of batch updates with this checkbox. The checkbox
will be disabled, if the JDBC driver does not support batch updates, or if a combined update mode (insert,update,
update,insert) is selected.

Batch execution is only available if either INSERT or UPDATE mode is selected.

15.3.7. Update mode

Just like the WbImport and WbCopy commands, the data pumper can optionally update the data in the target table.
Select the approriate update strategy from the Mode drop down. The DataPumper will use the key columns defined in
the column mapper to generate the UPDATE command. When using update you have to select at least one key column.

You cannot use the update mode, if you select only key columns, The values from the source are used to build up the
WHERE clause for the UPDATE statement. If ony key columns are defined, then there would be nothing to update.
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For maximum performance, choose the update strategy that will result in a succssful first statement more often. As a
rule of thumb:

• Use -mode=insert,upadte, if you expect more rows to be inserted then updated.

• Use -mode=update,insert, if you expect more rows to be updated then inserted.

15.4. Advanced copy tasks

15.4.1. Populating a column with a constant

To populate a target column with a constant value. The name of the source columns can be edited in order to supply a
constant value instead of a column name. Any expression understood by the source database can be entered there. Note
that if (Skip target column) is selected, the field cannot be edited.

15.4.2. Creating the target table

You can create the target table "on the fly" by selecting (Create target table) from the list of target tables.
You will be prompted for the name of the new table. If you later want to use a different name for the table, click on the
button to the right of the drop down.

The target table will be created without any primary key definitions, indexes of foreign key constraints.

The DataPumper tries to map the column types from the source columns to data types available on the target database.
For this mapping it relies on information returned from the JDBC driver. The functions used for this may not be
implemented fully in the driver. If you experience problems during the creation of the target tables, please create the
tables manually before copying the data. It will work best if the source and target system are the same (e.g. PostgreSQL
to PostgreSQL, Oracle to Oracle, etc).

Most JDBC drivers map a single JDBC data type to more then one native datatype. MySql maps its VARCHAR, ENUM
and SET type to java.sql.Types.VARCHAR. The DataPumper will take the first mapping which is returned by the
driver and will ignore all subsequent ones. Any datatype that is returned twice by the driver is logged as a warning in
the log file. The actual mappings used, are logged with type INFO.

To customize the mapping of generic JDBC datatypes to DBMS specific datatypes, please refer to Customizing data
type mapping

15.4.3. Using a query as the source

If you want to copy the data from several tables into one table, you can use a SELECT query as the source of your data.
To do this, select the option Use SQL query as source below the SQL editor. After you have entered you query
into the editor, click the button Retrieve columns from query. The columns resulting from the query will then be put
into the source part of the column mapping. Make sure, the columns are named uniquely when creating the query. If
you select columns from different tables with the same name, make sure you use a column alias to rename the columns.

Creating the target table "on the fly" is not available when using a SQL query as the source of the data
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16. Database Object Explorer

The Database Object Explorer displays the available database objects such as Tables, Views, Triggers and Stored
Procedures.

There are three ways to start the DbExplorer

Using Tools » Database Explorer.
Passing the paramter -dbexplorer to the main program (sqlworkbench.sh or SQLWorkbench.exe)
When using Windows, with the DbExplorer.exe executable or in Linux/Unix using shell script dbexplorer.sh

At the top of the window, the current schema and/or catalog can be selected. Whether both dropdowns are available
depends on the current DBMS. For Microsoft SQL Server, both the schema and the database can be changed. The
labels next to the dropdown are retrieved from the JDBC driver and should reflect the terms used for the current DBMS
(Schema for PostgreSQL and Oracle, Owner and Database for SQL Server, Database for MySQL).

The displayed list can be filtered using the quick filter above the list. To filter the list by the object name, simply enter

the criteria in the filter field, and press ENTER or click the filter icon . The criteria field will list the last 25 values
that were entered in the dropdown. If you want to filter based on a different column of the list, right-click on the criteria
field, and select the desired column from the Filtercolumn menu item of the popup menu. The same filter can be
applied on the Procedures tab.

The list of tables can be pre-filtered to remove unwanted entries such as tables that have been deleted and now reside
in Oracle's "Recycle Bin". The filtering is done through a regular expression on a per-database basis. By default this is
only defined for Oracle and will filter out any table that starts with BIN$.

Synonyms are displayed if the current DBMS supports them. You can filter out unwanted synonyms by specifying a
regular expression in your workbench.settings file. This filter will also be applied when displaying the list of
available tables when opening the command completion popup.

The first tab displays the structure of tables and views. The type of object displayed can be chosen from the drop down
right above the table list. This list will be returned by the JDBC driver, so the available "Table types" can vary from
DBMS to DBMS.

The menu item Database Explorer will either display the explorer as a new window or a new panel, depending on the
system options. If a DbExplorer is already open (either a window or a tab), the existing one is made visible (or active),
when using this menu item.

You can open any number of additional DbExplorer tabs or windows using Tools » New DbExplorer panel or Tools »
New DbExplorer window

16.1. Objects tab

The object list displays tables, views, sequences and synonyms (basically anyhting apart from procedures or functions).
The context menu of the list offers several additional functions:

Export data

This will execute a WbExport command for the currently selected table(s). Choosing this option is
equivalent to do a SELECT * FROM table; and then executing SQL » Export query result from
the SQL editor in the main window. See the description of the WbExport command for details.

When using this function, the customization for datatypes is not applied to the generated SELECT
statement.
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Put SELECT into

This will put a SELECT statement into the SQL editor to display all data for the selected table. You
can choose into which editor tab the statement will be written. The currently selected editor tab is
displayed in bold (when displaying the DbExplorer in a separate window). You can also put the
generated SQL statement into a new editor tab, by selecting the item New tab

When using this function, the customization for datatypes will be applied to the generated SELECT
statement.

Create empty INSERT

This creates an empty INSERT statement for the currently selected table(s). This is intended for
programmers that want to use the statement inside their code.

Create default SELECT

This creates a SELECT for the selected table(s) that includes all columns for the table. This feature is
intended for programmers who want to put a SELECT statement into their code.

If you want to generate a SELECT statement to actually retrieve data from within the editor, please
use the Put SELECT into option.

When using this function, the customization for datatypes is not applied to the generated SELECT
statement.

Create DDL Script

With this command a script for multiple objects can be created. Select all the tables, views or other
objects in the table list, that you want to create a script for. Then right click and select "Create DDL
Script". This will generate one script for all selected items in the list.

When this command is selected, a new window will be shown. The window contains a statusbar
which indicates the object that is currently processed. The complete script will be shown as soon as
all objects have been processed. The objects will be processed in the order: SEQUENCES, TABLES,
VIEWS, SYNONYMS.

Create schema report

This will create an XML report of the selected tables. You will be prompted to specify the location of
the generated XML file. This report can also be generated using the WbSchemaReport command.

Drop

Drops the selected objects. If at least one object is a table, and the currently used DBMS supports
cascaded dropping of constraints, you can enable cascaded delete of constraints. If this option is
enabled SQL Workbench/J would generate e.g. for Oracle a DROP TABLE mytable CASCADE
CONSTRAINTS. This is necessary if you want to drop several tables at the same time that have
foreign key constraints defined.

If the current DBMS does not support a cascading drop, you can order the tables so that foreign
keys are detected and the tables are dropped in the right order by clicking on the Check foreign keys
button.

If the checkbox "Add missing tables" is selected, any table that should be dropped before any of the
selected tables (because of foreign key constraints) will be added to the list of tables to be dropped.
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Delete data

Deletes all rows from the selected table(s) by executing a DELETE FROM table_name; to
the server for each selected table. If the DBMS supports TRUNCATE then this can be done with
TRUNCATE as well. Using TRUNCATE is usually faster as no transation state is maintained.

The list of tables is sorted according to the sort order in the table list. If the tables have foreign key
constraints, you can re-order them to be processed in the correct order by clicking on the Check
foreign keys button.

If the checkbox "Add missing tables" is selected, any table that should be deleted before any of the
selected tables (because of foreign key constraints) will be added to the list of tables.

ALTER script

After you have changed the name of a table in the list of objects, you can generate and run a SQL
script that will apply that change to the database.

For details please refer to the section Changing table definitions

16.2. Table details

When a table is selected, the right part of the window will display its column definition, the SQL statement to create the
table, any index defined on that table (only if the JDBC driver returns that information), other tables that are referenced
by the currently selected table, any table that references the currently selected table and any trigger that is defined on
that table.

The column list will also display any comments defined for the column (if the JDBC driver returns the information).
Oracle's JDBC driver does not return those comments by default. To enable the display of column comments
(remarks) you have to supply an extended property in your connection profile. The property's name should be
remarksReporting and the value should be set to true.

If the DBMS supports synonyms, the columns tab will display the column definition of the underlying table or view.
The source tab will display the statement to re-create the synonym. If the underlying object of the synonym is a table,
then indexes, foreign keys and triggers for that table will be displayed as well.

Note that if the synonym is for a view, those tabs will still be displayed, but will not show any information.

Changing the table definition

You can edit the definition of the columns, add new columns or delete existing columns. To apply the changes, click on
the ALTER table button.

For details please refer to the section Changing table definitions

16.3. Modifying the definition of database objects

16.3.1. Renaming objects

You can edit the name of the objects in the object list. Depending on the DBMS, you might be able to change the name
of other database objects as well (e.g. SEQUENCEs, VIEWs, ...).

For DBMS that support it, you can also edit the remarks column of the table to change the documentation.



SQL Workbench/J User's Manual

118

If the editing the name or comment is rejected, the necessary SQL statements have not been configured for your DBMS.
If your DBMS does support changing the object type in question, please send a mail with the necessary information to
the support email address.

Once you have changed a name (or several) the menu item "ALTER script" in the context menu of the object list, will
display a window with the necessary SQL statements to apply your changes. You can save the generated script to a file
or run the statements directly from that window.

16.3.2. Changing column definitions

You can change the column name, datatype, default value or the nullable flag in the display of the table's details. If the
necessary ALTER statements have been configured for your DBMS, you can generate and run an ALTER script to
apply your changes. This is done by clicking on the ALTER table button.

If your changes are rejected when editing, the necessary SQL statements have not been configured for your DBMS.
If your DBMS does support changing table columns, please send a mail with the necessary information to the support
email address.

16.4. Table data

The data tab will display the data from the currently selected table. There are several options to configure the display of
this tab. The Autoload check box, controls the retrieval of the data. If this is checked, then the data will be retrieved
from the database as soon as the table is selected in the table list (and the tab is visible).

The data tab will also display a total row count of the table. As this display can take a while, the automatic retrieval of
the row count can be disabled. To disable the automatic calculation of the table's rowcount, click on the Settings button
and deselect the checkbox Autoload table row count. To calculate the table's row count when this is not done
automatically, click on the Rows label. You can cancel the row count retrieval while it's running by clicking on the
label again.

The data tab is only available if the currently selected objects is recognized as an object that can can be "SELECTED".
Which object types are included can be defined in the settings for SQL Workbench/J See selectable object types for
details.

You can define a maximum number of rows which should be retrieved. If you enter 0 (zero) then all rows are retrieved.
Limiting the number of rows is useful if you have tables with a lot of rows, where the entire table would not fit into
memory.

In addition to the max rows setting, a second limit can be defined. If the total number of rows in the table exceeds this
second limit, a warning is displayed, whether the data should be loaded.

This is useful when the max rows parameter is set to zero and you accidently display a table with a large number of
rows.

If the automatic retrieval is activated, then the retrieve of the data can be prevented by holding down the Shift key while
switching to the data tab.

The data in the tab can be edited just like the data in the main window. To add or delete rows, you can either use the
buttons on the toolbar in the upper part of the data display, or the popup menu. To edit a value in a field, simply double
click that field, start typing while the field has focus (yellow border) or hit F2 while the field has focus.

16.5. Changing the display order of table columns

You can re-arrange the display order of the columns in the data tab using drag & drop. If you want to apply that column
order whenever you display the table data, you can save the column order by right-clicking in the table header and then
using the menu item Save column order. If the column order has not been changed, the menu item is disabled.
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The column order will be stored using the fully qualified table name and the current connection's JDBC URL as the
lookup key.

To reset the column order use the menu item Reset column order from the popup menu. This will revert the column
order to the order in which the columns appear in the source table. The saved order will be deleted as well.

16.6. Customize data retrieval

When displaying the data for a table, SQL Workbench/J generates a SELECT statement that will retrieve all rows and
columns from the database. In some cases the data for certain data types cannot be displayed correctly as the JDBC
drivers might not implement a proper "toString()" method that converts the data into a readable format.

You can customize the SELECT statement that is generated by SQL Workbench/J when retrieving table data in the
DbExplorer in the configuration file workbench.settings. For each DBMS you can define an expression for
specific data types that are used when building the SELECT statement.

To configure this, you need to add one line per data type and DBMS to the file workbench.settings:

workbench.db.[dbid].selectexpression.[type]=expression(${column})

When building the SELECT statement, the placeholder ${column} will be replaced with the actual column name.
[dbid] is the DBID of the DBMS for which the replacement should be done.

The whole key (the part to the left of the equal sign) must be in lowercase.

[type] is the datatype of the column without any brackets or parameters: varchar instead of varchar(10), or
number instead of number(10,2)

To convert e.g. the geometry datatype of postgres to a readable format, one would use the following expression
astext(transform(geo_column,4326)).

To tell the DbExplorer to replace the retrieval of columns of type geometry in PostgreSQL with the above
expression, the following line in workbench.settings is necessary:

workbench.db.postgres.selectexpression.geometry=astext(transform(${column},4326)) 

For e.g. the table geo_table (id integer, geo_col geometry) SQL Workbench/J will generate the
following SELECT statement:

SELECT id, astext(transform(geo_col,4326))
FROM geo_table

to retrieve the data of that table.

Note that the data of columns that have been "converted" through this mechanism, might not be updateable any more.
If you intend to edit such a column you will have to provide a column alias in order for SQL Workbench/J to generate a
correct UPDATE or INSERT statement.

Another example is to replace the retrieval of XML columns. To configure the DbExplorer to convert Oracle's XMLTYPE
a string, the following line in workbench.settings is necessary:

workbench.db.oracle.selectexpression.xmltype=extract(${column}, '/').getClobVal()

To convert DB2's XML type to a string, the following configuration can be used:

workbench.db.db2.selectexpression.xml=xmlserialize(${column} AS CLOB)

The column name (as displayed in the result set) will usually be generated by the DBMS and will most probably not
contain the real column name. In order to see the real column name you can supply a column alias in the configuration.
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workbench.db.oracle.selectexpression.xmltype=extract(${column}, '/').getClobVal() AS ${column}

In order for SQL Workbench/J to parse the SQL statement correctly, the AS keyword must be used.

You can check the generated SELECT statement by using the Put SELECT into feature. The statement that is generated
and put into the editor, is the same as the one used for the data retrieval.

The defined expression will also be used for the Search table data feature, when using the server side search. If you
want to search inside the data that is returned by the defined expression you have to make sure that you DBMS supports
the result of that expression as part of a LIKE expression. E.g. for the above Oracle example, SQL Workbench/J will
generate the following WHERE condition:

WHERE to_clob(my_clob_col) LIKE '%searchvalue%'

16.7. Customizing the generation of the table source

SQL Workbench/J re-generates the source of a table based on the information about the table's metadata returned by
the driver. In some cases the driver might not return the correct information, or not all the information that is necessary
to build the correct syntax for the DBMS. In those cases, a SQL query can be configured that can use the built-in
functionality of the DBMS to return a table's definition.

This DBMS specific retrieval of the table source is defined by three properties in workbench.settings. Please
refer to Customize table source retrieval for details.

16.8. View details

When a database VIEW is selected in the object list the right will display the columns for the view, the source and the
data returned by a select from that view.

The data details tab works the same way as the data tab for a table. If the view is updateable (depends on the view
definition and the underlying DBMS) then the data can also be changed within the data tab

The source code is retrieved by customized SQL queries (this is not supported by the JDBC driver). If the source code
of views is not displayed for your DBMS, please contact <support@sql-workbench.net>.

16.9. Procedure tab

The procedure tab will list all stored procedures and functions stored in the current schema. For procedures or functions
returning a result set, the definition of the columns will be displayed as well.

To display the procedure's source code SQL Workbench/J uses its own SQL queries. For most popular DBMS systems
the necessary queries are built into the application. If the procedure sourc is not displayed for your DBMS, please
contact the author.

Functions inside Oracle packages will be listed separately on the left side, but the source code will contain all functions/
procedures from that package.

16.10. Search table data

This tab offers the ability to search for a value in all text columns of all tables which are selected. The results will be
displayed on the right side of that tab. The result will always display the complete row where the search value was
found. Any column that contains the entered value will be highlighted.
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The results displayed here are not editable. If you want to modify the results after a search, you have to use the
WbGrepData command

Two different implementations of the search are available: server side and client side.

16.10.1. Server side search

To server side search is enabled by selecting the checkbox labelled "Server side search".

The value will be used to create a LIKE 'value' restriction for each text column on the selected tables. Therefore
the value should contain a wildcard, otherwise the exact expression will be searched.

You can apply a function to each column as well. This is useful if you want to to do a case insensitive search on Oracle
(Oracles VARCHAR comparison is case sensitive). In the entry field for the column the placeholder $col$ is replaced
with the actual column name during the search. To do a case insensitive search in Oracle, you would enter lower($col$)
in the column field and '%test%' in the value field.

The expression in the column field is sent to the DBMS without changes, except the replacement of $col$ with the
current column name. The above example would yield a lower(<column_name>) like '%test%' for each
text column for the selected tables.

The generated SQL statements are logged in the second tab, labeled SQL Statements.

In the resulting tables, SQL Workbench/J tries to highlight those columns which match the criteria. This might not
always work, if you apply a function to the column itself such as to_upper() SQL Workbench/J does not know that
this will result in a case-insesitive search on the database. SQL Workbench/J tries to guess if the given function/value
combination might result in a case insensitive search (especially on a DBMS which does a case sensitive search by
default) but this might not work in all the cases and for all DBMS.

The SELECT statement that is built to display the table's data will list all columns from the table. If the table contains
BLOB columns this might lead to a substantial memory consumption. To avoid loading too many data into memory,
you can check the option "Do not retrieve LOB columns". In that case columns of type CLOB or BLOB will not be
retrieved.

SQL Workbench/J is building a SELECT that "searches" for data using a LIKE expression. Only columns of type CHAR
and VARCHAR are included in the LIKE search, because that is what most DBMS support. If the DBMS you are using
supports LIKE expressions for other datatypes as well, you can configure this datatypes to be included in the search
feature of the DbExplorer.

16.10.2. Client side search

To client side search is enabled by un-checking the checkbox labelled "Server side search".

The client side search retrieves every row from the server, compares the retrieved values for each row and keeps the
rows where at least one column matches the defined search criteria.

As opposed to the server side search, this means that every row from the selected table(s) will be sent from the database
server to the application. For large tables were only a small number of the rows will match the search value this can
increase the processing time substantially.

As the searching is done on the client side, this means that it can also "search" data types that cannot be using for a
LIKE query such as CLOB, DATE, INTEGER.

The search criteria is defined similar to the definition of a filter for a result set. For every column, its value will be
converted to a character representation. The resulting string value will then be compared according to the defined
comparator and the entered search value. If at least one column's value matches, the row will be displayed. The
comparison is always done in a case-insesitively. The contents of BLOB columns will never be searched.
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The character representation that is used is based on the default formatting options from the Options Window. This
means that e.g. a DATE column will be compared according to the standard formatting options before the comparison is
done.

The client side search is also available through the WbGrepData command
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17. Common problems

17.1. The driver class was not found

If you get an error "Driver class not registered" or "Driver not found" please check the following
settings:

• Make sure you have specified the correct location of the jar file. Some drivers (e.g. for IBM DB2) may require more
than one jar file.

• Check the spelling of the driver's class name. Remember that it's case sensitive. If you don't know the driver's class
name, simply press the Enter key inside the input field of the jar file location. SQL Workbench/J will then scan the
jar file(s) to find the JDBC driver

17.2. Syntax error when creating stored procedures

When creating a stored procedure (trigger, function) it is necessary to use a delimiter other than the normal semicolon
because SQL Workbench/J does not know if a semicolon inisde the stored procedure ends the procedure or simply a
single statement inside the procedure.

Therefor you must use an alternate delimiter when running a DDL statement that contains "embedded" semicolons. For
details please refer to using the alternate delimiter.

17.3. Timestamps with timezone information are not displayed correctly

When using databases that support timestamps or time data with a timezone, the display in SQL Workbench/J might not
always be correct, especially when daylight savings time (DST) is in effect.

This is caused by the handling of time data in Java and is usually not caused by the database, the driver or SQL
Workbench/J

If your time data is not displayed correctly, you might try to explicitely specify the timezone when starting the
application. This is done by passing the system property -Duser.timezone=XYZ to the application, where XYZ is
the timezone where the computer is located that runs SQL Workbench/J

The timezone should be specified relativ to GMT and not with a logical name. If you are in Germany and DST is active,
you need to use -Duser.timezone=GMT+2. Specifying -Duser.timezone=Europe/Berlin does usually
not work.

When using the Windows launcher you have to prefix the paramter with -J to identify it as a parameter for the Java
runtime not for the application.

17.4. Excel export not available

In order to write the proprietary Microsoft Excel format, additional libraries are needed. Please refer to Exporting Excel
files for details.

17.5. Out of memory errors
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The memory that is available to the application is limited by the Java virtual machine to ensure that applications don't
use all available memory which could potentially make a system unusable.

If you retrieve large resultsets from the database, you may receive an error message indicating that the application does
not have enough memory to store the data.

Please refer to Increasing the memory for details on how to increase the memory that is available to SQL Workbench/J

17.6. Display problems when running under Windows®

If you experience problems when running SQL Workbench/J (or other Java/Swing based applications) on the
Windows® platform, this might be due to problems with the graphics driver and/or the DirectDraw installation. If
upgrading the graphics driver or the DirectDraw/DirectX version is not an option (or does not solve the problem), try to
run SQL Workbench with the direct draw feature turned off:

java -Dsun.java2d.noddraw=true -jar sqlworkbench.jar

When using the exe launcher, you can use the following syntax:

SQLWorkbench -noddraw

If you run SQL Workbench/J through a program that enables remote access to a Windows® workstations (PC-Duo,
VNC, NetMeeting, etc), you may need to disable the use of DirectDraw for Java as well.

17.7. High CPU usage when executing statements

If you experience a high CPU usage when running a SQL statement, this might be caused by a combination of the
graphics driver, the JDK and the Windows® version you are using. This is usually caused by the animated icon which
indicates a running statement (the yellow smiley). This animation can be turned off in Tools » Options See Enable
animated icons for details. A different icon (not animated) will be used if that option is disabled.

17.8. Oracle Problems

17.8.1. Error: "Stream has already been closed"

Due to a bug in Oracle's JDBC driver, you cannot retrieve columns with the LONG or LONG RAW data type if the
DBMS_OUTPUT package is enabled. In order to be able to display these columns, the support for DBMS_OUTPUT has
to be switched off using the DISABLEOUT command before runnnig a SELECT statement that returns LONG or LONG
RAW columns.

17.8.2. BLOB support is not working properly

SQL Workbench/J supports reading and writing BLOB data in various ways. The implementation relies on standard
JDBC API calls to work properly in the driver. If you experience problems when updating BLOB columns (e.g. using
the enhanced UPDATE, INSERT syntax or the DataPumper) then please check the version of your Oracle JDBC
driver. Only 10.x drivers implement the necessary JDBC functions properly. The version of your driver is reported in
the log file when you make a connection to your Oracle server.

17.8.3. Table and column comments are not displayed
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By default Oracle's JDBC driver does not return comments made on columns or tables (COMMENT ON ..). Thus your
comments will not be shown in the database explorer.

To enable the display of column comments, you need to pass the property remarksReporting to the driver.

In the profile dialog, click on the Extended Properties button. Add a new property in the following window with the
name remarksReporting and the value true. Now close the dialog by clicking on the OK button.

Turning on this features slows down the retrieval of table information e.g. in the Database Explorer.

When you have comments defined in your Oracle database and use the WbSchemaReport command, then you have to
enable the remrks reporting, otherwise the comments will not show up in the report.

17.8.4. Time for DATE columns is not displayed

A DATE column in Oracle always contains a time as well. If you are not seeing the time (or just 00:00:00) for a date
column but you know there is a different time stored, please enable the option "Oracle DATE as Timestamp" in the
"Data formatting" section of the Options dialog (Tools » Options)

17.8.5. Content of XMLTYPE columns is not displayed

The content of columns with the data type XMLTYPE cannot be displayed by SQL Workbench/J because the Oracle
JDBC driver does not support JDBC's XMLType and returns a proprietary implementation that can only be used with
Oracle's XDB extension classes.

The only way to retrieve and update XMLType columns using SQL Workbench/J is to cast the columns to a CLOB
value e.g. CAST(xml_column AS CLOB) or to_clob(xml_column)

In the DbExplorer you can customize the generated SQL statement to automatically convert the XMLType to a CLOB.
Please refer to the chapter Customize data retrieval in the DbExplorer for details.

Note

17.8.6. Error: "missing mandatory parameter"

When running statements that contain single line comments that are not followed by a space the following
Oracle error may occur: ORA-01009: missing mandatory parameter [SQL State=72000, DB
Errorcode=1009].

--This is a comment
SELECT 42 FROM dual;

When adding a space after the two dashes the statement works:

-- This is a comment
SELECT 42 FROM dual;

This seems to be a problem with old Oracle JDBC drivers (such as the 8.x drivers). It is highly recommend to upgrade
the driver to a more recent version (10.x or 11.x) as they not only fix this problems, but are in general much better than
the old versions.

17.9. MySQL Problems
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17.9.1. INFORMATION_SCHEMA tables not displayed in DbExplorer

It seems that the necessary API calls to list the tables of the INFORMATION_SCHEMA database (which is a database,
not a schema - contrary to its name) are not implemented correctly in earlier JDBC drivers of MySQL. Only the driver
with the version 5.1.7 returns the list of tables of the INFORMATION_SCHEMA database.

17.9.2. "Operation not allowed" error message

In case you receive an error message "Operation not allowed after ResultSet closed" please
upgrade your JDBC driver to a more recent version. This problem was fixed with the MySQL JDBC driver version 3.1.
So upgrading to that or any later version will fix this problem.

17.9.3. Problems with zero dates with MySQL

MySQL allows the user to store invalid dates in the database (0000-00-00). Since version 3.1 of the JDBC driver, the
driver will throw an exception when trying to retrieve such an invalid date. This behaviour can be controlled by adding
an extended property to the connection profile. The property should be named zeroDateTimeBehavior. You
can set this value to either convertToNull or to round. For details see http://dev.mysql.com/doc/refman/4.1/en/
connector-j-installing-upgrading.html

17.9.4. Source SQL for views is not displayed

SQL Workbench/J retrieves the view definitioin from INFORMATION_SCHEMA.VIEWS. In some cases the column
VIEW_DEFINITION does not contain the view definition and thus the source cannot be displayed.

17.10. Microsoft SQL Server Problems

17.10.1. Can't start a cloned connection while in manual transaction mode

This error usually occurs in the DbExplorer if an older Microsoft JDBC Driver is used and the connection does not use
autocommit mode. There are three ways to fix this problem:

• Upgrade to a newer Microsoft driver (e.g. the one for SQL Server 2005)

• Enable autocommit in the connection profile

• Add the parameter ;SelectMethod=Cursor to your JDBC URL

This article in Microsoft's Knowledgebase gives more information regarding this problem.

The possible parameters for the SQL Server 2005 driver are listed here: http://msdn2.microsoft.com/en-us/library/
ms378988.aspx

17.10.2. Dealing with locking problems

Microsoft SQL Server (at least up to 2000) does not support concurrent reads and writes to the database very well.
Especially when using DDL statements, this can lead to database locks that can freeze the application. This affects
e.g. the display of the tables in the DbExplorer. As the JDBC driver needs to issue a SELECT statement to retrieve the
table information, this can be blocked by e.g. a non-committed CREATE ...  statement as that will lock the system
table(s) that store the meta information about tables and views.

http://dev.mysql.com/doc/refman/4.1/en/connector-j-installing-upgrading.html
http://dev.mysql.com/doc/refman/4.1/en/connector-j-installing-upgrading.html
http://www.microsoft.com/sql/technologies/jdbc/default.mspx
http://support.microsoft.com/?scid=kb;en-us;313181&x=9&y=11
http://msdn2.microsoft.com/en-us/library/ms378988.aspx
http://msdn2.microsoft.com/en-us/library/ms378988.aspx
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Unfortunately there is no real solution to blocking transactions e.g. between a SQL tab and the DbExplorer. One (highly
discouraged) solution is to run in autocommit mode, the other to have only one connection for all tabs (thus all of them
share the same transaction an the DbExplorer cannot be blocked by a different SQL tab).

The Microsoft JDBC Driver supports a connection property called lockTimeout. It is recommended to set that to
0 (zero) (or a similar low value). If that is done, calls to the driver's API will through an error if they encounter a lock
rather than waiting until the lock is released. The jTDS driver does not support such a property. If you are using the
jTDS driver, you can define a post-connect script that runs SET LOCK_TIMEOUT 0.

17.10.3. WbExport using a lot of memory

The jTDS driver and the Microsoft JDBC driver read the complete result set into memory before returning it to the
calling application. This means that when retrieving data, SQL Workbench/J uses (for a short amount of time) twice
as much memory as really needed. This also means that WbExport will effectively read the entire result into memory
before writing it into the output file. For large exports this us usually not wanted.

This behaviour of the drivers can be changed by adding an additional parameter to the JDBC URL that
is used to connect to the database. For the jTDS driver append useCursors=true to the URL, e.g.
jdbc:jtds:sqlserver://localhost:2068;useCursors=true.

The URL parameters for the jTDS driver are listed here: http://jtds.sourceforge.net/faq.html#urlFormat

For the Microsoft driver, use the parameter selectMethod=cursor to switch to a cursor based retrieval that does
not buffer all rows within the driver, e.g. jdbc:sqlserver://localhost:2068;selectMethod=cursor.

The URL parameters for the Microsoft driver are listed here: http://msdn2.microsoft.com/en-us/library/ms378988.aspx

17.11. DB2 Problems

17.11.1. "Connection closed" errors

When using the DB2 JDBC drivers it is important that the charsets.jar is part of the used JDK (or JRE).
Apparently the DB2 JDBC driver needs this library in order to correctly convert the EBCDIC characterset (used in the
database) into the Unicode encoding that is used by Java. The library charsets.jar is usually included in all multi-
language JDK/JRE installations.

If you experience intermittent "Connection closed" errors when running SQL statements, please verify that
charsets.jar is part of your JDK/JRE installation. This file is usually installed in jre\lib\charsets.jar.

17.11.2. XML columns are not displayed properly in the DbExplorer

The content of columns with the data type XML  are not displayed in the DbExplorer (but something like
com.ibm.db2.jcc.am.ie@1cee792 instead) because the driver does not convert them to a character datatype.
To customize the retrieval for those columns, please refer to the chapter Customize data retrieval in the DbExplorer.

When using a JDBC4 driver for DB2 (and Java 6), together with SQL Workbench/J build 107, XML content will be
displayed directly without the need to cast the result.

17.11.3. No error text is displayed

When running SQL statements in SQL Workbench/J and an error occurs, DB2 does not show a proper error
message. To enable the retrieval of error messages by the driver you have to set the extended connection property
retrieveMessagesFromServerOnGetMessage to true.

http://jtds.sourceforge.net/faq.html#urlFormat
http://msdn2.microsoft.com/en-us/library/ms378988.aspx
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The connection properties for the DB2 JDBC driver are documented here:

http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/index.jsp?topic=/com.ibm.db2.luw.apdv.java.doc/doc/
r0052038.html
http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/topic/com.ibm.db2.luw.apdv.java.doc/doc/r0052607.html
The example claims that this property is only needed for z/OS, but it works as described for LUW as well.

17.11.4. DB2 commands like REORG cannot be run

REORG, RUNSTATS and other db2 command line commands cannot be be run directly through a JDBC interface
because those are not SQL statements, but DB2 commands. To run such a command from with SQL Workbench/J you
have to use the function sysproc.admin_cmd(). To run e.g. a REORG on a table you have to run the following
statement:

call sysproc.admin_cmd('REORG TABLE my_table');

17.12. PostgreSQL Problems

17.12.1. WbExport using a lot of memory

The PostgreSQL JDBC driver defaults to buffer the results obtained from the database in memory before returning them
to the application. This means that when retrieving data, SQL Workbench/J uses (for a short amount of time) twice
as much memory as really needed. This also means that WbExport will effectively read the entire result into memory
before writing it into the output file. For large exports this us usually not wanted.

This behaviour of the driver can be changed so that the driver uses cursor based retrieval. To do this, the connection
profile must disable the "Autocommit" option, and must define a default fetch size that is greater than zero. A
recommended value is e.g. 10, it might be that higher numbers give a better performance. The number defined for
the fetch size, defines the number of rows the driver keeps in its internal buffer before requesting more rows from the
backend.

More details can be found in the driver's manual: http://jdbc.postgresql.org/documentation/83/query.html#query-with-
cursor

17.12.2. Getting the error: Current transaction is aborted

PostgreSQL - unlike other DBMS - marks a complete transaction as failed if a single statement fails. In such a case the
transaction cannot be committed, e.g. consider the following script:

INSERT INTO person (id, firstname, lastname) VALUES (1, 'Arthur', 'Dent');
INSERT INTO person (id, firstname, lastname) VALUES (2, 'Zaphod', 'Beeblebrox');
INSERT INTO person (id, firstname, lastname) VALUES (2, 'Ford', 'Prefect');
COMMIT;

As the ID column is the primary key, the third insert will fail with a unique key violation. In PostgreSQL you cannot
commit anyway and thus persist the first two INSERTs.

This problem can only be solved by using a SAVEPOINT before and after each statement. In case that statement fails,
the transaction can be rolled back to the state before the statement and the reminder of the script can execute.

Doing this manually is quite tedious, so you can tell SQL Workbench/J to do this automatically for you by setting the
properties:

workbench.db.postgresql.ddl.usesavepoint=true

http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/index.jsp?topic=/com.ibm.db2.luw.apdv.java.doc/doc/r0052038.html
http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/index.jsp?topic=/com.ibm.db2.luw.apdv.java.doc/doc/r0052038.html
http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/topic/com.ibm.db2.luw.apdv.java.doc/doc/r0052607.html
http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/topic/com.ibm.db2.luw.apdv.java.doc/doc/tjvjcerr.html
http://jdbc.postgresql.org/documentation/83/query.html#query-with-cursor
http://jdbc.postgresql.org/documentation/83/query.html#query-with-cursor
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workbench.db.postgresql.sql.usesavepoint=true

in the file workbench.settings. If this is enabled, SQL Workbench/J will issue a SET SAVEPOINT before running each
statement and will release the savepoint after the statement. If the statement failed, a rollback to the savepoint will be
issued that will mark the transaction as "clean" again. So in the above example (with sql.usesavepoint set to
true), the last statement would be rolled back automatically but the first two INSERTs can be committed (this will
also required to turn on the "Ignore errors" option is enabled).

If you want to use the modes update/insert or insert/update for WbImport, you should also add the
property:

workbench.db.postgresql.import.usesavepoint=true

to enable the usage of savepoints during imports. This setting also affects the WbCopy command.

You can also use the parameter -useSavepoint for the WbImport and WbCopy commands to control the use of
savepoints for each import.

Using savepoints can slow down the import substantially.

17.13. Sybase SQL Anywhere Problems

17.13.1. Columns with type nvarchar are not displayed properly

The jConnect driver seems to have a problem with nvarchar columns. The data type is not reported properly by the
driver, so the display of the table structure in the DbExplorer will be wrong for those columns.



SQL Workbench/J User's Manual

130

18. Options dialog
The options dialog enables you to influence the behaviour and look of SQL Workbench/J to meet your needs. To open
the options dialog choose Tools » Options.

18.1. General options

18.1.1. Language

With this option you can select in which language the application is shown. The new value will only be in affect when
you restart the application.

18.1.2. Check for updates

With this option you can enable an automatic update check when SQL Workbench/J is started. You can define the
interval in days after which the application should check for updates on the homepage. If a newer version is found on
the website this will be indicated with a little globe in the statusbar. Clicking on the icon will open your default internet
browser with the application's homepage.

If you disable this option, you can manually check for updates using the menu Help » Check for updates....

When SQL Workbench/J performs an update check, it sends the following information as part of the request to the
server:

• The version of SQL Workbench/J you are using

• Whether the check was an automatic check or a manual one

• The interface language selected

• The operating system as reported by your Java installation

• The Java version you are using

18.1.3. Show connect dialog

If this option is enabled, the connect dialog will be shown automatically when the application is started.

18.1.4. Exit on first connect cancel

If this option is enabled, then the application is closed completely if the initial connect dialog is cancelled.

This option is only valid if "Show connect dialog" is selected.

18.1.5. Single page HTML help

If this option is enabled, the HTML help will be shown as a single page in the browser instead of one page per chapter.

18.1.6. Encrypt passwords

If this option is enabled, the password stored within a connection profile will be encrypted. Whether the password
should be stored at all can be selected in the profile itself.

Using this option only supplies very limited security. As the source code for SQL Workbench/J is freely
available, the algorithm to decrypt the passwords stored in this way can easily be extracted to retrieve the plain
text passwords.
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18.1.7. Consolidate script log

Usually SQL Workbench/J reports the success and timings for each statement that is beeing executed in the message tab
of the current SQL panel. For large scripts this can slow down script execution dramatically. If this option is enabled,
only a summary of the execution is printed once the script has finished. You can turn off the log during script execution
by using the WBFEEDBACK command.

18.1.8. Show tab index

If this option is enabled, each editor tab will be shown with its index. You can then select the first 9 tabs by pressing
Ctrl-1, Ctrl-2 and so on.

18.1.9. Scroll tabs

This option controls the behaviour of the tab display, if more tabs are opened than can be displayed in the current width
of the window.

If this option is enabled, the tabs are always displayed in a single row. If too many tabs are open, the row can be
scrolled to the display the tabs that are not visible.

If this option is disabled, the tabs are displayed in multiple rows, so that all tabs are always visible.

18.1.10. Confirm tab close

If this option is enabled, closing a tab needs to be confirmed, to prevent accidental closing.

18.1.11. Enable animated icons

Enable or disable the use of an animated icons in the SQL editor to indicate a running SQL statement. It has been
reported, that the animated icon does have a severe (negativ) impact on the performance on some computers (depending
on JDK/OS/Graphics driver). If you experience a high CPU usage during the execution of SQL statements, or if you
find your SQL statements are running very slow, try to turn off the usage of the animated icons.

18.1.12. Log Level

With this option you can control the level of information written to the application log. The most verbose level is
DEBUG. With ERROR only severe errors (either resulting from running a user command or from an internal error) are
written to the application log.

When using Log4J as the logger, this will change the log level of the root logger.

18.1.13. Configuration file information

At the bottom of the "General options" page, the full filename of the configuration file and the logfile are listed.

18.2. Editor options

18.2.1. Line ending for DBMS

This property controls the line terminator used by the editor when sending SQL statements to the database. The value
"Platform default" relates to the platform where you run SQL Workbench/J this is not the platform of the DBMS server.
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The editor always uses "unix" line ending internally. If you select a different value for this property, SQL Workbench/
J will convert the SQL statements to use the desired line ending before sending them to the DBMS. As this can slow
down the execution of statements, it is highly recommended to leave the default setting of Unix line endings. You
should only change this, if your DBMS does not understand the single linefeed character (ASCII value 10) properly.

18.2.2. File format

This property controls the line terminator used when a file is saved by the editor. Changing this property affects the next
save operation.

18.2.3. Alternate Delimiter

This options defines the default alternate delimiter. You can override this default in the connection profile, to use
different delimiters for different DBMS. For details see using the alternate delimiter

18.2.4. History size

The number of statements per tab which should be stored in the statement history. Remember that always the full text of
the editor (together with the selection and cursor information) is stored in the history. If you have large amounts of text
in the editor and set this number quite high, be aware of the memory consumption this might create.

18.2.5. Files in history

If this option is enabled, the content of external files is also stored in the statement history.

18.2.6. Electric scroll

Electric scrolling is the automatic scrolling of the editor when clicking into lines close to the upper or lower end of the
editor window. If you click inside the defined number of lines at the upper or lower end, then the editor will scroll this
line into the center of the visible area. The default is set to 3, which means that if you click into (visible) line 1,2 or 3 of
the editor, this line will be centered in the display.

18.2.7. Editor tab width

The number of spaces that are assumed for the TAB character.

18.2.8. Additional word characters

The editor recognizes character sequences that consist of letters and characters only as "words". This influences the
way word by word jumping is done, or when selecting text using a doubleclick. Every character that is entered for this
option is considered a "word" character and thus does not mark a word boundary.

By putting e.g. an underscore into this field, the text MY_TABLE is recognized as a single word instead of two words
(which is the default).

18.2.9. Always allow "Execute Selected"

If this option is turned off, then SQL » Execute Selected will only work if text is selected in the editor. If this option is
turned on and no text is selected, the complete content of the editor will be executed.
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18.2.10. Allow empty lines as statement delimiter

When analysing statements in the editor, it is assumed that individual statements are separated with a semicolon. This
property controls if an empty line delimits a statement as well. This setting will be used to detect the current statement
for auto-completion and when using "Execute Current" inside the editor.

This does not influence the behaviour when running scripts in batch mode or when using the WbInclude
command.

18.2.11. Auto advance to next statement

If this option is enabled, then the cursor will automatically jump to the next statement in the script, when you execute
a single statement using Ctrl-Enter ("Run current statement"). This can also be toggled through the menu SQL » Auto
advance to next

For more information on how you can execute statements in the editor, please refer to Executing Statements

18.2.12. Highlight current statement

When running several statements (e.g. by using "Execute all") this option will highlight the current statement. The
editor will be scrolled to make sure the currently executed statement is visible.

18.2.13. Retain current statement highlight

If "Highlight current statement" is enabled and this option is turned on, the highlighting will be kept once execution has
finished.

18.2.14. Allow editing while executing

When running a statement, the editor is set to read-only in order to allow a consistent statement highlighting. When
this option is turned on, the text in the editor may be modified even if a statement is running. If the text in the editor is
modified during execution, statement and error highlighting will not be done any more.

18.2.15. Right click moves cursor

Normally a right click in the SQL editor does not change the location of the cursor (caret). If this option is checked,
then a right click will also change the caret's location (to where the mouse cursor is located)

18.2.16. Current directory follows active file

If this option is enabled, the file open dialog will default to the directory of the current file in the editor. If no file is
loaded in the editor, the directory that is defined through the "Default directory" option will be selected.

18.3. Editor colors

18.3.1. Current line color

If you want to highlight the line in which the cursor is located, specify the color for the highlighting. To disable the
highlight for the current line, simply "remove" the color selection by clicking on the remove button.

18.3.2. Selected text

The color that is used to highlight selected text.
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18.3.3. Error highlight color

When a statement is not executed correctly (and the DBMS signals an error) it is highlighted in the editor. With this
option you can select the color that is used to highlight the incorrect statement.

18.3.4. Syntax highlighting colors

You can change the colors for the different types of keywords in the editor.

18.4. Font settings

18.4.1. Editor font

The font that is used in the SQL editor. This font is also used when displaying the SQL source for tables and other
database objects in the DbExplorer.

18.4.2. Data font

The font that is used to display result sets. This includes the object list and results in the DbExplorer.

18.4.3. Message font

The font that is used in the message pane of the SQL window.

18.4.4. Standard font

The standard font that is used for menus, lables, buttons etc.

18.5. Auto-completion options

18.5.1. Paste completion in

With this option you can select how the selected object name from the code completion popup is pasted into the editor.
As is means, that the values will be inserted into the editor as it was retrieved from the database. This option will also
be used when SQL statements are generated internally (e.g. for updating the result set or when you export/copy data as
SQL statements)

18.5.2. Sort pasted columns by

When selecting to paste all (or several columns) from the popup window, you can select with this option, in which order
the columns should be written into the editor.

18.5.3. Close completion with search

When using the quicksearch feature in the code completion this option controls the behaviour when hitting the ESC
key. If this option is enabled, the ESC key will also close the popup window with the available choices. If this option is
disabled, the ESC key will only close the quicksearch input field.
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18.5.4. Sort entries in popup

If this is enabled, columns are sorted alphabetically in the popup. If not, they are listed in the order as they are returned
by the the database.

18.5.5. Quick search matches anywhere

If this option is enabled, the typed characters match anywhere in the object name. If this optioin is disabled, the object
name must start with the entered search value.

18.5.6. Filter by quicksearch

When this option is enabled, only those entries are shown in the popup that match the entered values in the quick
search.

18.6. Workspace options

18.6.1. Auto-Save workspace

If this option is enabled, the current workspace is saved each time you run a SQL statement.

18.6.2. Create workspace backup

If this option is enabled the current workspace file will be backed up, before saving the new workspace. You can
keep multiple versions of the workspace by supplying a number in the "Max. Backups" input field. If a value > 1 is
entered, saving the workspace will create a new "version" of the backup file. The versions will have the version number
appended (e.g. testdata.wksp.1, testdata.wksp.2 and so on). The most recent version is the one with the
highest number.

18.6.3. Workspace backup directory

By default the backups for the workspaces are stored in the same directory as the workspace file itself. If you want to
keep the (versioned) backups in a separate directory, you can specify it here.

If you specify a relative directory, it will be relative to the config directory.

18.6.4. Remember open files in workspace

You can customize how external files (that have been loaded using File » Open) are remembered in the workspace. You
can select three different options:

Content and filename When this option is selected, the filename that is loaded in the editor tab will be stored in the
workspace. The next time the workspace is loaded the file is opened as well. This is the default
setting

Content only When this option is selected, only the content of the editor tab is save (just like any other editor
tab), but the link to the filename is removed. The next time the workspace is loaded, the file
will not be opened.

Nothing Neither the content, nor the filename will be saved. The next time th workspace is loaded, the
editor tab will be empty.
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18.7. Options for displaying data

18.7.1. Sort Locale

When you sort the result set, characters values will be sorted case-sensitiv by default. This is caused by the
compareTo() method available in the Java environment which puts lower case characters in front of upper case
characters when sorting. With the "Sort Locale" option you can select which language rules should be applied while
sorting. Note that sorting with a locale is slower than using the "Default" setting.

18.7.2. Show selection summary in statusbar

If this option is enabled the number of selected rows in the result will be displayed in the status bar.

If you have a single numeric column selected (by holding down the Alt key while selecting with the mouse), the
statusbar will display the sum of the selected values.

18.7.3. Displaying multi-line values

SQL Workbench/J uses a special renderer for the contents of CLOB columns that is capable of displaying multiple lines
(i.e. honors newlines and linefeeds in the data retrieved from the database).

This multi-line renderer is usually not applied for VARCHAR columns. If your database stores text in VARCHAR
columns that contains line breaks, you can define a threshold for the length of the column. Any column that is defined
with a higher value will be displayed with a multiline renderer.

The default value of 250 means that a VARCHAR(250) column will be displayed with the multiline renderer. A
VARCHAR(210) will be displayed in a single line.

Using the multiline renderer has some minor drawbacks when editing the data, and is be a bit slower when displaying
large result sets.

The feature Adjust row height only works with multi-line fields.

18.7.4. Column width settings

Automatically adjust column widths

If this option is enabled, the widths of the result set columns are automatically adjusted to fit the largest value
(respecting the min. and max. size settings) after retrieving data. Note that you can manually optimize the column
widths using View » Optimize width for all columns.

Adjust to column headers

When calculating the optimal width for a column (either manually or if "Auto adjust column widths" is enabled, then
the column's label will be included in the width calculation if this option is enabled. If this option is disabled, and the
column contains very short values, the column width could be smaller than the column's label.

This option is also used when manually optimizing the column width,

Max. column width

When the initial display size of a column is calculated, or if you optimize the column widths to fit the actual data,
columns will not exceed this width. This is useful when displaying large character columns.
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Min. column width

When the initial display size of a column is calculated, or if you optimize the column widths to fit the actual data,
columns will not exceed this width.

18.7.5. Row height settings

Automatically adjust row height

If this option is enabled, the height of each column is automatically adjusted after data retrieval to display as many lines
of the column values (for character columns) as possible. Note that you can manually optimize the row height using
View » Optimize row height.

Not every (character) column is displayed in a manner that multiple lines will be displayed. The default setting is to
always display CLOB columns as multiline. VARCHAR (and CHAR) columns will only be displayed in multiline mode if
they can hold more than 250 characters. This limit can be changed.

Allow row height resizing

If this option is enabled, you can manually adjust the height of each row using the mouse. This option does not need to
be enabled in order to (automatically) optimize the row height.

Max. number of lines

When calculating the optimimal height for each row, the number of lines defined with this option will never be
exceeded.

18.7.6. Alternate row colors

If this option is selected, the rows in the data table will be displayed with alternating background color. You can choose
the alternate color (the other color is defined by the used Look & Feel) with the font chooser next to the checkbox.

18.7.7. Color for NULL values

If a color is defined, NULL values will be highlighted with the selected colors in the result set.

18.8. Options for formatting data

18.8.1. Date, timestamp and time formats

Define the format for displaying date, date/time (timestamp) and time columns in the result set. For details on the
format of this option, please refer to the documentation of the SimpleDateFormat class. This format is also used
when parsing input for date or timestamp fields, so if you enter a date while editing the data, make sure you enter it the
same way as defined with this option.

Here is an overview of the letters and their meaning that can be used to format the date and timestamp values. Be aware
that case matters!

Letter Description

G Era designator (Text, e.g. AD)

y Year (Number)

http://java.sun.com/javase/6/docs/api/java/text/SimpleDateFormat.html
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Letter Description

M Month in year (Number)

w Week in year (Number)

W Week in month (Number)

D Day in year (Number)

d Day in month (Number)

F Day of week in month (Number)

E Day in week (Text)

a AM/PM marker

H Hour in day (0-23)

k Hour in day (1-24)

K Hour in am/pm (0-11)

h Hour in am/pm (1-12)

m Minute in hour

s Second in minute

S Milliseconds

z General time zone (e.g. Pacific Standard Time; PST; GMT-08:00)

Z RFC 822 time zone (e.g. -0800)

18.8.2. Oracle DATE as TIMESTAMP

The Oracle DATE datatype includes the time as well. But the JDBC driver does not retrieve the time part of a DATE
column, so when retrieving DATE values, this would remove the time stored in the database. If this option is enabled,
SQL Workbench/J will treat Oracle's DATE columns as TIMESTAMP columns, thus preserving the time information.

18.8.3. Decimal symbol

The character which is used as the decimal separator when displaying numbers.

18.8.4. Decimal digits

Define the maximum number of digits which will be displayed for numeric columns. This only affects the display of
the number internally they are still stored as the DBMS returned them. To see the internal value, leave the mouse cursor
over the cell. The tooltip which is displayed will contain the number as it was returned by the JDBC driver. When
exporting data or copying it to the clipboard, the real value will be used.

18.9. Options for data editing

18.9.1. Confirm result set updates

When this option is enabled, the statements which are sent to the database when saving changes to result set table, are
displayed before execution. The update can be cancelled at that point if the statements are not correct. The generated
statements can also be saved to a file from that window.

The statement(s) that are displayed in the confirmation window can not be changed!
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18.9.2. Confirm discarding changed results

When running a statement that would replace a result that has changes that are not saved to the database, you will be
prompted whether you want to cancel the current operation that would discard those changes.

This applies to statements run in the editor, as well as to changes done in the Data tab of the DbExplorer.

You will not be prompted when running statements in the editor, when the option Append results is enabled.

18.9.3. Highlight required fields

When editing data either in the result set or in the data tab of the DbExplorer, fields that are set to NOT NULL in the
underlying table, will be displayed with a different background color if this option is selected.

18.9.4. Color for required fields

If required fields are highlighted during editing, this option defines the background color that is used.

18.9.5. Default PK Map

This property defines a mapping file for primary key columns. The information from that file is read whenever the
primary keys for a table of cannot be obtained from the database. For a detailed description on how to define extra
primary key columns, please refer to the WbDefinePk command.

18.9.6. Single record dialog

When displaying data in the Single record dialog you can customize the width for the input fields, and the default height
for multiline columns.

18.10. DbExplorer options

18.10.1. DB Explorer as Tab

The Database Explorer can either be displayed as a separate window or inside the main window as a another tab. If this
option is selected, the Db Explorer will be displayed inside the main window. If the option Retrieve DB Explorer is
checked as well, the current database scheme will be retrieved upon starting SQL Workbench/J

18.10.2. Automatically retrieve objects

If this option is enabled, the contents of the database schema is retrieved when the DB Explorer is displayed. If this
option is not checked, either the Refresh button or selecting a schema or table type will load the list.

18.10.3. Show trigger panel

By default triggers are shown only in the details of a table. If the option "Show trigger panel" is selected, an additional
panel will be displayed in the DbExplorer that displays all triggers in the database independently of their table.

18.10.4. Focus to data panel

When this option is selected, the focus inside the DbExplorer will be set to the data panel, after an object in the list has
been selected (and the data panel is visible).
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18.10.5. Show focus

When this option is selected, a rectangle indicating the currently focused panel will be displayed, to indicate the
component that will received keystrokes e.g. shortcuts such as Ctrl-R.

18.10.6. Generate PK constraint name

When displaying the SQL source for a table, a name will be generated for primary key constraint if the current
constraint has no name or a system generated name.

System generated names are identified using a regular expression that can be configured.

If this option is selected, the generated SQL will not reflect the real statement that was used to create the table!

18.10.7. Remember object type

The list of objects can be filtered with the dropdown. If the option "Remember object type" is selected, the current
object type will be stored in the workspace of the current connection, and will be restored the next time.

18.10.8. Remember sort column

When this option is selected, the sort column in the data display of the DbExplorer will be restored after reloading the
table data.

18.10.9. Remember column order

When you reorder the column in the data display of a table, enabling this option will automatically store the new
column order and apply it the next time the table data is displayed.

18.10.10. Default object type

If "Remember object type" is not enabled, you can define a default object type that is selected in the dropdown when
the DbExplorer is displayed initially.

18.10.11. Object details tabs

With this dropdown you can select the position of the details tabs (Columns, Source, Data etc).

18.11. Window Title

The title bar of the main window displays displays information about the current connection, workspace and editor file.
Some of these elements can be enabled or disabled with the options on this page.

18.11.1. Application name at end

If this option is enabled, the Application name will be put at the end of the window title.

18.11.2. Show Workspace name

If this option is enabled, the currently loaded workspace name will be displayed in the main window's title.
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18.11.3. Show Profile Group

If this option is enabled, the group of the current connection profile will be displayed in the main window's title. The
name of the current connection profile will always be shown.

18.11.4. Enclose Group With

If you select to display the current profile's group, you can select a pair of characters to put around the group name.

18.11.5. Separator

If you select to display the current profile's name and group, you can select the character that separates the two names.

18.11.6. Editor Filename

If the current editor tab contains an external file, you can choose if and which information about the file should be
displayed in the window title. You can display nothing, only the filename or the full path information about the current
file. The information will be displayed behind the current profile and workspace name.

18.12. SQL Formatting

These options influence the behaviour of the SQL Formatter when reformatting a SQL statement in the editor.

18.12.1. Max. length for sub-select

When the SQL formatter hits a sub-SELECT while parsing it will not reformat any statement which is shorter then the
length specified with this option, i.e. any sub-SELECT shorter then this value will be formatted as one single statement
without line breaks or indention. See SQL Formatter for details on how the SQL formatting works.

18.12.2. Columns in SELECT

This property defines the number of columns the formatter puts in on line when formatting a SELECT statement. The
default of 1 (one) will put each column into a separate line:

SELECT p.name,
       p.firstname,
       a.city,
    a.zip
FROM person p JOIN address a ON (p.person_id = a.person_id);

If this is set to 2, this would result in the following formatted SELECT:

SELECT p.name, p.firstname,
       a.city, a.zip
FROM person p JOIN address a ON (p.person_id = a.person_id);

The above example would list all columns in a single line, if this option is set to 4 (or a higher value):

SELECT p.name, p.firstname, a.city, a.zip
FROM person p JOIN address a ON (p.person_id = a.person_id);
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18.12.3. Columns in INSERT

This property defines the number of columns the formatter puts in on line when formatting an INSERT statement. A
value of one will list each column in a separate line in the INSERT part and the VALUES part

INSERT INTO PERSON
(
  id,
  firstname,
  lastname
)
VALUES
(
  42,
  'Arthur',
  'Dent'
);

When setting this value to 2, the above example would be formatted as follows:

INSERT INTO PERSON
  (id, firstname,
   lastname)
VALUES
  (42, 'Arthur',
   'Dent');

18.12.4. Columns in UPDATE

This property defines the number of columns the formatter puts in on line when formatting an UPDATE statement. A
value of 1 (one) will put each column into a separate line:

UPDATE person
   SET firstname = 'Arthur',
       lastname = 'Dent'
WHERE id = 42;

With a value of 2, the above example would be formatted as follows:

UPDATE person
   SET firstname = 'Arthur', lastname = 'Dent'
WHERE id = 42;

18.12.5. Quoted elements per line

This optioin is used when changing the selected text into elements suitable for an IN list using SQL » Create SQL List.
The number of values that are kept on a single line is controlled with this option.

18.12.6. Other elements per line

This option defines how many values will be put into a single line when creating non-quoted elements (Create non-char
SQL List).



SQL Workbench/J User's Manual

143

18.12.7. Lowercase functions

If this option is selected, standard ANSI functions will converted to lowercase when formatting a SQL statement.

18.12.8. Uppercase keywords

If this option is selected, standard ANSI keywords (SELECT, UPDATE) will converted to uppercase when formatting
a SQL statement, otherwise they will be converted to lowercase.

18.13. SQL Generation

18.13.1. Generated UPDATE statements

If formatting of UPDATE statements is enabled, the threshold defines how many columns have to be present for a single
UPDATE statement in order to put each column into a separate line. If the number of columns is lower then this value
they will remain on one line. The keywords (UPDATE, WHERE) will still be formatted into new lines.

18.13.2. Generated INSERT statements

If formatting of INSERT is enabled, the way they are formatted can be controlled with several values.

Column threshold

If the number of columns in the statement exceeds this value, the columns will be spread over several lines. The number
of columns that are put into each line is controlled using the option "Columns per line".

Columns per line

If the number of columns in the option "Column threshold" is exceeded, this option controls how many columns are put
into each line

18.13.3. Include owner in export

This setting controls whether SQL Workbench/J uses the onwer (schema) when creating SQL scripts during exporting
data (through WbExport or "Save as"). When this option is selected, the usage of the schema depends on the ignore
schema setting that controls ignoring certain schemas for specific DBMS. When this is option is not selected, the
schema/owner will never be used for SQL scripts.

18.13.4. Date literals for clipboard

Defines the date literal format to be used when copying data as SQL statements to the clipboard. For a detailed
description of the different formats please refer to the WbExport description. This option does not influence the default
format used by the WbExport command.

When you copy data as "Text" (tab-separated) to the clipboard, the date and timestamp format from the general
options is used.

18.13.5. Date literals for WbExport

Defines the date literal format to be used for the WbExport command. The value of this option is used if the -
sqlDateLiterals switch is not supplied when running WbExport. This default value is reported when
WbExport is executed without parameters.
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18.13.6. Date literals for WbDataDiff

Defines the date literal format to be used for the WbDataDiff command. The value of this option is used if the -
sqlDateLiterals switch is not supplied when running WbDataDiff. This default value is reported when
WbDataDiff is executed without parameters.

18.14. External tools

On this page, you can define external tools (programs). Currently the only place where this is used, is in the BLOB info
dialog, to open the BLOB data with one of the defined external tools.

This could be a program to display images, OpenOffice to display office documents or a text editor to display text files.

You do not need to define the PDF Reader here, as the definition from the general options will automatically be used in
the BLOB info dialog.

18.15. Look and Feel

If you want to use additional Look and Feels that are not part of the JDK, you can specify them here.

A Look And Feel definition consists of a name, the class name to be used and the location of the JAR file that provides
the look and feel implementation. The class name that has to be used should be available in the documentation of
the look and feel of your choice. The name is SQL Workbench/J internal and is only used when displaying the list of
available Look and Feels.

The current look and feel is only changed when you click on the Make current button. Simply selecting a
different entry in the list on the left side will not change the look and feel.

When you switch the current Look & Feel, you will need to restart the application to activate the new look and feel.
Note that if you switch the current Look & Feel it will be changed, regardless whether you close the options dialog
using Cancel or OK.

http://www.openoffice.org
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19. Configuring keyboard shortcuts

You can configure the keyboard shortcut to execute a specific action (=menu item) in the dialog which is displayed
when you select Tools » Configure shortcuts.... The dialog lists the available actions together with their configured
shortcut and their default shortcut.

19.1. Assign a shortcut to an action

To assign a (new) keyboard combination for a specific action, select (highlight) the action in the list and click on the
Assign button. A small window will pop up, where you can press the key combination which you would like to assign
to that action. Note that only F-Keys (F1, F2, ...) can be used without a modifier (Shift, Control, Alt). All other keys
need be pressed together with one of the modifier keys.

After you have entered the desired keyboard shortcut, press the OK button. If the shortcut is already assigned to a
different action, you will be prompted, if you want to override that definition. If you select to overwrite the shortcut for
the other action, that action will then have no shortcut assigned

19.2. Removing a shortcut from an action

To remove a shortcut completely from an action, select (highlight) that action, and click on the Clear button. Once the
shortcut has been cleared, the action is no longer accessible through a shortcut (only through the menu).

19.3. Reset to defaults

If you want to reset the shortcut for a single action to its default, select (highlight) the action in the list, and click on the
Reset button. To reset all shortcuts click on the Reset all button.
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20. Advanced configuration options

This section describes the additional options for SQL Workbench/J which are not (yet) available in the options dialog.

The name of the setting refers to the entry in the file workbench.settings which is located in the configuration
directory. Not all listed properties will be present in workbench.settings. In this case, simply create a new line
with the property name and the value as described here. The position where you add this entry does not matter.

Every property can also be specified on the commandline when starting SQL Workbench/J by setting a system
property with that name using the -Dworkbench.property=value switch. When using one of the
Windows launchers (.exe) you have to use -J-Dworkbench.property=value. See the section about
Java options in the description of the Windows launcher.

20.1. Database Identifier

Some parameters are used such that a list of "Database Identifiers" is expected. The identifier that needs to be put there
can be obtained by hovering the mouse over the connection URL information in the main window, or from the log file.
After a successful connect to a database, there will be an entry in the log file similar to this:

INFO  15.08.2004 10:24:42 Connected to: [HSQL Database Engine]

If the description for a property in this chapter refers to a "Database Identifier", the text between (but not including) the
square brackets has to be used.

20.2. DBID

For some settings, where the ID is part of the property's key, a "clean" version of the Database Identifer, called the
DBID, is used. This DBID is displayed in the connection info dialog (right click on the connection URL in the main
window, then choose "Connection Info").

The DBID is also reported in the log file:

INFO  15.08.2004 10:24:42 Using DBID=hsql_database_engine

If the description for a property in this chapter refers to the "DBID", then this value has to be used.

If the DBID is part of a property key this will be referred to as [dbid] in this chapter.

20.3. GUI related settings

Showing accelerator in menu

Property: workbench.gui.showmnemonics

Possible values: true, false

Usually the mnemonic (aka. Accelerator) for a menu item is not shown under Windows 2000 or later. It will only be
shown, when you press the ALT key. With this settings, this JDK behaviour can be controlled.

Default: true

Controlling the type of print dialog

Property: workbench.print.nativepagedialog
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Possible values: true, false

When printing the contents of a table, this settings controls the type of print dialog to be used. The default setting will
open the native print dialog of the operating system. If you experience problems when trying to print, set this property
to false. SQL Workbench/J will then open a cross-platform print dialog.

Default value: true

20.4. Editor related settings

Include Oracle public synonyms in auto-completion of tables

Property: workbench.editor.autocompletion.oracle.public_synonyms

Possible values: true, false

When using auto completion for table columns and table names, Oracle's public synonyms are not included by default.
This has two reasons: first, the author believes that public synonyms shouldn't be used (it's just as bad as global
variables in programming) and second, Oracle defines a huge number of public synonyms that would make the popup
with all available tables very long and hard to use. Setting this property to true, will include public synonyms in the
popup. Please refer to filtering synonyms for details on how to filter out unwanted synonyms from this list.

Default value: false

Set the modifier key for rectangular selections in the edior

Property: workbench.editor.rectselection.modifier

These properties control the modifier key that needs to be pressed to enable rectangular selections in the editor. Possible
values are alt for setting the Alt key as the modifier, or ctrl for setting the Ctrl key as the modifier.

Default value: alt

Default file encoding

Property: workbench.file.encoding

Several internal commands use an encoding when writing external text files (e.g. WbExport). If no encoding is
specified for those commands, the default platform encoding as reported by the Java runtime system is used. You can
overwrite the default encoding that Java assumes by setting this property.

Default value: empty, the Java runtime default is used

Limitting size of the text put into the history

Property: workbench.sql.history.maxtextlength

When you execute a SQL statement in the editor, the current content of the editor is put into the history buffer. If you
are editing large scripts, this can lead to memory problems. This property controls the max. size of the editor text that is
put into the history.

If the current editor text is bigger than the size defined in this property the text is not put into the history.

Default value: 10485760 (10MB)
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Controlling newlines in code snippets

Property: workbench.clipcreate.includenewline

Possible values: true, false

When creating a Java code snippet, the newlines inside the editor are preserved by putting a \n character into the String
declaration. Setting this property to false, will tell SQL Workbench/J not put any \n characters into the Java string.

Default: true

Controlling the concatenation character for code snippets

Property: workbench.clipcreate.concat

When creating a Java code snippet, each line is concatenated using the standard + operator. If your programming
language uses a different concatenation character (e.g. &), this can be changed with this property.

Default: +

Controlling the prefix for code snippets

Property: workbench.clipcreate.codeprefix

When creating a Java code snippet, this is prefixed with String sql = . With this property you can adjust this
prefix.

Default: String sql =

20.5. DbExplorer Settings

Controlling data display in the DbExplorer

Property: workbench.db.objecttype.selectable.[dbid]=value1,value2,...

The DbExplorer makes the "data" tab available based on the type of the selected object in the object list (second
column). If the type returned by the JDBC driver is one of the types listed in this property, SQL Workbench/J assumes
that it can issue a SELECT * FROM to retrieve data from that object.

Default values:

.defaultt=view,table,system view,system table

.postgresql=view,table,system view,system table,sequence

.rdb=view,table,system,system view
The values in this property are not case-sensitiv (TABLE is the same as table)

Customizing the SELECT to be used for the data tab

You can customize the generated SELECT that is used to display the table data depending on the column type. Please
refer to the DbExplorer chapter for details.

Customizing columns that can be searched

Property: workbench.db.[dbid].datatypes.searchable
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DbExplorer's "Search table data" feature only includes columns with the datatypes CHAR and VARCHAR into the
WHERE clause for searching.

Some database systems allow CLOB columns to be searched using a LIKE expression as well. This property can be
used to list all datatypes that can be used in a LIKE condition.

Default values:

For PostgreSQL: text
For MySQL: longtext,tinytext,mediumtext

Microsoft SQL Server extended property for remarks

Property: workbench.db.microsoft_sql_server.remarks.propertyname

Defines the name of the extended property that is queried in order to retrieve table or column remarks for SQL Server.

SQL Workbench/J will use the table function fn_listextendedproperty  to retrieve the extended property defined by this
configuration setting to retrieve remarks.

Default value: MS_DESCRIPTION

Displaying table comments for MySQL

Property: workbench.db.mysql.tablecomments.retrieve

By default the MySQL JDBC driver does not return comments defined on tables. If you use table comments, you can
enable their display by setting this property to true. This might also show comments generated by MsSQL itself.

Default value: false

Retrieving remarks for Microsoft SQL Server

Property:

workbench.db.microsoft_sql_server.remarks.object.retrieve
workbench.db.microsoft_sql_server.remarks.column.retrieve

Enables/disables the retrieval of extended properties as a replacement for the standard SQL COMMENT ON ...
capability.

SQL Workbench/J will use SQL Server's fn_listextendedproperty  table function to retrieve table or column remarks.
As this can have a performance impact on the retrieval of tables or columns, this retrieval can be disabled using this
configuration setting.

Default value: true for both properties

20.6. Database related settings

Automatically connect the DataPumper

Property: workbench.datapumper.autoconnect

When opening the DataPumper it will connect to the current profile as the source connection. If you do not want the
DataPumper to connect automatically set this property to false

http://msdn.microsoft.com/en-us/library/ms179853%28SQL.90%29.aspx
http://msdn.microsoft.com/en-us/library/ms179853%28SQL.90%29.aspx
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Default: true

Controlling COMMIT for DDL statements

Property workbench.db.[dbid].ddlneedscommit

Possible values: true, false

Defines if the DBMS supports transactional DDL (CREATE TABLE, DROP TABLE, ...)

Default: false

COMMIT/ROLLBACK behaviour

Property: workbench.db.[dbid].usejdbccommit

Possible values: true, false

Some DBMS return an error when COMMIT or ROLLBACK is sent as a regular command through the JDBC interface. If
the DBMS is listed here, the JDBC functions commit() or rollback() will be used instead.

Default: false

Generating constraints for SQL source

Property: workbench.db.inlineconstraints

This setting controls the generation of the CREATE TABLE source in the DbExplorer. This is a comma separated list of
Database Identifiers that only support defining primary and foreign keys inside the CREATE TABLE statement.

If a DBMS is not listed here, the table constraints will be re-created using ALTER TABLE.

Default: FirstSQL/J

Case sensitivity when comparing values

Property workbench.db.[dbid].casesensitive

Possible values: true, false

The search panel of the DbExplorer highlights matching values in the result tables. The highlighter needs to know
whether string comparisons in the database are case sensitive in order to highlight the correct values.

Default: false

Definining SQL commands that may change the database

Property: workbench.db.updatingcommands for general SQL statements

Property: workbench.db.[dbid].updatingcommands for DBMS specific update statements

When enabling the read only or confirm update option in a connection profile, SQL Workbench/J assumes a default
set of SQL commands that will change the database. With this property you can add additional keywords that should
be considered as "updating commands". This is a comma separated list of keywords. The keywords may not contain
whitespace.
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No default

Database switch in DbExplorer

Property: workbench.dbexplorer.switchcatalog

When connected to a DBMS that supports multiple databases (catalogs) for the same connection, the DbExplorer
displays a dropdown list with the available databases. Switching the selected catalog in the dropdown will trigger a
switch of the current catalog/database if the DbExplorer uses its own connection. If you do not want to switch the
database, but merely apply the new selection as a filter (which is always done, if the DbExplorer shares the connection
with the other SQL panels) set this property to false.

Default: true

Filtering tables

Property: workbench.db.[dbid].exclude.tables

Whenever SQL Workbench/J retrieves a list of tables (e.g. the DbExplorer, auto completion, WbSchemaReport) certain
tables can be filtered out by supplying a regular expression in this property. The default setting will filter Oracle tables
that reside in the "Recycle bin". This setting can be applied on a per DBMS basis

Default value: workbench.db.oracle.exclude.tables=^BIN\\$.*

Note that you need to use two backslashes in the RegeEx.

URL for online manual

Property: workbench.db.[dbid].manual

This defines the URL of the online manual for that DBMS. This URL is shown in the browser when using the menu
item: Help » DBMS Manual will display the

Filtering synonyms

Property: workbench.db.[dbid].exclude.synonyms

The database explorer and the auto completion can display (Oracle public) synonyms. Some of these are usually not
of interest to the end user. Therefor the list of displayed synonyms can be controlled. This property defines a regular
expression. Each synonym that matches this regular expression, will be excluded from the list presented in the GUI.

Default value (for Oracle): ^AQ\\$.*|^MGMT\\$.*|^GV\\$.*|^EXF\\$.*|^KU\\$_.*|^WM\\$.*|
^MRV_.*|^CWM_.*|^CWM2_.*|^WK\\$_.*|^CTX_.*

Note that you need to use two backslashes in the RegeEx.

Support for Oracle materialized views (snapshots)

Property: workbench.db.oracle.detectsnapshots

When displaying the list of tables in the database explorer Oracle materialized views (snapshots) are identified as tables
by the Oracle JDBC driver. To identify a specific "table" as a materialized view, a second request to the database is
necessary (accessing the system view ALL_MVIEWS). As this request can slow down the retrieval performance, this
feature can be turned off. If for any reason the ALL_MVIEWS view cannot be accessed, this feature will be turned off
until you re-connect to the database.
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Default value: true

Fix type display for VARCHAR columns in Oracle

Property: workbench.db.oracle.fixcharsemantics

The Oracle driver does not report the size of VARCHAR2 columns correctly if the character semantic has been set
to "char". The JDBC driver always returns the length in bytes. When this property is set to true, the length for those
columns will be displayed correctly in the DbExplorer. As this means SQL Workbench/J is using it's own query to
retrieve the table definition, this might not always yield the same results as the original statement from the Oracle
driver. If your table definitions are not displayed correcly, set this value to false so that the original driver methods
are used. The statement used by SQL Workbench/J is a bit faster then then original Oracle statement, as it does not use
a LIKE predicate (which is required to comply with the JDBC specs).

Default value: true

Fix type display for NVARCHAR2 columns in Oracle

Property: workbench.db.oracle.fixnvarchartype

The Oracle driver does not report the type of NVARCHAR2 columns correctly. They are returned as Types.OTHER.
If this property is enabled, than SQL Workbench/J is also using it's own SELECT statement to retrieve the table
definition.

Default value: true

Defining a base directory for JDBC libraries

Property: workbench.libdir

A directory that contains the .jar files for the JDBC drivers. The value of this property can be referenced using
%LibDir% in the driver's definition. The value for this can also be specified on the commandline.

No default

Defining keywords for date or timestamp input

Property: workbench.db.keyword.current_date

The "literals" that are accepted for DATE columns to identify the current date. Default values are current_date,
today

Property: workbench.db.keyword.current_timestamp

The "literals" that are accepted for TIMESTAMP columns to identify the current date/time. Default values are
current_timestamp,sysdate,systimestamp

Property: workbench.db.keyword.current_time

The "literals" that are accepted for TIME columns to identify the current time. Default values are current_time,
now

Use Savepoints to guard DML statement execution

Property: workbench.db.[dbid].sql.usesavepoint



SQL Workbench/J User's Manual

153

Possible values: true, false

Some DBMS (such as PostgreSQL) cannot continue inside a transaction when an error occurs. A script with multiple
DML statements can therefor not run completely if one statement fails, even if you choose to ignore the error. If this
property is set to true, SQL Workbench/J will set a savepoint before executing a DML statement (SELECT, INSERT.
In case of an error the savepoint will be rolled back and the transaction can continue.

Default value: false

Use Savepoints to guard DDL statement execution

Property: workbench.db.[dbid].ddl.usesavepoint

Possible values: true, false

Some DBMS (such as PostgreSQL) cannot continue inside a transaction when an error occurs. A script with multiple
DDL statements can therefor not run completely if one statement fails, even if you choose to ignore the error. If this
property is set to true, SQL Workbench/J will set a savepoint before executing a DDL statement. In case of an error the
savepoint will be rolled back and the transaction can continue.

Default value: false

Use Savepoints for update/insert mode for WbImport

Property: workbench.db.[dbid].import.usesavepoint

Possible values: true, false

Some DBMS (such as PostgreSQL) cannot continue inside a transaction when an error occurs. When running
WbImport in update,insert or insert,update mode, the first of the two statements needs to be rolled back
in order to be able to continue the import. If this property is set to true, SQL Workbench/J will set a savepoint before
executing the first (insert or update) statement. In case of an error the savepoint will be rolledback and WbImport will
try to execute the second statement.

Default value: false

Ignore errors during data retrieval

Property: workbench.db.ignore.readerror

Possible values: true, false

When retrieving data (e.g. using a SELECT statement) errors that are reported by the driver will be displayed to the
user. The retrieval will be terminated. If you want to ignore errors and replace the data that could not be retrieved with a
NULL value, set this property to true.

Using this parameter is not recommended as it might produce results that do not reflect the data as it is stored in the
database.

Default value: false

Customizing data type mapping

Property: workbench.db.[dbid].typemap
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When using the -createTarget parameter for WbCopy, the type mapping from the JDBC driver might not be
sufficient or correct. With this setting you can define your own type mapping for a specific dbms. The entry is a list of
mappings that map the numeric value of a JDBC datatype (as defined in java.sql.Types) to a real data type name for the
DBMS. The numeric JDBC datatype value and the DBMS specific datatype name are separated with a colon. Each pair
is separated by a semicolon.

The following entry maps the JDBC datatype with the value 3 (NUMERIC) to the target datatype double and the
value 2 (BIGINT) to the target type NUMBER. The NUMBER datatypes needs uses two parameter placeholders
$size and $digits. The last mapping maps the JDBC value -1 (LONGVARCHAR) to the DBMS type VARCHAR
using only the $size parameter

workbench.db.[some_db].typemap=3:DOUBLE;2:NUMBER($size,$digits);-1:VARCHAR($size)

JDBC 4.0 defines the following constants:

• BIGINT = -5
• BINARY = -2
• BIT = -7
• BLOB = 2004
• BOOLEAN = 16
• CHAR = 1
• NCHAR = -15
• CLOB = 2005
• NCLOB = 2011
• DATE = 91
• DECIMAL = 3
• DOUBLE = 8
• FLOAT = 6
• INTEGER = 4
• LONGVARBINARY = -4
• LONGVARCHAR = -1
• LONGNVARCHAR = -16
• NUMERIC = 2
• REAL = 7
• SMALLINT = 5
• TIME = 92
• TIMESTAMP = 93
• TINYINT = -6
• VARBINARY = -3
• VARCHAR = 12
• NVARCHAR = -9
• ROWID = -8
• SQLXML = 2009

20.7. SQL Execution related settings

Maximum script size for in-memory script execution

Property: workbench.sql.script.inmemory.maxsize

This setting controls the size up to which files that are executed in batch mode or via the WbInclude command are read
into memory. Files exceeding this size are not read into memory but processed statement by statement. When a file is
not read into memory the automatic detection of the alternate delimiter does not work any longer. The size is given in
bytes.

http://java.sun.com/javase/6/docs/api/java/sql/Types.html
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Default: 1048576

Ignoring certain SQL commands

Property: workbench.db.ignore.[dbid]

For a DBMS identifier you can define a list of commands that are simply ignored by SQL Workbench/J. This is useful
e.g. for Oracle, when you want to run scripts that are intended for SQL*Plus. If those scripts contain special SQL*Plus
commands (that are not understood by the Oracle server as SQL*Plus executes these commands directly) they would
fail in SQL Workbench/J. If those commands are simply ignored and not send to the server, the scripts can run without
modification.

Default: workbench.db.ignore.oracle=prompt,exit,whenever

Enabling short WbInclude

Property: workbench.db.supportshortinclude

By default the WbInclude command can be shortened using the @ sign. This behaviour is disabled for MS SQL to
avoid conflicts with parameter definitions in stored procedures. This property contains a list of DBIDs for which this
should be enabled. To enable this for all DBMS, simply use * as the value for this property.

Default: oracle, rdb, hsqldb, postgresql, mysql, adaptive_server_anywhere,
cloudscape, apache_derby

Check for single line commands without delimiter

Property: workbench.db.checksinglelinecmd

When parsing a SQL script, SQL Workbench/J supports statements that are put into a single line without a delimiter.
This is primarily intended for compatibility with Oracle's SQL*Plus and is not enabled for other database systems.

Default: oracle

20.8. Default settings for Export/Import

For some switches of the WbExport and WbImport command, you can override the default values used by SQL
Workbench/J in case you do not provide the parameter. The default values mentioned in this chapter apply, if no
property is defined in the workbench.settings file. The current default for these properties is displayed in the
help message when you run the corresponding command without any parameters.

Controlling header lines in text exports

Property: workbench.export.text.default.header

Possible values: true, false

This property controls whether default value for the -header parameter of the WbExport command.

Default: false

Controlling XML export format

Property: workbench.export.xml.default.verbose
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Possible values: true, false

This property controls whether XML exports are done using verbose XML or short tags and only basic formatting. This
property sets the default value of the -verbosexml parameter for the WbExport command.

Default: true

Setting default for WbImport's -continueOnError parameter

Property: workbench.import.default.continue

Possible values: true, false

This property controls the default value for the parameter -continueOnError of the WbImport command.

Default: false

Setting a default for WbImport's -header parameter

Property: workbench.import.default.header

Possible values: true, false

This property controls the default value for the parameter -header of the WbImport command.

Default: true

Setting a default for WbImport's -multiLine parameter

Property: workbench.import.default.multilinerecord

Possible values: true, false

This property controls the default value for the parameter -multiLine of the WbImport command.

Default: false

Setting a default for WbImport's -trimValues parameter

Property: workbench.import.default.trimvalues

Possible values: true, false

This property controls the default value for the parameter -trimValues of the WbImport command.

Default: false

20.9. Controlling the log file

When SQL Workbench/J initializes the logging environment, it also adds two system property that can be used to define
the logfile relative to the configuration or the installation directory:

• workbench.config.dir contains the full path to the configuration directory
• workbench.install.dir contains the full path to the directory where sqlworkbench.jar is located

These properties can be used to put the logfile into the directory relative to the config or installation directory without
the need to hardcode the directory name.
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20.9.1. Configure internal logging

Log file location

Property: workbench.log.file

Defines the location of the logfile. By default, the file will be named workbench.log and will be written into the
configuration directory.

Log level

Property: workbench.log.level

Set the log level for the log file. Valid values are

• DEBUG
• INFO
• WARN
• ERROR

Default: INFO

Log format

Property: workbench.log.format

Define the elements that are included in log messages. The following placeholders are supported:

• {type}
• {timestamp}
• {message}
• {error}
• {source}
• {stacktrace}

This property does not define the layout of the message, only the elements that are logged.

If the log level is set to DEBUG, the stacktrace will always be displayed even if it is not included in the format string.

If you want more control over the log file and the format of the message, please switch the logging to use Log4J.

Default: {type} {timestamp} {message} {error}

Logging to the console

Property: workbench.log.console

Defines whether SQL Workbench/J logs messages additionally to the standard error output

Default: false

Logging SQL used for retrieving metadata

Property: workbench.dbmetadata.logsql

If this is set to true the SQL queries used to retrieve DBMS specific meta data (such as view/procedure/trigger source,
defined triggers/views) will be logged with level INFO.

This can be used to debug customized SQL statements for DBMS's which are not (yet) preconfigured.
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Default: false

20.10. Configure Log4J logging

20.10.1. Turn on Log4J logging

Property: workbench.log.log4j

If you need more control over the logfile (e.g. for batch processing) you can delegate logging to Log4j. You can turn on
Log4j logging in two different ways:

• The value of the property is true
• The value of the property points to an existing file

If you just pass true as the value for this property, the Log4j configuration file must be accessible to Log4j through
the usual ways (please refer to the Log4j manual for details). If you specify a configuration file, this will be "passed" to
Log4j by setting the system property log4j.configuration to contain the correct "file URL" needed by Log4j.

When passing a configuration file through this property, you can use a system property as part of the filename (e.g.
${user.home}/sqlworkbench.log). If the filename denotes a relative filename (e.g. log4j.xml without any
path information), then it is assumed to be relative to the configuration directory.

When you turn on Log4J logging, you must copy copy the Logg4J library as log4j.jar into the directory where
sqlworbkench.jar is located. Do not include the version number in the filename.

The jar file must be named log4j.jar

If the Log4J classes are not found, the built-in logging will be used (see above)

When Log4J logging is enabled, none of the logging properties described in the previous section will be used. You have
to configure everything through log4j.xml.

When using Help » Show log file with Log4J enabled, and you have configured Log4J to write to multiple files, only
the first file will be shown.

When SQL Workbench/J initializes the logging environment, it also adds two system property that can be used to define
the logfile relative to the configuration or the installation directory:

• workbench.config.dir contains the full path to the configuration directory
• workbench.install.dir contains the full path to the directory where sqlworkbench.jar is located

These properties can be used to put the logfile into the directory relative to the config or installation directory without
the need to hardcode the directory name in log4j.xml

A sample log4j.xml can be found in the scripts directory of the SQL Workbench/J distribution.

The system properties that are set by SQL Workbench/J to point to the configuration and installation directory (see
above) can also be used in the log4j.xml file.

20.11. Settings related to SQL statement generation

Controlling schema usage in generated SQL statements

Property: workbench.sql.ignoreschema.[dbid]=schema1,...
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Define a list of schemas that should be ignored for the DB ID When SQL Workbench/J creates DML statements and the
current table is reported to belong to any of the schemas listed in this property, the schema will not be used to qualify
the table. To ignore all schemas use a *, e.g. workbench.sql.ignoreschema.rdb=*. In this case, table names
will never be prefixed with the schema name reported by the JDBC driver. The values specified in this property are case
sensitiv.

Note that for Oracle, tables that are owned by the current user will never be prefixed with the owner.

Default values:

.oracle=PUBLIC

.postgresql=public

.rdb=*

Defining CREATE TABLE templates for WbCopy

Property: workbench.db.[dbid].create.table.[typename]

This defines a complete CREATE TABLE statement that is used by WbCopy to create the target table. The typename
value is the value that has to be used for the -tableType parameter of the WbCopy command.

The following placeholders are supported in the template

%fq_table_name% replaced with the fully qualified table name
%table_name% replaced with the specified table name (without schema or catalog)
%columnlist% replaced with the column definitions (for all columns)
%pk_definition% replaced with the primary key definition.

The placeholder %pk_definition% can be used if the DBMS does not support defining a primary key using an
ALTER TABLE on the created table. If this placeholder is present in the template and the table has a primary key, the
placeholder will replaced with an approriate PRIMARY KEY (col1, ...) expression. Note that the template must
not contain the needed comma for the PRIMARY KEY. The comma will be added by SQL Workbench/J if a primary
key is defined. If the table has no primary key, the placeholder will automatically be removed.

Default values:

.postgresql.create.table.temp=CREATE LOCAL TEMPORARY TABLE %fq_table_name%
( %columnlist% ) ON COMMIT DROP
.oracle.create.table.globaltemp=CREATE GLOBAL TEMPORARY TABLE %fq_table_name%
( %columnlist% ) ON COMMIT DELETE ROWS
.h2.create.table.temp=CREATE LOCAL TEMPORARY TABLE %fq_table_name% ( %columnlist
% )
.informix_dynamic_server.create.table.temp_nolog=CREATE TEMP TABLE
%fq_table_name% ( %columnlist% %pk_definition% ) WITH NO LOG

System generated names for contraints

Property: workbench.db.[dbid].constraints.systemname

Defines a regular expression to identify system generated constraint names. If a constraint name is identified as beeing
system generated, it is treated as if no name was defined, when e.g. creating the SQL for a table. Whether or not SQL
Workbench/J then generates a name for the constraint can be controlled in the options for the DbExplorer.

Default values:

oracle: ^SYS_.*
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mysql: PRIMARY

Controlling the chunk size for WbDataDiff

Property: workbench.sql.sync.chunksize

Controls the number of rows that are retrieved from the target table when running WbDataDiff or WbCopy with the
-syncDelete=true parameter.

Default value: 25

20.12. Customize table source retrieval

SQL Workbench/J re-generates the source of a table based on the information about the table's metadata returned by
the driver. In some cases the driver might not return the correct information, or not all the information that is necessary
to build the correct syntax for the DBMS. In those cases, a SQL query can be configured that can use the built-in
functionality of the DBMS to return a table's definition.

This DBMS specific retrieval of the table source is defined by two properties in workbench.settings.

Defining the SQL statement

Property: workbench.db.[dbid].retrieve.create.table.query

This property defines the SQL query that should be executed. It must be a statement that returns a result set. The
statement may contain three placeholders: %catalog%, %schema% and %table_name% that are replaced with the
values of the actual table before running the statement.

Defining the result column

Property: workbench.db.[dbid].retrieve.create.table.sourcecol

The source of the table might not be returned in the first column of the result set. If this is the case this property can be
used to define the column index in which the table's source is available. The first column has the index 1.

The following example configures a SQL statement to retrieve the table's source using MySQL's "SHOW CREATE
TABLE":

workbench.db.mysql.retrieve.create.table.query=show create table %catalog%.%table_name%
workbench.db.mysql.retrieve.create.table.sourcecol=2

If an error occurs during retrieval, SQL Workbench/J will revert to the built-in table source generation.

20.13. Filter settings

Controlling the number of items in the pick list

Property: workbench.gui.filter.mru.maxsize

When saving a filter to an external file, the pick list next to the filter icon will offer a drop down that contains the most
recently used filter definitions. This setting will control the maximum size of that dropdown.



SQL Workbench/J User's Manual

161

Default value: 15
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